FluidDraw P6 is an application for creating electro-pneumatic circuit drawings.

It contains a wide range of standard circuit diagram symbols as well as all components from the Festo product catalogue with their part numbers and technical details. If you have set up a user account for the Festo Online Shop, your shopping baskets are also available in FluidDraw. FluidDraw also supports DXF files and circuit drawings created with older FluidDraw versions and the FluidSIM pneumatic simulator, in addition to its own file format.
Contents

1. Installation and licensing 12
   1.1 FluidDraw installation program 12
   1.1.1 Installing FluidDraw 13
   1.1.2 Installing the CodeMeter licence server 19
   1.2 Licence management 21
      1.2.1 Activating licences 25
      1.2.2 Deactivating licences 30
      1.2.3 Relocating single licences (licence borrowing) 34
   1.3 Licences / troubleshooting 38
      1.3.1 CodeMeter Control Center 39
      1.3.2 WebAdmin 41

2. Getting started 46
   2.1 Ribbon 46
   2.2 Creating a new project 46
   2.3 Organising projects, symbols and libraries 51
   2.4 Inserting a symbol from the menu 52
   2.5 Symbol libraries 54
      2.5.1 Creating your own library 56
      2.5.2 Creating new symbols 57
   2.6 Project files 58

3. Library, project window and object browser 59
   3.1 Changing the window position 59
   3.2 Automatic hiding and displaying 59

4. Editing circuits 61
   4.1 Inserting and arranging symbols 61
   4.2 Using the Festo product catalogue with FluidDraw 61
   4.3 Using the Festo shopping basket with FluidDraw 63
   4.4 Inserting valve terminals via order code 66
6.1.2 Alignment lines
6.1.3 Object snap
6.1.4 Rulers
6.2 Drawing layers
6.3 Displaying line jumps
6.4 Selection filter
6.5 Cross-references
6.5.1 Creating cross-references from symbols
6.5.2 Cross-reference representation
6.5.3 Managing cross-references
6.6 Drawing functions and graphical elements
6.6.1 Hatching
6.6.2 Text
6.6.3 Image
6.6.4 Line
6.6.5 Rectangle
6.6.6 Circle
6.6.7 Ellipse
6.6.8 Polyl ine (traverse line)
6.6.9 Connecting cable
6.6.10 Interruption/potential
6.7 Checking the drawing

7. The object browser
7.1 Navigating in the object browser
7.2 Filter criteria for the object browser

8. Manage Product Database

9. Manage Translation Tables

10. Dimensioning
10.1 Drawing dimensions
10.2 Settings for dimensioning
11. Equipment identifications and designation conventions 175

11.1 Renumber Designations 177

12. Component attributes 181

12.1 Component attributes in the Properties dialogue window 182

12.2 Identification 184

12.3 Catalogue Properties 186

12.4 User Defined Properties 187

12.5 Drawing Properties 188

12.6 Main and secondary elements 189

12.7 Linking main and secondary elements 189

12.8 Linking solenoid valves and solenoid coils 193

12.9 Attributes of the text components 196

12.10 Linking text components with attributes 199

12.10.1 Text constants 202

12.11 Text components with predefined links 203

12.12 Changing the properties of several objects simultaneously 205

13. Managing projects 207

13.1 Creating a new project 207

13.2 Project node 208

13.3 page node 208

13.4 Global objects 210

13.5 Unplaced objects 213

14. page and project properties 216

14.1 Attributes 217

14.1.1 Predefined placeholders 219

14.2 Page Dividers 220

14.3 Basic Unit Length 220

14.4 Language 221

14.5 Encryption 222
14.6  Designation Conventions 224
14.7  Cross Reference Representation 225
14.8  Representation 226

15.  Tables 227
15.1  Using tables 227
15.1.1  Editing contents 228
15.1.2  Formatting 229

16.  Reports 230
16.1  Using reports 230
16.2  Parts lists 231
16.2.1  Inserting a new parts list 231
16.2.2  Adapting a parts list 232
16.2.3  Adding user defined attributes to the parts list 237
16.2.4  Editing the parts list contents 239
16.2.5  Exporting a parts list 240
16.2.6  Sending it to the Festo Online Shop 242
16.2.7  Differences between parts lists in version 5 and 6 242
16.3  Table of contents 243
16.3.1  Inserting a new table of contents 243
16.3.2  Adapting the table of contents 244
16.4  Connector lists / terminal diagrams 244
16.5  Reports in detail 244
16.5.1  Object selection 246
16.5.2  Column selection 254
16.5.3  Appearance 258

17.  Functional diagram 264
17.1  Edit modes 264
17.1.1  Edit Mode 265
17.1.2  Drawing a diagram curve 267
17.1.3  Insert text boxes 268
17.1.4  Insert signal elements 268
17.1.5 Draw signal lines and insert signal connections 269
17.1.6 “Format” mode 272
17.2 Properties dialogues 273
17.2.1 Diagram properties dialogue 274
17.2.2 Text box properties dialogue 275
17.2.3 Diagram columns properties dialogue 276
17.2.4 Signalling element properties dialogue 278
17.2.5 Signal lines properties dialogue 279
17.2.6 Signal link properties dialogue 280
17.2.7 “Format” dialogue 281
17.3 Rows 283
17.3.1 Add row 283
17.3.2 Insert row 283
17.3.3 Copy row 283
17.3.4 Moving rows 284
17.3.5 Delete row 284
17.4 Scrolling and zooming in and out 284

18. Special functions for electric circuits 286
18.1 Potentials and conduction lines 286
18.2 Cables and wiring 288
18.2.1 Managing cables 293
18.2.2 Inserting a cable map 294
18.2.3 Inserting a cable list 295
18.3 Terminals and terminal strips 295
18.3.1 Setting terminals 295
18.3.2 Setting multiple terminals 298
18.3.3 Creating terminal strips 301
18.3.4 Managing terminal strips 303
18.4 Terminal diagram 304
18.4.1 Setting links 305
18.5 Contact image 309

19. Circuit input and output 312
19.1 Printing circuits and parts lists 312
19.2 Importing DXF files 313  
19.3 Exporting circuits 315

20. Template management 318
   20.1 Template management dialogue 318
   20.2 Adjustment of the folder structure 319

21. Options 321
   21.1 General 322
      21.1.1 Language 322
      21.1.2 Menu bar 323
      21.1.3 Dialogue boxes 323
      21.1.4 Project 323
      21.1.5 Check for updates at start-up 324
   21.2 Save 325
   21.3 Product Catalogue 326
   21.4 Folder Locations 328
   21.5 Translation Table 329
   21.6 Connector Links 330
      21.6.1 Connect Automatically 330
   21.7 Warnings 332
      21.7.1 Warnings 332
      21.7.2 Show Warnings 333
   21.8 Appearance 334
      21.8.1 Override Default Settings 334
      21.8.2 View 334
      21.8.3 Zoom 335
      21.8.4 Grid 335
   21.9 Designation Conventions 335
      21.9.1 Default Settings 336
      21.9.2 User Defined 337
   21.10 Cross Reference Representation 337
      21.10.1 Default Settings 338
   21.11 Text Sizes 339
   21.12 Dimension 340
Chapter 1

FluidDraw uses the CodeMeter technology from Wibu-Systems for software protection. The CodeMeter Runtime must be installed for this. If the Runtime is not installed or if it is too old, then a current Runtime version of FluidDraw setup will be installed.

1.1 FluidDraw installation program

You can select the language to be used during the installation on the start page of the installation program. Install FluidDraw is used to start the installation. The Install Licence Server selection is described further below.
1.1.1 Installing FluidDraw

Figure 1/1: FluidDraw setup: start page
Figure 1/2: FluidDraw-Setup:  *End-User Licence Agreement*

Please confirm the licence conditions for a new installation. For an update installation no further settings have to be made and the installation can be started immediately.

FluidDraw requires the CodeMeter Runtime from Wibu-Systems for licensing. If no suitable version of the installation program is found on your system, the Runtime will be installed in the next steps.

You require administrator rights to install the CodeMeter Runtime.

If you would like to install FluidDraw under a user with limited rights, exit the installation program after the CodeMeter Runtime has been installed and start it again.
In the next step, you can select whether to perform a complete installation or a network access installation (client installation). For a client installation, FluidDraw must already be installed. In this case, the installation program does not perform an installation but only creates a link to the program already installed.
If your CodeMeter licences are provided by a licence server in your network and if this licence server is in a different subnet, you can use the following dialogue to specify the IP address of the licence server. If you are using a local licence or if the licence server is in the same subnet, you can simply continue with Next.
Figure 1/5: FluidDraw setup: Specify licence server (optional)

Then you can select whether FluidDraw is to be installed for all users or only for the currently logged on user.

You require administrator rights to select “For all users”. 
Figure 1/6: FluidDraw setup:  *Select User Group*

Then you can select the target folder and start the installation.
1.1.2 Installing the CodeMeter licence server

You can use any PC in your network as the licence server. The following conditions must be met for this:

— The CodeMeter Runtime from Wibu-Systems must be installed on the server PC and the *Server Access* option must have been activated in the Runtime.

— The client PCs must have access to the server PC via the LAN.

— Valid licences must have been activated on the server PC or a CodeMeter USB plug with valid licences must be inserted.

The activation of licences is described in the “Licence management” chapter.
If you started the FluidDraw installation program on a PC that you want to use as the server, then you can select the Install Licence Server to install the CodeMeter Runtime from Wibu-Systems. The “Server Access” option is automatically activated in the Runtime. If there already is a suitable version of the CodeMeter Runtime on the PC, the Runtime will not be installed and only the “Server Access” option will be activated. The “Server Access” option can also be activated and deactivated using the tools from Wibu-Systems. For details, see “CodeMeter Control Center and WebAdmin” chapter.
1.2 Licence management

FluidDraw licences are mainly output and managed via a ticket system. In this case, you will have received a ticket from your licensor that you can use to import (activate) and manage your licences via the Internet. The ticket number consists of 5 alphanumerical strings of 5 characters each that are separated by a minus sign, e.g. “8A7T4-6P7GW-5YQLN-4WDWL-KR3M7”. The licences can be managed using the “Online Licence Activation Wizard”. This wizard is available as a separate program “CodemeterActivation-Wizard.exe” in the “bin” folder of your FluidDraw installation or can be accessed directly from FluidDraw via the Manage menu item.

The following conditions must be met to be able to use the activation wizard.
The activation wizard must be able to establish an Internet connection. If the PC is behind a proxy, a dialogue is opened in which you can enter the required proxy data.

The CodeMeter Runtime from Wibu-Systems must be installed on the PC used to open the activation wizard. If that is not the case, you can use the wizard to open the corresponding download page of Wibu-Systems in the standard browser.

The CodeMeter Runtime from Wibu-Systems must be installed on the PC to which the licences are to be imported.

The activation wizard must be able to access the PC to which the licences are to be imported via LAN.

Enter your ticket number on the start page of the activation wizard.

You can also copy the complete ticket number in the first input field via the clipboard. The ticket number is then automatically distributed to the five input fields.
If the activation wizard has no access to the PC to which the licences are to be imported, various files need to be exchanged between this PC and the licensor. Only select the [Transfer files manually] button in this case. An Internet site opens that guides you through the file exchange process.

Select [Next] to access the licence information for your ticket via the Internet.
The table lists all licences for your ticket number. Free licences that can be activated are displayed on a green background. If no free licences are available, you will be informed. Every line contains a number of licences of a product that can be activated or deactivated together.

<table>
<thead>
<tr>
<th>Name</th>
<th>Number of licences</th>
<th>CmContainer</th>
<th>Found server</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>FluidDraw P6 Permanent</td>
<td>2</td>
<td></td>
<td></td>
<td>Activate</td>
</tr>
<tr>
<td>FluidDraw P6 Permanent</td>
<td>1</td>
<td>130-4040597147</td>
<td>Local machine</td>
<td>Deactivate/Re-host</td>
</tr>
</tbody>
</table>

**Figure 1/11: Activation wizard: Select licence**

Name: Contains the name of the licensed product.

Number of licences: Specifies the maximum number of licences that can be activated or deactivated.

CmContainer: Contains the serial number of the CodeMeter container in which the licences were activated. The container can be a hardware plug (CmDongle) or a software-based licence (CmAct).

Found server:
Contains the name of the server with the corresponding CodeMeter container. If the CodeMeter container cannot be found in the LAN, this field is empty and the licence cannot be deactivated.

→ Select “Activate” if you want to import (activate) licences or “Deactivate/Re-host” if you want to deactivate or relocate licences.

### 1.2.1 Activating licences

After selecting “Activate”, you can select the number of licences you want to activate. This dialogue is skipped if only one licence is available.
You can select whether to import the licences locally or to a PC in the network (if available).

The CodeMeter Runtime from Wibu-Systems must be installed on the PC in the network.
Then, you can define the CodeMeter container type. It can be a hardware plug (CmDongle) or a software-based container (CmAct). To use a hardware plug, you need to own one. The software-based container is automatically created by the activation wizard.
Before the actual activation, a summary of the licences to be activated is displayed to you again.

→ Start the activation with “Activate”.

Figure 1/14: Activation wizard: Select licence type
Figure 1/15: Activation wizard: *Executing activation*

The individual activation steps are carried out via the Internet and highlighted in colour.
Finally, you can close the activation wizard or have the current licence information displayed for your ticket via Back to licence overview.

1.2.2 Deactivating licences

After selecting “Deactivate/Re-host” in the licence overview, you can select whether you want to deactivate licences or relocate an individual licence.
Figure 1/17: Activation wizard: *Deactivate/Borrow licences*

→ Select “*Deactivate licences*”.

You can now select the number of licences you want to deactivate. This dialogue is skipped if only one licence is available.
Figure 1/18: Activation wizard: *Specify number of licences*

Before the actual deactivation, a summary of the licences to be deactivated is displayed to you again.

→ Start the activation with “*Deactivate/Re-host*”.
Figure 1/19: Activation wizard: *Executing deactivation*

The individual deactivation steps are carried out via the Internet and highlighted in colour.
Finally, you can close the activation wizard or have the current licence information displayed for your ticket via Back to licence overview.

1.2.3 Relocating single licences (licence borrowing)

The activation wizard supports the simple conversion of a single licence into a software licence. That is a practical function e.g. if you have multiple licences on a server and want to use an individual licence for a foreseeable time locally on a laptop (licence borrowing). You can also carry out the necessary steps manually using the activation wizard. The necessary steps for licence borrowing are automated, however. The steps are deactivation of a licence and
subsequent activation of a single software licence on the local computer.

→ Select “Deactivate/Re-host” from the licence overview.

![Activation wizard: licence overview](image)

Figure 1/21: Activation wizard: licence overview

→ Finally, select “Re-host a single licence to the local machine.”.
Figure 1/22: Activation wizard: licence borrowing

The subsequent steps are carried out automatically.
Figure 1/23: Activation wizard: step 1: deactivation
Finally, you can close the activation wizard or have the current licence information displayed for your ticket via Back to licence overview.

If you want to give back your licence, you must deactivate it.

1.3 Licences / troubleshooting

To be able to start FluidDraw, it must find a valid and available CodeMeter licence. The CodeMeter Runtime from Wibu_systems is used to install various tools that you can use to query licence information and make settings.
Licence server refers to the computer that can directly access the CodeMeter container (CmContainer) with licences. A container can be a connected hardware plug (CmDongle) or an imported software-based CodeMeter-Act licence (CmAct).

Client computer refers to the computer on which FluidDraw is started and on which it requests a licence from the licence server. If the CodeMeter containers are on the local computer, then licence server and client computer are identical. Various requirements must be complied with for successful access to the licence. How you can check these requirements using the tools of Wibu-Systems is described afterwards.

1. A current CodeMeter Runtime must be installed on the licence server and on the client computer.

2. The licence server must have direct access to the CodeMeter container with the corresponding licences.

3. If the licence server is not also the local computer, then the “Server Access” option must be selected on the licence server.

4. The client computer must be able to access the licence server via the network and its licence information. If the licence server is in a different subnet, then the IP address of the licence server must be specified on the client computer (Server Search List).

1.3.1 CodeMeter Control Center

The CodeMeter Control Center is installed, along with the CodeMeter Runtime. The connected CodeMeter containers of the computer are displayed via the CodeMeter Control Center. No CodeMeter containers are listed that are on other licence servers in the network. The CodeMeter Control Center can be started via the start menu under “CodeMeter”-“CodeMeter Control Center” or by clicking the corresponding symbol on the task bar.
Next to the list of connected CodeMeter containers, you can use the “WebAdmin” button to have detailed licence information displayed in the Internet browser and you can make various settings. The WebAdmin is described in the next section.

On the licence server, you can use the CodeMeter Control Center to check if your CodeMeter containers really are available or connected. More information on the CodeMeter Control Center can be found in the Help for the program.
1.3.2 WebAdmin

The CodeMeter Runtime is also used to install the WebAdmin that you can use to access detailed licence information and make runtime settings. The WebAdmin can be opened via the CodeMeter Control Center, which was described in the previous chapter. All WebAdmin functions are described in this Help. Only the main functions important for starting FluidDraw are explained below. The WebAdmin always shows a view of the licences and settings of a selected licence server. You can therefore also have information of a different licence server in the network displayed.

Figure 1/26: CodeMeter Control Center
First check if the new licences are available on the licence server. Start the WebAdmin directly on the licence server and check on the “Containers” tab if your CodeMeter container is available with the corresponding licences.

If the licence server is not the local computer and if the licences are to be available to other client computers, then the “Server Access” option must be selected. You can configure this on the “Configuration” tab.

![Figure 1/29: WebAdmin, tab: Server Access](image)

Next, check if the licences of the licence server can be accessed by the client computer. Start the WebAdmin directly on the client server for this purpose. Then, you must select the licence server in the WebAdmin at the bottom left.
If your licence server is not listed, there may be one of two reasons for this.

1. On the licence server, the “Server Access” option is not activated (see previous section).

2. The licence server is in a different subnet and this server is not entered in the server search list.

You can enter the licence server on the tab: “Configuration”-“Basic”-“Server Search List”.

Figure 1/30: WebAdmin: servers found
You should now be able to select the license server at the bottom left in the WebAdmin and you can then check on the “Container” tab if your CodeMeter container is available with the corresponding licenses on the license server.

If you still have any licensing problems, please contact Support.
Chapter 2

2.1 Ribbon

For clearer and easier operation with fewer mouse clicks, in FluidDraw 6 a ribbon is used instead of the classic menu bars. The classic menu bars are still available, however and can be activated via the Options.

![Ribbon](image)

Figure 2/1: Ribbon

The operating instructions in this manual refer to the ribbon. Every entry in the ribbon can also be found on the classic menu bar. If the general term "menu" is used in the manual, you can find the corresponding function in the ribbon and also on the classic menu bar.

You can customise the ribbon as well as the keyboard shortcuts to your own liking. For details, see Adjust ribbons.

2.2 Creating a new project

A project in FluidDraw consists of pages that can be organised hierarchically in a tree structure. The main node of the tree structure is the project itself. Sub-nodes can be created under the project node for structuring. pages can include circuit diagrams and reports, such as parts lists.

A sub-node automatically adopts all properties (attributes) of the parent node, such as the drawing frame. The properties can be overwritten in subordinate nodes and on the pages or deleted.
Please note that in FluidDraw, version 6, circuit diagrams are always managed in projects. However, individual pages of older FluidDraw versions that are not part of a project can still be opened, edited and saved.

→ On the ribbon, select **File → New → Project**.

First specify the project file to which the new project is to be saved. A dialogue box appears. The file extension that belongs to a project file is “fdprj”. Then, the dialogue with the project properties automatically opens.

On the **Drawing Frame** tab, you can select a drawing frame that is to be used by default for all pages. Further information on the drawing frame can be found in the section: **Drawing frame**.
Figure 2/2: **Project** dialogue window, **Drawing Frame** tab: selecting a drawing frame

After closing the properties dialogue of the project with **OK**, a new empty page is automatically created to which all project properties are transferred.
Figure 2/3: New project with a page

Via [Page] [Properties...], you can change the properties of a page, such as the description.

If you select [File] [New] [Page] to add a new page to the project, the properties dialogue for the new page automatically opens.

You can insert symbols in the new page and connect them with lines. If you have selected a drawing frame in the project or on the page, the size of the drawing is automatically set. If you want to manually define the drawing size then deselect the “Adopt from drawing frame” option on the “Drawing Size” tab and select the drawing’s desired dimensions and orientation. If the drawing’s dimensions are larger than your printer's printing area then you can distribute your drawing across several pages (tiles)
For a better overview you can create attributes for every circuit drawing.

→ Click the “Attributes” tab to do this.
Figure 2/5: Page dialogue window, Attributes tab: creating attributes

The attribute table allows you to save any desired data in the form of attribute value pairs. The associated placeholders (attributes with the same name) in the drawing frame are replaced by the values entered.

2.3 Organising projects, symbols and libraries

To support the organisation of the different document types in FluidDraw, they are classified into one of three groups:
The default location for projects is in the FluidDraw folder contained in the My Documents folder defined by the operating system. These have the fdprj file extension.

Symbols
Symbols are formal, abstract models, which graphically represent the function of a component or component group. These can be simple circuit symbols or also complete circuits. Symbols can be inserted in their own circuits and connected between the connector points. They are inserted either using the Insert menu or by dragging them (“drag and drop”) out of a library window. Symbols can be combined to libraries.

Libraries
Libraries are hierarchically organised collections of symbols. In addition to the standard library that cannot be changed by the user, you can compile your own libraries as desired. You can find functions for organising the libraries in the Library menu and in the context menu of the active library. The library is switched over using the tab at the top edge of the library window. Library files have the file extension: lib.

2.4 Inserting a symbol from the menu

To find a specific symbol, you can enter characteristic key words in the Find Symbol dialogue window or navigate through the hierarchical structure.

→ Open a new window, if necessary, and select the Find Symbol Description... menu item in the Insert menu.

The Find Symbol dialogue window opens. You can enter search terms in the “Search” input line. The individual search terms are separated by commas or blanks. The order of the entries and (upper or lower) case are irrelevant.
The symbols found are displayed in the two result lists. The library hierarchy is displayed on the left side. Only those branches appear that have the fitting symbols. An alphabetically sorted list with the search hits is displayed on the right side. The symbol of the highlighted entry is displayed in the preview. When you have found the desired symbol, you can select it using the **OK** button or by double-clicking the corresponding line in the result list. The symbol is then attached to the mouse pointer and is positioned on the drawing area by a left-click.

You can use the **Fuzzy Search** option to activate a tolerance to also get results in the event of input errors or spelling variants.

In addition to the option of inserting a specific symbol using the **Find Symbol** dialogue window you can also insert a real component...
along with its part number and technical details from the Festo product catalogue. You can find details of how to use the Festo product catalogue with FluidDraw under Using the Festo product catalogue with FluidDraw.

2.5 Symbol libraries

FluidDraw can manage several libraries, of which each individual one is display on a tab of the library window. Libraries that cannot be changed in FluidDraw are marked by a lock symbol on the tab. That applies to the standard library and to FluidDraw symbol folders that you do not manage yourself or for which the logged-on user does not have any write access.

Every library is displayed hierarchically. Every hierarchy level can be displayed or hidden by clicking the group name. Right-click a library to open a context menu that provides the following menu items for editing the library:

- **View**
  Defines the size of the symbols displayed. Small, Normal, and Large are available.

- **Show All Symbols**
  By default, the library contains the symbols and components normally used that are included in the Festo product catalogue. All symbols can be displayed with the Show All Symbols option. These also include those that FluidDraw uses internally e.g. to assemble valve terminals.

- **Show default designation**
  Reference letters that comply with the standard are already stored for typical components. They are displayed by default in the symbol at the top right. You can deactivate the display with this option if you do not want it.

- **Assign reference designation...**
  If a symbol does not have a default identification in the library or if you want to change it, you can assign an individual identification to every symbol. A free number is automatically attached to this identification when it is inserted on a page.
Figure 2/7: Assign reference designation... dialogue window

Enter a standard identification for this symbol. The Manage reference designations... button opens an overview of all user IDs.

**Copy to Other Library**
Copies the marked symbols to another library. The available libraries are listed in a submenu. Only those libraries that are currently open (i.e. that appear as tabs in the library window) and that are not write-protected (indicated by the fact that no lock symbol 🗝 is displayed) appear here.

**Expand All**
Opens all hierarchy levels.

**Collapse All**
Closes all hierarchy levels.

There are three types of libraries:

**The standard library**
This library is supplied with FluidDraw and cannot be changed.

**Symbol folder**
Circuit and symbol files stored on the data storage medium can be used like libraries in FluidDraw. The files of the selected folder are added as a library via the Library menu and the Add Existing Symbol Folder... menu item. The library hierarchy exactly matches the folder hierarchy. These libraries cannot be changed in FluidDraw. Changes must be made directly on the data storage medium.

**Own libraries**
You can create and subsequently edit new libraries via the Library menu and the Create New Library... menu item (see section Creating your own library). Using “drag and drop” you can move the symbols and groups within the library as desired.
2.5.1 Creating your own library

To be able to access frequently used symbols (or circuits) more quickly, several symbols can be combined to libraries. Libraries are stored in files with the file extension `.lib`. You can create new libraries via the [Library] menu and the [Create New Library...] menu item. Right-click the new library to open a context menu that you can use to edit the library.

The following menu items are available:

- **Copy**
  - Copies the selected symbols to the clipboard.

- **Paste**
  - Inserts the symbols from the clipboard in the library. These symbols can also be sub-circuits.

- **Delete**
  - Removes the marked symbols from the library.

- **Rename...**
  - Changes the text which libraries display below the symbol.

- **Add Existing Symbols...**
  - Opens a dialogue window for selecting symbol files, which are to be copied as new symbols into the library.

- **Copy to Other Library**
  - Copies the marked symbols to another library. The available libraries are listed in a submenu. Only those libraries that are currently open (i.e. that appear as tabs in the library window) and that are not write-protected (indicated by the fact that no lock symbol is displayed) appear here.

- **New Sub-Folder...**
  - Creates a new hierarchy level below the active group. The active group is the one that belongs to the area under the mouse pointer. It is indicated by a dark blue colour.

- **Remove Sub-Folder**
  - Removes the hierarchy level at which the mouse pointer is.

- **Rename Sub-Folder...**
  - Allows the name of the hierarchy level to be changed at which the mouse pointer is.
2.5.2 Creating new symbols

Existing symbols from the standard library cannot be changed, but you can create your own symbols in FluidDraw. To do this, proceed as follows:

1. Draw symbol
   You can easily create a new symbol using the line, polyline, rectangle, circle, ellipse, etc. drawing functions. Use these drawing elements to draw your desired symbol in an empty page. In order to achieve this precisely, you can activate additional snap functions such as [Snap to End Point], [Snap to Centre] or [Snap to Intersection] using items on the ribbon page [Edit]. The [Show Grid] option in the [View] page displays a grid in the background. This has a grid width of 2 M by default. Grid width and style can be adjusted in program options on the [Appearance] page.

2. Create macro object
   After you have drawn the symbol, select all elements of the symbol and select [Create Macro Object] from the context menu in the circuit or from the menu on page [Home]. The individual drawing elements are then combined to form a single new symbol with its own properties.

3. Define connectors
   Via the [Define Connector] item in the [Insert] menu, you can now add pneumatic, hydraulic or electrical connectors to the symbol. For the line routing of conduction lines it is optimal if these connectors are placed in such a way that they are located at intersections with the grid.

4. Save symbol in own symbol library
   Via the main menu item [Create New Library...] on the ribbon page [Library] you can create your own symbol library for your user symbols. If you use this menu item and specify a file name, a new empty symbol library is created. You can then drag and drop the newly created symbol into the new library. When storing the symbol in the library, you can assign your own symbol name and a description for the symbol.

   Now you can use the new symbol from your user library just like a symbol from the standard library in your projects.
As an alternative to creating your own macro object in steps 1 and 2, you can also import a completely drawn symbol in DXF format. To do this, use the main menu item **DXF Import...** in the **File** menu.

### 2.6 Project files

FluidDraw project files have the file extension **fdprj** and are saved as compressed XML files. An option in the **Manage** ribbon under the **Options...** menu item in the **General Save** sub-menu allows you to deactivate this compression so that the circuit files can be viewed as plain text. This can be useful for version management software, for example.

Before version 6 of FluidDraw, individual pages could be saved as circuit diagram files with the file extension **circ**. These are also (compressed) XML files. They can still be opened, edited and saved using the current version of FluidDraw. Please bear in mind however, that the use of some new functions of FluidDraw requires a conversion into the current project format. In this case, FluidDraw displays a message prior to saving the data and offers to create a backup of the original file.
Chapter 3

3.1 Changing the window position

The library window is firmly attached on the left side by default and the project window and the object browser (if a project is open) are on the right side.

To release the window from its position: connect the mouse pointer to the upper edge of the window. Click and hold the left mouse button. Move the window a small distance towards the centre of the screen. Now release the left mouse button. Now you need to move the library window to the bottom right and the project window to the bottom left. Once a window has been released from its fixed position it can be moved freely.

To move the window back into its fixed position: connect the mouse pointer to the upper edge of the window. Click and hold the left mouse button. Move the window as far as possible to the right or the left. Now release the left mouse button. This window snaps into place. This enables you to fasten the library window in place on the right and the project window on the left, for example. You can also fasten both windows on the same side. In this case you can move the desired window into the foreground by clicking the associated tab.

3.2 Automatic hiding and displaying

The tabs provide another practical function: the automatic hiding and display of the library, the project window or the object browser. Click the corresponding vertical “Library”, “Project” or “Object browser” tab at the edge of the window with the mouse pointer. That hides the window in order that a larger space is provided for the drawing. To have the window displayed again, it is sufficient to move the mouse pointer over the tab, which opens the window. As
soon as you have carried out your operation in this window and move the mouse to a circuit window again, the corresponding window is automatically hidden. To deactivate the function, click the corresponding tab again (which then appears in pressed-down form).
4.1 Inserting and arranging symbols

Using the Find Symbol dialogue window and the libraries, you can insert symbols in the circuit window to be edited. You can also apply objects from any other window however, by marking them and dragging them into the desired window. Alternatively, you can also use the clipboard by selecting the Copy menu item after highlighting the objects in the Home menu, moving the target window to the foreground and selecting the Paste menu item in the Home menu.

If you “drag” objects from one window to another using the mouse pointer, they are copied. If you drag the objects within a window from one position to another, they are moved. To copy objects within a window, you must keep the Shift key pressed when you move the mouse pointer. The corresponding operation is indicated by the shape of the mouse pointer: during a shift operation a cross with arrows appears and for copying there is also a plus symbol in the bottom right corner of the cross.

4.2 Using the Festo product catalogue with FluidDraw

The FluidDraw standard installation already contains all products from Festo. For this, an excerpt from the Festo product catalogue is also installed in several languages.

In order to remain up-to-date, we recommend to always install the latest update. FluidDraw updates always also include the data of the current Festo product catalogue.

There are two basic options for inserting symbols with part numbers and technical details in the circuit.
If you wish to insert a symbol from the FluidDraw symbol library, simply select a graphical image that represents the function of a component or component group. For the majority of the symbols there is a large number of different products with different part numbers and technical details (attributes and parameters). To select a product open the **Properties** dialogue window by right-clicking the symbol and click the **Find...** button.

The product catalogue represents a complete database of the available Festo products. If you wish to insert the associated symbols with part numbers and technical details for certain products then select the **Insert** menu item from the **From Festo Catalogue** menu. The **Insert from catalogue** dialogue window appears. Enter your key words in the **Search** input line. The upper table contains the search result. Highlighting a row there displays the associated symbol in the preview. Select a product by double-clicking a table row or using the **Add to Selection** button. Selected products are collected in the lower table. When exiting the dialogue window the symbols of the selected products are inserted into the circuit window. The symbols contain the part numbers and technical details of the previously selected products in the form of attribute value pairs.

If you are using a custom product database you can select it in the **Product Database** list box. You can use the selected database in the same way as the Festo product catalogue.
There are different symbol representations for some products. If necessary, select a suitable symbol from the preview at the top left.

4.3 Using the Festo shopping basket with FluidDraw

If you want to insert one or more symbols from an existing shopping basket, select the From Festo Shopping Basket menu item in the Insert menu.

FluidDraw supports shopping baskets that you created with an installed product catalogue (offline) and also shopping baskets created via the Online Shop (online).

If you want to insert shopping baskets from the Festo Online Shop, you must log on with the corresponding user account at Festo.
On request, FluidDraw can memorise your login data for the Festo Online Shop. This data is stored in encrypted form in the registration database for the currently logged-on Windows user. Use this convenient option only if you are sure that no unauthorised person uses the PC with your Windows login.

If a proxy is used in your environment for access to the Internet for which login data needs to be entered, a dialogue automatically appears in which you can enter this login data for access to the Internet. Use the same data here that you also use e.g. for your Internet browser.

After successful login to the Online Shop, the stored shopping baskets are downloaded and displayed. All shopping baskets are displayed by default. You can modify the period, if necessary. A default period can also be defined in the program settings.
Search options are available for further limiting the number of shopping baskets displayed. Press the **Refresh** button after any change to the search parameters to refresh the shopping baskets displayed.

To insert a specific shopping basket, select it from the list of baskets. You also have the option of deselecting individual items from the shopping basket.

If you have selected a product without any graphical representation, a text appears on the circuit drawing that includes the component attributes, instead of the symbol. This text also appears in the parts list just like the ID of the symbols.

You can make the settings that influence the creation of the symbol designations and accessories using the **Tools** tab under the **Manage** menu item in the Product Catalogue menu. If desired, FluidDraw can automatically generate text elements derived from the type attribute of the associated symbol.
4.4 Inserting valve terminals via order code

FluidDraw can insert the corresponding symbols from many Festo order codes. That does not only work via the Festo shopping basket but also by directly inserting an order code text from the clipboard.

→ Copy the following order code to the clipboard: 10P-10-8A-IC-V-Z-MMQMGFPCYEVF+MA and then insert the text via [Home] / Paste in FluidDraw.

FluidDraw uses it to create the following symbol:

![FluidDraw symbol](image)

Figure 4/4: valve terminal 10P-10-8A-IC-V-Z-MMQMGFPCYEVF+MA

You can get a more compact, but outdated view for some products by selecting the Insert legacy valve terminal symbols option under [Manage] / Product Catalogue:
4.4.1 Distributing valve terminals to several pages

A complete valve terminal is generally too big for a single page. It is therefore practical to distribute symbols to several pages. As a valve terminal consists of a group of individual symbols, FluidDraw can break up this group to distribute the individual elements to different pages.

→ Highlight the valve terminal and select the Distribute to multiple pages... menu item from the context menu (right mouse button)
Figure 4/6: Distribute to multiple pages... dialogue window

The preview window represents the separation points of the valve terminal. The black vertical lines show possible separation points, and the blue ones show those currently selected. You can move the blue separators with the mouse to change the desired separating position.

**Number of pages**

Defines how many pages the valve terminal is to be distributed to.

**Distance between blocks**

Defines the space between two blocks on a page.

**Draw connection lines**

If there are several separate blocks on a page, you can connect them using lines.

**Accumulate interruptions**

The connectors are on the left and right sides of the deleted symbols that are connected via interruptions to the previous or following pages. FluidDraw can summarise these connectors for a better overview and only create a single interruption.

After closing the dialogue with OK, FluidDraw automatically creates several new project pages according to the distribution and distributes the individual blocks to the new pages.
4.5 Connecting connectors

To connect two component connectors to a line, move the mouse pointer over a component connector. A connector is indicated by the small circle at the end of a connector line of the symbol. As soon as you “hit” a connector, the mouse pointer is converted into a crosshair ⊗.

Figure 4/7: Mouse pointer as crosshair over a component connector

→ Now, press the left mouse button and move the mouse pointer to the connector you want to connect to the first one.

The shape of the mouse pointer ⊗ shows you when you are over the connector. If the mouse pointer is over a connector to which a line is already connected, the prohibited sign ⊘ appears and no line can be created.

→ Let go of the mouse button once you have hit the second connector.

FluidDraw automatically inserts a line between the two connectors.
4.6 **Automatically connect connectors.**

FluidDraw supports two methods of automatically connecting connectors. The first is to drop a symbol on an existing line. To be able to use this method, the symbol must have at least two connectors that precisely fit onto one or more existing lines and the lines that are created must not cross the symbol. The following two figures show this function.
Another method of automatically connecting connectors is to position symbols so that their connectors can be horizontally or vertically connected with free connectors from other symbols. After the symbol has been dropped the corresponding lines are automatically drawn if they do not cross any symbols. The free connectors can also be T-distributors.

You can define how the connectors of different objects are automatically connected in the *General Connector Links* tab under the *Options...* menu item in the *Manage* menu. The following two figures show this function.
4.7 Inserting T-distributors

To insert a T-distributor you do not need to use any special symbol. FluidDraw automatically inserts a T-distributor if you drag a component connector to a line or a line segment to a connector. If you want to connect two lines, you can also drag one line segment to another one. FluidDraw then inserts two T-distributors and connects them with a new line.

→ Move the mouse pointer to a connector and press the left mouse button.

If you are over a line segment, the mouse pointer is converted into a crosshair. 

Figure 4/11: Circuit before the connectors are automatically connected

Figure 4/12: Circuit after the connectors are automatically connected
Let go of the mouse button once you have hit the desired point of the line.

FluidDraw inserts a T-distributor and automatically inserts a line.

Figure 4/13: Line connection with T-distributor inserted

Every T-distributor can be used to connect up to 4 lines.

The default representation of the T-distributor can be selected via the corresponding drop-down list on the Edit ribbon page.

You can customise the representation of the T-distributor by double-clicking the T-distributor or highlighting the T-distributor and selecting the Home menu item in the Properties... menu. The “Properties” dialogue window opens. Select the “Representation” tab.
Figure 4/14: T-distributor dialogue window. Tab: Representation

**T distributor**

Defines the representation of the basic T-distributor. Here you can select whether the distributor should be represented as a filled circle or a simple intersection.

**Cross-Link**

Defines that the T-distributor should be represented as an electrical link. This representation has an effect on the connected lines, which are automatically marked as links.

**Junction**

Defines that the T-distributor should be represented as an electric junction. This representation has an effect on the terminal destination search. With a junction, the target in the direction of a straight line or right angle is found first and then the target via an angled branch.

### 4.8 Moving lines

After connecting two connectors, you can adapt the position of the lines. You can move the line segments parallel by moving the mouse pointer on the relevant line segment. The “line start” form of the mouse pointer shows you when you have hit the line.
Press the left mouse button and move the line segment in orthogonal direction to the desired position.

Figure 4/15: Moving a line segment

If you let go of the mouse button, FluidDraw will adjust the adjacent line segments in such a way that the complete line is retained.

If you move a line segment that is connected directly to a component connector, FluidDraw will insert any additional line segments to avoid gaps.

If you move a line segment that is horizontally or vertically connected with other line segments via T-distributors then these line segments are moved together with the T-distributors.
If you only want to move the individual line segment in the case described above then release the mouse button after highlighting the line segment. Click the segment again and move it while keeping the mouse button pressed.

Figure 4/16: Moving multiple line segments

Figure 4/17: Moving multiple line segments
4.9 Defining the properties of the lines

Lines, like other symbols, can be assigned an identification, catalogue properties and user-defined properties. You can find more information on this under Component attributes in the Properties dialogue window.

You can also define the style, colour and drawing layer of the lines by double-clicking a line segment or highlighting the line segment and selecting the [Home] menu item in the [Properties...] menu. The Line Properties dialogue window opens. Select the Drawing Properties tab in this window. The settings are applied to the entire line section as far as the next connector or T-distributor.
Figure 4/19: *Line Properties* dialogue window: defining the properties of a pneumatic or electric line

- **Layer**: Defines the drawing layer for the line.
- **Color**: Defines the colour of the line.
- **Line Style**: Defines the line style of the line.
- **Line Width**: Defines the line width of the line.
- **Start Cap**: Defines how the start of the line is displayed.
End Cap

Defines how the end of the line is displayed.

Straight connection line

By default, FluidDraw automatically creates all lines orthogonally. However, it some cases it may be desirable to create a straight connection between two connectors.

Note: Working lines are typically displayed as continuous lines and control lines are displayed as dashed lines.

4.10 Deleting a line

To delete a line you can either highlight an associated line segment and press the Del key or select the Home menu item in the Delete menu or highlight a component connector and press the Del key. In these cases it is the line rather than the connector itself that is deleted.

If you delete a T-distributor to which three or four lines are connected, all lines are deleted. However, if only two lines are connected, only the T-distributor is deleted and the two lines are joined to form one line.

4.11 Defining the properties of the connectors

You can give a component connector an identification and a blanking plug or a silencer by double-clicking the connector or by highlighting the connector and selecting the Properties... menu item in the Home menu. The Connector dialogue window opens.
Figure 4/20: Connector dialogue window: defining the properties of a connector

Identification

You can enter a text for identifying this connector at the input line. The identification is shown in the circuit drawing if the Display option is selected.

Whether or not the identification is actually displayed depends on the option selected under [View] [Show Connector Descriptions].

Terminator

Open the symbol list containing connector terminators by clicking the button using the arrow. Select a suitable silencer or a blanking plug.

Note: Please note that this symbol list is only available if a line is not connected to the connector in question. If you wish to connect a line to a sealed connector you first have to remove the blanking plug or silencer. To do this select the empty field in the symbol list with the connector terminators. The alignment of the connector terminator can be set via the radio buttons.
4.12 Defining a component connector / setting a T-distributor

You can set T-distributors on existing lines or define a new component connector by selecting the [Insert] menu item in the [Define Connector...] menu. FluidDraw then switches to a special mode in which the next mouse click sets a T-distributor or defines the new connector. You can cancel the action by pressing the [Esc] key or the right mouse button.

Connectors in symbols can be placed at any positions.

Note: To place the connector as exactly as possible at the desired position, it is recommended to increase the size of the image section of the corresponding symbol significantly. As soon as the mouse pointer is over a symbol, it is converted into a crosshair. You define the new connection with a left-click.

Figure 4/21: [Define Connector...] dialogue window

- **Type of connector**: Selects the connector type. The following are available: “Pneumatic”, “Hydraulic”, “Electric” and “Electric (Label)”.

- **Define multiple connectors**: Multiple connectors can be set one after the other if this option is active. You can cancel the action by pressing the [Esc] key.
4.13 Deleting a component connector

To delete a component connector, select it and select the [Delete Connector] menu item in the [Home] menu.

Note: Bear in mind that the [Delete] menu item or the [Del] key does not delete the connector, only any connected line.

4.14 Configuring directional control valves

If you require a specific valve that you cannot find in the FluidDraw standard library, you can use the valve editor to create your own valve symbols.

→ Insert a 5/n directional control valve into a circuit window from the “Pneumatic symbols - ISO 1219-1 | Configurable symbols” library.

To determine the valve bodies and actuation types of directional control valves, double-click the valve. The Properties dialogue window opens. Click the “Configure Valve” tab. That opens the valve editor.
Figure 4/22: Properties dialogue window: Configure Valve tab

Left Actuation – Right Actuation

You can select the actuation types of the valve from the “Manually”, “Mechanically” and “Pneumatically/Electrically” categories for both sides of the valve. Click the button with the mouse pointer and select a symbol element. A valve can have multiple actuation types at the same time. If you do not want an actuation from a category then select the empty field in the list. You can also define whether each side should have a spring return, pilot control, pneumatic spring or external supply.

Valve Body

A configurable valve can have a maximum of four switching positions. A valve body can be selected for every switching position.
Click the corresponding button with the arrow to open the list of symbol elements. Select a symbol element for every switching position. If you require less than four switching positions, select the empty field for the positions not required in the list.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Position</td>
<td>This is for defining which switching position the valve should assume in the normal position. Note: When making the definition, make sure that it does not contradict any spring return.</td>
</tr>
<tr>
<td>Dominant Signal</td>
<td>This is for indicating graphically whether the right-hand signal or the left-hand signal is to dominate if two equally strong signals are applied.</td>
</tr>
<tr>
<td>Spring-returned</td>
<td>This is for defining whether the corresponding side is to be equipped with a spring return.</td>
</tr>
<tr>
<td>Piloted</td>
<td>This is for defining whether the corresponding side is to be equipped with a pilot control.</td>
</tr>
<tr>
<td>Pneumatic Spring</td>
<td>This is for defining whether a pneumatic spring is to ensure the return on the corresponding side.</td>
</tr>
<tr>
<td>External Supply</td>
<td>This creates another connector via which the external supply of the controller is connected.</td>
</tr>
<tr>
<td>Pilot air exhaust</td>
<td>Creates a symbol for releasing the pilot exhaust air into the environment.</td>
</tr>
<tr>
<td>Pilot air exhaust (ducted)</td>
<td>This creates a further connector via which the pilot exhaust air is released.</td>
</tr>
</tbody>
</table>

### 4.15 Configuring cylinders

If you require a specific cylinder that you cannot find in the FluidDraw standard library, you can use the cylinder editor to create your own cylinder symbols.
Insert a double-acting cylinder into a circuit window from the “Pneumatic symbols - ISO 1219-1 / Configurable symbols” library.

Double-click the cylinder to configure it. The Properties dialogue window opens. Click the “Configure Cylinder” tab. That opens the cylinder editor.

Figure 4/23: Properties dialogue window: Configure Cylinder tab

Cylinder Type

Click the button with the arrow to open the list of the symbol elements. Select a cylinder type. Defines whether the cylinder is to be single-acting or double-acting.
Specifies whether a spring is to be inserted for the return in the right or left cylinder chamber.

Click the button with the arrow and select a symbol element for the piston. Define whether the cylinder is to have end-position cushioning and whether it can be adjusted.

Click the button with the mouse pointer and select a symbol element for the piston rod.

You can use the slide ruler to specify the relative piston position in increments of 25 %. 0 % stands for a completely retracted piston and 100 % stands for a completely extended piston.

**4.16 Grouping symbols**

If you wish to combine multiple symbols to a group, then highlight them and select the [Home] menu item from the [Group] menu. Groups can also be nested, i.e. grouped objects can be grouped again.

A group is primarily a drawing aid and does not represent a new component. Every group element is added to a parts list in exactly the same way as without grouping. Double-click a group element to open the Properties dialogue window of the clicked group element.

If you want to combine multiple symbols to a new component with its own attributes then create a macro object.

**4.17 Creating macro objects**

If you wish to combine multiple symbols into a new component with its own attributes then highlight these and select the [Home] menu item from the Create Macro Object menu. This creates a new macro object. Macro objects are included in the parts lists as
independent components. The original symbols are removed from the parts lists. It is no longer possible to edit their component attributes.

4.18 Deleting symbol groups and macro objects

To delete a group or a macro object, highlight the group or the macro object and select the **Ungroup/Break Off** menu item in the **Home** menu. Always only the very outer group is deleted first. To delete nested groups, you must carry out the operation several times.

4.19 Aligning symbols

To mutually align objects, highlight them and select the desired alignment in the **Home** menu under the **Align** menu item or click the corresponding button on the toolbar.

4.20 Mirroring symbols

The symbols can be mirrored horizontally and vertically. To do this, select the desired mirror axis in the **Home** menu under the **Mirror** menu item or click the corresponding button on the toolbar. If you have highlighted several objects simultaneously, each object is mirrored on its own. If you want the operation to apply to a common mirror axis, group the objects prior to the operation.
You can also enter the drawing properties as component attributes under the “Drawing Properties” tab. Enter a negative sign in front of the scaling factor to mirror the symbol.

4.21 Rotating symbols

The symbols can be rotated in increments of 90 degrees or using the mouse pointer. For a rotation in 90 degree increments, select the desired angle in the Home menu under the Rotate menu item or click the corresponding button on the toolbar. If you have highlighted several objects simultaneously, each object is rotated on its own. If you want the operation to apply to a common axis of rotation, group the objects prior to the operation.

You can also rotate symbols using the mouse pointer by dragging the edge of the symbol. In order to do this FluidDraw must be in Enable Rotate mode. This mode can be activated or deactivated on the Edit ribbon page with the Enable Rotate menu item.

Note: Activating Enable Scale mode deactivates Enable Rotate mode and vice versa.

→ In Enable Rotate mode, click the edge of a symbol and keep the mouse button pressed.

![Figure 4/24: Rotating a symbol](image)

The current angle of rotation and auxiliary lines are displayed.

→ Keep the mouse button pressed and move the mouse pointer until the desired angle of rotation is established. The angle changes in 15 degree steps.
Note: If you also press the `Shift` key then you can rotate the symbol continuously.

Figure 4/25: Rotating a symbol

The angle of rotation can also be entered directly in the properties dialogue window on the Drawing Properties tab.

### 4.22 Scaling symbols

The component symbols can be scaled using the mouse pointer. In order to do this FluidDraw must be in Enable Scale mode. This mode can be activated or deactivated on the Edit ribbon page with the Enable Scale menu item.

Note: Activating Enable Scale mode deactivates Enable Rotate mode and vice versa.

→ In Enable Scale mode, click the edge or a corner of a symbol and keep the mouse button pressed.

Figure 4/26: Scaling a symbol

The current scaling relationship to the current original size is displayed.

→ Move the mouse pointer, keeping the mouse button pressed, until the desired size is established. The scaling relationship is
changed in increments of 0.25. If you also press the Shift key then you can scale the symbol continuously.

Figure 4/27: Scaling a symbol

You can simultaneously mirror the symbol by moving the mouse pointer over the middle of the symbol to the opposite side.

Figure 4/28: Mirroring a symbol

The scaling factors can also be entered directly in the Properties dialogue window on the Drawing Properties tab.
Chapter 5

FluidDraw provides some drawing frames that can be embedded at the project or page level. FluidDraw provides a special editor for adjustments or user-specific drawing frames. It can be used to flexibly adapt the header and the frame with the distribution of fields.

5.1 Using the drawing frame

To select a drawing frame that is to be used for all pages of the entire project, open the project’s properties dialogue. You can then overwrite this setting e.g. for a page with a parts list or for a complete project node and define a different drawing frame.

→ Open the properties of a page and activate the Drawing Frame tab. Remove the Inherit From Project option, if necessary.
Figure 5/1: *Page* dialogue window: inserting a drawing frame

**Inherit From Project**  
If this option is activated then the drawing frame specified in the project is copied into the circuit. The path and the file used are displayed in the "Frame File" line.

**Select...**  
This button is used to open a dialogue that can be used to select a frame provided. These frame files are to be found in the *frm* directory.

**Reload File**  
Reloads the frame from the specified file. That can be practical if the drawing frame was changed in the meantime.

**Edit...**  
Opens the frame file for editing in the *drawing frame editor*.
Remove Local Frame

Removes the drawing frame from the circuit. The attributes of the drawing frame are retained as attributes of the project or of the circuit.

Reload Frame Attributes

When you insert a drawing frame, the attributes of the drawing frame are listed. These attributes are saved with the project or with the circuit drawing and can be edited and deleted. You can use the Reload Frame Attributes to reload all attributes from the drawing frame and thus update the attribute list of the project or of the circuit drawing.

→ Click Select... to select a drawing frame.

Figure 5/2: Select Drawing Frame dialogue window

All available frame files are displayed as a tree on the left side. The desired drawing frame can be selected in this tree. The drawing frame is then displayed in the preview.

You can find a detailed description of the options for managing the drawing frames in the section: Manage templates
5.2 Drawing frame editor

You can use the drawing frame editor to create new drawing frames and edit existing frames.

The editor can be started regardless of a specific project or page directly via the main menu and the [Manage templates...] menu item.

Alternatively, you can open the editor via the properties of the project or of an individual page. Select a drawing frame first on the Drawing Frame tab and then press the [Edit...] button to open this frame in the editor to edit it.

5.2.1 The structure of a drawing frame

Creating or editing a drawing frame in the editor is split up into individual small steps, which are displayed on various tabs. The individual tabs are generally to be gone through in steps from the left to the right like in a wizard. For navigation, please use the two [Previous] and [Next] buttons at the bottom edge of the editor.

As an alternative, you also have the option of going directly to a specific tab by clicking its title. You can thus change specific aspects of the drawing frame in a selective manner. When you use the editor for the first time, we recommend that you go through all tabs once in succession to familiarise yourself with the contents of the individual steps.

The basic structure of a drawing frame consists of the following five components:

1. Drawing page
2. Outer frame
3. Page dividers
4. Inner frame

5. Header

The drawing space that can be used with the drawing page is defined by the inner frame. The following diagram illustrates the previously mentioned elements:

![Diagram](image)

Figure 5/3: Elements of a drawing frame

In the following steps, you have the option of changing all properties of these elements.
5.2.2 Drawing Size

![Drawing Frame Editor](image)

**Figure 5/4: Drawing Size tab**

On this page of the editor, you can assign a designation and change the size and alignment of the drawing frame. At the top, you can either select one of the specified default sizes from the stored list or enter your complete own dimensions. You can adapt the alignment of the frame below.

In addition, the current dimensions are displayed to you in the preview on the right side for illustration.
5.2.3 Page border

You have the option here of designing the outer and inner frame lines according to your requirements.

At the top you can select the line width, line type and colour properties for the corresponding frame line. If desired, you can also remove one line or both lines from the drawing by means of the check box.

In the centre, you can set the outer edge between the outer frame line and the edge of the drawing page, as well as the inner edge between the two frame lines. Your changes of the set values are displayed to you directly in the preview on the right side.

At the bottom, you can have additional markings drawn in the drawing frame.

Figure 5/5: Page border tab
5.2.4 Page Dividers

The page dividers can be configured on this tab.

At the top, on the left side, you can configure the labelling properties of the individual rows. In the area below, you can configure the labelling properties of the individual columns.

For the distribution of the rows and columns you can either specify a fixed number or a specific height or width.

— If you define a specific row height or column width, then the columns/rows are entered with the specified width/height, starting at the centre of the inner frame. The last column or the last row on both pages of the drawing frame may be smaller than the specified width with this distribution. The following diagram gives an example of the distribution of the columns on a DIN A4 page in landscape format with a set column width of 50 mm.
If you instead specify a fixed number of rows or columns, the width/height of the inner frame with the specified number is split up into columns of the same size. The following diagram shows the distribution of the columns on the same DIN A4 page as previously with six columns.

The numbers define how the columns or rows are to be labelled. You can choose between numerical labelling and alphabetic labelling with upper or lower case. You can enter with which number or letter the caption is to begin with in the First Item field.

By default, the columns are labelled continuously from the left to the right and the rows from top to bottom. Select the Descending Order check box if you want to reverse the labelling order.

The current status of the page division is displayed to you on the right side together with special control elements for manually adjusting the division. The control elements displayed there match those in the page windows in FluidDraw and can also be used to configure the complete page division manually. The width and the height of the vision always correspond to the complete width or height of the inner frame here, however.
5.2.5 Title block customizing

Figure 5/9: *Title block customizing* tab

You can adjust and design the header according to your requirements here.

General design and layout of the header

The header within the drawing frame consists of a table with a specific number of columns and rows. Either a fixed text, an attribute link or an image can be entered in the individual cells of the table.

Using the **Select template...** button at the top edge of the tab, you can open a dialogue that you can use to load predefined headers into the editor.
Figure 5/10: Dialogue for selecting a header

You can use the dialogue to select a template for the header. Either use one of the integrated templates or select a user-defined template. The selected header is displayed to you as a preview on the right side.

**Selecting/highlighting cells**

You can select individual cells of the table by left-clicking them. The selected cell is then displayed with a thicker, blue border. The contents of the selected cell, its cell properties and the dimensions of the corresponding row and column are shown below the displayed table.

You can highlight an area with several cells by moving the mouse over further cells while keeping the left mouse button pressed. Alternatively, you can click the first and last cell one after the other while keeping the **Shift** key pressed. You can highlight several cells not connected by clicking them with the mouse and keeping the **Ctrl** key pressed. The selected area is given a thick blue border.

**Adjusting the table structure**

You can change the number of rows and columns of the current table by right-clicking a cell within the table. A context menu appears for the currently selected cell. You can find commands for adding or deleting rows or columns below the **Insert** and **Delete** menu items.

You can change the width of a column or the height of a row by moving the mouse pointer to the edge of the cell, pressing the left
mouse button there and moving the cell border accordingly. The corresponding cell is thus increased and reduced in size along with the overall width/overall height of the table. Keep the Ctrl pressed when you move the mouse to change the size of the cell without changing the overall width/overall height of the table.

As an alternative to changing the cell width or cell height by moving the mouse, you can enter the dimensions directly in the input fields below the displayed table. First select a cell from the row / column that you want to change and then enter the desired values in the input fields.

Several cells can be joined to form one cell within the table. Such a joined cell then covers several columns and/or several rows.

To connect several cells, highlight them first in the table and then click the Merge cells button on the menu bar above the table displayed. Only a rectangular continuous cell area can be connected. When the connection is established, only the contents and formatting from the top left cell of the highlighted area are retained. The Split cells button is available to separate a joined cell.

**Entering a fixed text**

You can enter a fixed text in a cell by double-clicking the cell with the left mouse button. An input cursor appears in the cell and you can enter the desired text directly. You can also highlight a cell and press the F2 function key to activate direct cell input.

These texts entered by you are not saved in a language-dependent manner. That means the text you entered is shown as entered, regardless of the page or project language used later on. If you want to use a language-dependent text, you can use the predefined attribute texts, which are displayed to you in the list next to the displayed table. Highlight the desired text, drag the text with the left mouse button pressed into the desired table cell and let go of the mouse button there. Only then is the corresponding internal placeholder for the attribute text entered in the cell. For the “Project” attribute, for example, the internal placeholder is “~FrmAttProject”.

**Text formatting**

You can change the text formatting of a cell using the menu bar above the displayed table. Select those cells in the table whose formatting you want to change. Then, click the corresponding button on the menu bar or select the desired value.
Using the menu bar, you can change the following formatting properties:

- Font
- Font size
- Font style (B = bold; I = italics; U = underlined)
- Horizontal alignment (left; centred; right)
- Vertical alignment (top; centred; bottom)
- Background colour
- Font colour

If you select a cell in the table, the font and font size of the selected cell are automatically displayed on the menu bar. The buttons for the font style, and horizontal and vertical alignment are enabled according to the current setting in the cell.

You can insert an image in a cell by selecting the desired cell and then clicking the **Choose picture...** button below the displayed table. A dialogue appears that you can use to select your image for insertion. The file formats Bitmap, JPEG, PNG and GIF are supported.

The path and the file name of the selected image are displayed to you after selecting the image in the input field using the button and the image is displayed in the highlighted cell of the table. The size of the image is adapted taking the correct width-to-height ratio of the cell into account. The maximum width or height of the cell is always utilised for display purposes. Increase the size of the cell if the displayed image is to be increased in size.

A newly inserted image is linked to the cell via the path and the file name. That is indicated by the selected **External Link** check box. For each subsequent use of the drawing frame, the image is reloaded.
from the specified location. If it is not found there, a red X is displayed instead of the image.

To permanently integrate the image in the drawing frame, remove the check mark from the External Link check box. The image is embedded in the drawing frame and is always visible in the drawing frame regardless of the path of the original file. By embedding graphics in the drawing frame, you increase the memory space required for the drawing frame and the projects that use this frame. Therefore, it is best to use images that save space.

Setting frame lines

The frame lines in a cell are influenced using the Borderlines button on the menu bar above the displayed table. Select those cells in the table that you want to give a frame. Then click the small triangle at the right edge of the button to open a selection menu of the available frame lines.

Figure 5/12: Frame line selection

You can set the desired frame for the highlighted cells from this menu. By selecting No border, you remove all existing borders from the selected cells. Your frame selection is transferred to the button and can be set for other cells by clicking the button directly.

Frame attributes and variables

In addition to the previously described contents of the fixed texts and images, variable elements can also be inserted in the header, whose value is determined later on when the drawing frame is used in a specific project or page. These are drawing frame attributes, which are managed later on in the properties of the project or page,
and also predefined variables, which are automatically replaced by the corresponding value in the drawing.

**Drawing frame attributes**

Drawing frame attributes are special placeholders that you can define in the header and at whose point in the final drawing the value of the attribute of the corresponding page or of the project is displayed. That can be e.g. the name of the project, the title of the drawing or the release date.

The available attributes are displayed to you on the left side of the dialogue in a list view. You can find predefined attributes, predefined variables and user-defined attributes in this list.

Every frame attribute generally consists of two parts: an attribute caption and a placeholder that is replaced by the value of the entered attribute later on. The attribute caption is to be found in the *Displayed Text* column and the placeholder in the *Default value* column. The placeholder is displayed in the *Default value* column in grey fonts in pointed brackets if no default value is entered.

To use an attribute in its frame, select the placeholder of the desired attribute in the *Default value* column and drag it, while keeping the left mouse button pressed, into the desired table cell. If you let go of the mouse button over the desired cell, the selected placeholder is entered there for the attribute. Only by entering the placeholder in the header is the selected attribute displayed on the “Attributes” tab later on when the drawing frame is used. You can assign a specific value to it.

You can store default values for attributes in the drawing frame. To do this, double-click the corresponding placeholder in the attribute list and enter the desired default value. It is then displayed in the header instead of the placeholder for the attribute. However, the placeholder is still entered in the corresponding cell. Later on when the drawing frame is used, the entered default value is transferred as an attribute value to the diagram. However, it can be changed at any time there. By entering a default value, you also have the option of checking if the text formatting and the size of the cell are correct.
If you want to add the attribute caption in the header in addition to the placeholder for the attribute value, then highlight the corresponding caption in the *Displayed Text* column and then drag it, with the left mouse button pressed, into the desired cell of the table. The predefined attributes use special variables for the caption in order that the attribute caption can be displayed in the corresponding page language.

In addition to the predefined attributes and variables, you have the option of defining your own attributes. To add an attribute, click the **Add Attribute...** button and enter a name for the attribute. Then, the new user-defined attribute is displayed to you in the list and you can use it like the previously described predefined attributes in the header. The only difference to the predefined attributes is that the caption depends on the language and is not automatically translated, even if there are different page languages.

**Variables**

The attribute list on the page on which the table is displayed contains the following predefined variables:

- Page number
- Description
- Installation
- Circuit
- Location
- File Name
- Full file path
- Full project path
- File modification date and time
- File modification date
- File modification time
- Total project pages
These predefined variables are used in exactly the same way as the previously described frame attributes. Drag the desired variable from the list into the table. The difference is that the values for the variables in the specific drawing are entered automatically, which is why you cannot specify a default value.

5.2.6 Title block location

![Drawing Frame Editor](image)

Figure 5/13: *Title block location* tab

You can adjust the position of the header within the drawing frame here.

Select the desired position from the specified options. The modified position of the header is displayed to you in the preview on the right side.
5.3 Adding fixed elements to drawing frames

The drawing frame editor shown in the previous section can be used to create a drawing frame with the main graphic elements and, above all, a dynamic title block. Additional graphic elements, such as a watermark or a copyright notice, cannot be created within the editor. A different concept is provided for this.

Not only those files created with the drawing frame editor can be used as drawing frames. In addition, it is also possible to use each individual sheet of an existing project as a drawing frame in another project. This way you have the possibility to enrich a drawing frame with other elements.

The following example shows how you can add a watermark with text to a given drawing frame:

→ Create a new project with a single page.

→ Select and assign a drawing frame that you want to enrich with additional objects.

→ Add all new elements to the sheet at the right location. To create a watermark, insert a text object with the menu item Text in the menu Insert. Utilize the possibilities to format a text to increase the font-size, to rotate the text or to change the colour.
Figure 5/14: Example for a watermark with fixed text

You can also insert a text object that will contain an attribute value of the project or sheet. For this insert a new text object with a simple text like “ReleaseStatus”. Additionally set the option *Attribute Link* within the properties of the text object. The text will then be shown in angle brackets. The entered text “ReleaseStatus” will be the new frame attribute that will show up in the project attributes where you can enter a value for it.
In order for the extended drawing frame to be used in another project, the project just created must be added to the template management. This only has to be done once. The entry is then preserved and can be used like all other entries.

→ Open the template management with the menu item **Manage templates...** in the menu **Manage**.

→ Klick with the right mouse button on the topmost node with the label *Drawing Frame* and select **Add Existing Files...** from the context menu.
Figure 5/16: Adding an existing file to the drawing frame templates

→ A dialogue to select a file appears, but initially the dialogue does not show FluidDraw project files. You can change that by selecting a different file filter in the lower right of the dialogue. Change it from “Drawing Frames (*.frm)” to “Project Files (*.fdprj; *.prj).

Figure 5/17: Changing the file filter to show project files

→ Now navigate to the path where you saved the previously created project, select the project and click Open... The project is then included as a reference in the drawing frame selection and is available as a new entry.

Now you can use the page with the enhanced drawing frame as drawing frame in your projects.

→ Open an existing project or create a new project.

→ Select and assign the new enhanced drawing frame for the project. (In this example the page with a watermark.)
When you have created an additional frame attribute, you will find it in the project properties in the **Attributes** tab. There you can enter an attribute value analogue to the other attributes from the title block and it will show up in the prepared text field.

**Notes:**

— The project with the extended drawing frame can also contain several sheets, e.g. with different contents. The appropriate frame can be selected according to requirements.

— The extended drawing frame can no longer be edited directly in the drawing frame editor. If you want to change the drawing frame, reopen the frame project in FluidDraw and edit the corresponding pages. The drawing frame editor can then be called from there.
With the extended drawing frames, it is still the case that all objects of the drawing frame are placed on drawing layer 0 and cannot be changed. A prominently placed watermark in the background does not disturb the drawing creation.

5.4 Page dividers

A circuit diagram or page can be logically divided into rows and columns, which can be labelled with numbers or letters. These page dividers are usually shown in the drawing frame and serve as a means of orientation within the page. Above all they allow the current paths (columns) of contacts to be specified in the contact images.

The graphical representation of the page dividers matches the logical page dividers in the drawing frames provided. The logical page dividers can be shown and hidden via the [Show Page Dividers] menu item in the [View] menu or using the [ ] button. They are displayed at the left edge as well as the upper edge of the circuit window.

If the page dividers are displayed you can customise them using the mouse so that they match the graphical representation of the drawing frame, for example. This customisation can be done in different ways:

→ Click and hold the mouse buttons in a column or row to move the entire column or row.

→ Click and hold the mouse buttons at the outer margin of a column or row to move the margin of the column or row.
The opposite margin is not moved and the columns or rows are resized proportionally.

→ Click and hold the mouse buttons at the margin of an inner division in a column or row to move the margin of the column or row.

In this case only the adjacent columns or rows are resized.

Columns and rows can be inserted and removed using the and buttons.

The labelling type and the number of rows and columns can be defined using the button. The settings are saved as page properties. The following dialogue window is opened:
Figure 5/22: Page dialogue window, Page Dividers tab

Adopt from drawing frame
If this option is activated then all settings that have been defined in the drawing frame are adopted.

Rows
Defines the settings for the horizontal rows.

Columns
Defines the settings for the vertical columns.

Number
Defines the number of page dividers.

Numbering
Numbers, lower case letters or upper case letters can be used for numbering.

First Item
Defines the first numbering item. Numbering is continued in the same way starting with this element.

Descending Order
Reverses the numbering order.

Skip letters ‘I’ and ‘O’
If this option is active, the letters “I” and “O” are not used for numbering. That prevents any risk of confusion with the numbers “1” and “0”.
Reset

Resets the page dividers to default values.
Chapter 6

6.1 Drawing aids

6.1.1 Grid

For arranging the symbols and inserting the lines it is often practical to show a point or line grid. You can activate or deactivate the display of the grid using the View menu item in the Show Grid menu. You can define more grid settings in the Manage menu under the Options... menu item on the Representation Grid tab.

In order to simplify handling the connectors snap into place when they are close to a grid line. This makes it easier to find the precise position when moving the connectors.

Note: The grid snap function may sometimes not be desired as it prevents free positioning. In this case you can keep the Ctrl key pressed during the moving operation, which temporarily deactivates the grid snap function.

6.1.2 Alignment lines

Connectors of symbols should be aligned horizontally or vertically as precisely as possible. Then, they can be connected with a straight line.

FluidDraw supports precise positioning by the grid snap function on the one hand, and by automatically displaying red alignment lines while the highlighted objects are moved on the other hand.
Opens a circuit file that contains several objects. Highlight one of them and move it slowly back and forth over and next to other objects.

Pay attention to the red dashed lines that appear if two or more connectors lie below each other.

![Figure 6/1: Automatically displaying the alignment lines](image)

In order to simplify handling the connectors snap into place when they are close to an alignment line. This makes it easier to find the precise position when moving the connectors.

Note: The grid snap function may sometimes not be desired as it prevents free positioning. In this case you can keep the Ctrl key pressed during the moving operation, which temporarily deactivates the alignment lines and the grid snap function.

### 6.1.3 Object snap

Various snap points can be activated for precise drawing. During a drawing operation the mouse pointer snaps into place as soon as it is close to a snap point.

The following snap functions are available, which can be selected individually via the ribbon under **Edit Snap**: 
6.1.4 Rulers

The rulers can be shown and hidden via View > Show Rulers. They are displayed at the left-hand as well as the upper edge of the circuit window.

6.2 Drawing layers

FluidDraw supports 256 drawing layers that can be shown/hidden and disabled/enabled individually. You can also define the colour, the style and the line width for each drawing layer.

Like with most other settings, you can also define drawing layers separately for the project, a project node or a page. When you create a new project, the default settings defined under Manage in Options... > Drawing Layers are copied. You can change these settings at any time individually in the properties of a project node or page.

Note: The drawing frame is in layer “0” by default.
Inherit From Parent Node

If this option is selected, defined drawing layers are used for the page in the project or in the parent project node.

Copy from global options

This is for copying the settings defined under [Manage] in [Options...]/[Drawing Layers].

⚠️ Please note that the global settings are then copied **once**. If the global settings for the drawing frame change later on, the locally copied drawing layers are retained. That ensures that the appearance of the circuit diagrams does not depend on the user’s individual settings.
On insert objects to page  Define the drawing layer of the objects here if they are inserted via the clipboard or from another page.

Default Layer  You can select the drawing layer where newly inserted objects should be placed here. If you do not want the symbol level to be changed when objects are inserted then select the “Preserve Object Layer” option.

Number  Defines the number of the drawing layer.

Description  Defines the description of the drawing layer.

Color  Defines the colour of the objects in this drawing layer.

Line Style  Defines the line style of the objects in this drawing layer.

Line Width  Defines the line width of the objects in this drawing layer.

Display  If this option is deselected, the corresponding drawing layer is not visible and cannot be edited either.

Edit  If this option is deselected, objects located in the relevant drawing layer are visible but cannot be highlighted and therefore neither moved nor deleted.

6.3 Displaying line jumps

Intersecting lines are sometimes difficult to distinguish from T-distributors. FluidDraw therefore provides the option of displaying crossing lines as line jumps. You can find the option as a default setting under Manage / Options... and as a page or project setting under Representation.
To edit the circuits, it is frequently useful to select specific object types or objects simultaneously at certain drawing layers. In addition to the methods already described with the Ctrl key pressed and the creation of a selection rectangle, FluidDraw provides the Select menu.

The selection of the different object types can be used in two ways:

- Set the desired object types before selecting them. With this option, you define which object types are to be highlighted during subsequent selection operations. This filter can be used if you simply click an object, when you create a rectangle and also with the Select All command. Only objects that meet the selection criterion are highlighted.
— Set the desired object types after selecting them. With this option, you can subsequently limit a selection already made. First select individual objects or all objects and highlight an area with the mouse. Then deactivate those object types that you want to exclude from the selection. FluidDraw memorises the originally selected objects so that you can adapt the object types as desired. However, more object types are never selected than were highlighted before selecting the filter.

After using the selection filter, make sure to switch back to the All Objects option to be able to fully edit your circuit diagram again.

Active Drawing Layer Only

With this option, the selection only applies to the selected drawing layer.

→ First cancel all selections by clicking a free space on the page or by pressing the Esc key.

You can thus select the standard drawing layer without changing any highlighted objects.

→ Now select the drawing layer you want to edit from the drop-down list.

You can now combine the Active Drawing Layer Only option with the other criteria.

Protect connector texts

That prevents any inadvertent displacement of the connector texts if you want to move a symbol.

FluidDraw permits the positioning of identifications, connector designations and attribute links as desired. These texts move along with the corresponding symbol when it is moved. In the case of small symbols or e.g. valves with many connectors, it is possible that you inadvertently select a connector text although you wanted to move the entire symbol. In this case, you will inadvertently move the text away from the symbol.

To avoid this type of operational error, the connector texts can be protected. These texts can therefore not be moved individually. Instead the entire symbol is automatically highlighted with all other associated texts. Deactivate this option if you want to position connector texts individually again.
Layer

In this drop-down list, you define the drawing layer to which the object selection is to apply.

6.5 Cross-references

Cross-references serve to link connected parts of a circuit drawing when the entire drawing is spread across several pages. This allows lines to be interrupted, for example, and continued on another page.

FluidDraw supports two types of cross-references. Paired cross-references consist of two cross-reference symbols that refer to each other. The two cross-reference symbols are linked via a unique label that is entered for both symbols.

The option also exists to reference any object within a project from a cross-reference symbol. The cross-reference is unidirectional in this case: from the cross-reference to the target object. This allows several cross-references to refer to the same object.

Both types enable you to jump directly from a cross-reference to the associated destination. With the paired cross-reference the destination is the corresponding cross-reference, otherwise an object.

Paired cross-references are to be found as symbols in the standard library under “Drawing elements and cross-references” and can be inserted in circuit drawings.

You jump to the corresponding destination either using the Jump to Target button in the properties dialogue window for the cross-reference symbol or by highlighting the cross-reference and selecting the Jump to Target menu item from the context menu.

The circuit drawings involved must belong to the same project. Open the Home dialogue window via the Properties... menu and the Cross-reference menu item. Alternatively you can open this dialogue window by double-clicking the cross-reference symbol or using the Properties... context menu.
Figure 6/5: *Cross-reference* dialogue window

**Layer**
The cross-reference is assigned to this drawing layer.

**Text**
This text is displayed in the cross-reference.

**Label**
Defines the label used to identify the cross-references linked to each other.

**Link**
If this option is activated then the label entered represents a link to a target object. The cross-reference only works in the direction of the target object in this case. This option can be combined with the *Show Location* option to show the location of the target object.

**Target Text**
If the *Show Location* option is activated then the position of the target object is displayed here. The representation of the position is defined in the *Cross Reference Representation* tab in the properties dialogue window for the page or project.

If *Show Description* is activated then the text of the corresponding cross-reference is displayed for paired cross-references, otherwise the description of the target object is displayed.

**Display Target Text**

If this option is activated then the above-mentioned text from the *Target Text* field is displayed below the text for this cross-reference.

**Jump to Target**

Pressing this button opens the circuit window that contains the corresponding cross-reference. The relevant symbol is indicated by an animation.

The font, text colour and alignment of the texts to be displayed can also be customised.

### 6.5.1 Creating cross-references from symbols

You can create a cross-reference from one or more symbols.

→ To do so highlight the corresponding symbols and select the [Home][Create Cross-reference] menu item or the [Create Cross-reference] menu item from the context menu.

The highlighted symbols are combined into a group that represents a cross-reference with two additional texts. One of these texts shows the label used and the other the target text for the cross-reference.
6.5.2 Cross-reference representation

The position of the target object can be shown in cross-references. How it is represented can be specified on the *Cross Reference Representation* tab in the properties dialogue window for the circuit or project. The position can be compiled from the “*Page number*”, “*Page*”, “*Page Column*”, “*Page Row*”, “*Target Connector*”, “*Target Object*” and “*Object Identification*” components. These refer to the target object. Separators can be specified before and after each component. The default representation is:

/ *Page number*. *Page Column* The description of the page and the page number is specified in the *Properties dialogue window for the circuit*. The page number is a *predefined placeholder* that can be used in *text components* and *drawing frames*, among other things.
Figure 6/6: Cross Reference Representation tab

Inherit From Parent Node

- Defines whether the representation rules for the parent node should be applied.

Copy from global options

- This is for copying the settings defined under Manage in Options... / Cross Reference Representation.

- Please note that the global settings are then copied once. If the global settings for displaying the cross-reference change later on, the locally copied options are retained. That ensures that the appearance of the circuit diagrams does not depend on the user's individual settings.
Suppress Inherited Parts

If this option is active, components of the cross-reference are hidden that are valid for all elements of the corresponding page or project.

Example

A position example that conforms to the specified rules is displayed here.

6.5.3 Managing cross-references

All paired cross-references in a project are listed in a dialogue window that is opened using the Project Manage Cross References... menu item. Using this dialogue you can jump to all paired cross-references in the project.

Figure 6/7: Manage Cross References... tab

Label

Contains the label for the corresponding cross-reference.
6.6 Drawing functions and graphical elements

Graphical elements can be inserted into a circuit via the [Insert] under Object or [Draw]. In order to prevent you from unintentionally moving other symbols when drawing you activate a special mode for the drawing function in which you can only perform the selected drawing functions. After every drawing operation FluidDraw returns to the normal editing mode. To insert another drawing element you must select the associated menu item or the corresponding drawing function on the toolbar again.

Note: If you want to draw several elements in succession without exiting the special drawing mode every time, then you can select the menu item or the corresponding drawing function on the toolbar while keeping the [Shift] key pressed. Drawing mode then remains active until the menu item or the drawing function is deactivated by selecting it again or another drawing function is selected without the [Shift] key being pressed.

The [Insert] ribbon page contains the [Draw] and Object groups with the following buttons:

- Switches to the mode for inserting a text.
- Switches to the mode for inserting an image.
- Switches to the mode for drawing a line.
- Switches to the mode for drawing a rectangle.
- Switches to the mode for drawing a circle.
Switches to the mode for drawing an ellipse.

Switches to the mode for drawing a polyline.

Switches to the mode for drawing a conduction line. You can start by choosing whether you would like to draw a pneumatic, hydraulic or electric conduction line.

Switches to the mode for drawing an interruption or potential. You can start by choosing whether you would like to draw a pneumatic, hydraulic or electric interruption or such a potential.

The Edit ribbon page enables the definition of the line attributes:

- The graphical elements are drawn in the specified colour.
- The graphical elements are drawn with the specified line style.
- The graphical elements are drawn with the specified line width.
- The starts of lines are drawn with the specified symbol.
- The ends of lines are drawn with the specified symbol.

Any change to the line attributes does not only apply to drawing elements that will be inserted in the future, but also to any currently highlighted objects. In this case, you will be asked whether the properties are also to be transferred to the currently highlighted objects.

6.6.1 Hatching

Drawing elements that define an area, such as rectangles, circles or polylines can be given a hatching. The corresponding elements have a Hatching button that can be used to open the hatching dialogue.
Figure 6/8: *Hatching* dialogue window

**First Pattern**
- **Line color**: You define the settings for the first hatching here.
- **Line Style**: Defines the colour of the hatching.
- **Line Width**: Defines the line style.
- **Line Width**: Defines the line width.
- **Angle**: Defines the angle of the hatching.
- **Distance**: Defines the line spacing of the hatching.

**Second Pattern**
- A second hatching can be activated as an option that can be combined with the first pattern.
6.6.2 Text

A text is inserted at the position of the mouse pointer with a click. That opens the Properties dialogue window for entering the text and setting the attributes.

A text can be inserted using the corresponding button of the Object group on the Insert ribbon page.

6.6.3 Image

An image is inserted at the position of the mouse pointer with a click. That opens the dialogue window for selecting an existing image file.

An image can be inserted using the corresponding button of the Object group on the Insert ribbon page.

Large background images can reduce the processing speed significantly, as when symbols are moved or edited the screen view needs to be rebuilt.

The image-specific properties can be defined in the Properties and Drawing Properties tabs of the Picture dialogue window for the image:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Defines the top left position of the image.</td>
</tr>
<tr>
<td>Scale</td>
<td>Defines the scaling in x or y direction.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Defines the rotation angle in degrees.</td>
</tr>
<tr>
<td>Override Color</td>
<td>Defines the colour of the drawing element.</td>
</tr>
<tr>
<td>Background</td>
<td>Defines that the drawing element is displayed in the background. This means that all circuit symbols are on top of it. In particular this means that symbols are not covered by filled drawing elements, for example.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Defines that the drawing element is displayed in the foreground. This means that all circuit symbols are under it. In particular it means that symbols are covered by filled drawing elements, for example.</td>
</tr>
</tbody>
</table>
Figure 6/10: *Properties* dialogue window of an image: *Picture* tab

<table>
<thead>
<tr>
<th>File</th>
<th>Defines the image file of the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Link</td>
<td>If the option is selected FluidDraw only saves one link to the image file. If this option is deselected, however, the image is embedded in the circuit. This is the option to be preferred if you want to forward or archive the circuit drawing.</td>
</tr>
</tbody>
</table>

### 6.6.4 Line

A line is drawn by defining two points. In contrast to a conduction line this line is purely a drawing element. As such it can be drawn with any desired angle but does not allow connections with pneumatic or electric connectors.

A line can be inserted using the corresponding button of the **Draw** group on the **Insert** ribbon page.

The line-specific properties can be defined in the *Properties* dialogue window for the line on the *Drawing Properties* tab:
Start Point: Defines the x/y coordinate of the starting point.
End Point: Defines the x/y coordinate of the end point.
Scale: Defines the scaling in x or y direction.
Rotation: Defines the rotation angle in degrees.
Color: Defines the colour of the drawing element.
Line Style: Defines the line style.
Line Width: Defines the line width.
Start Cap: Defines how the beginning of the line is displayed.
End Cap: Defines how the end of the line is displayed.
Background: Defines that the drawing element is displayed in the background. This means that all circuit symbols are on top of it. In particular this means that symbols are not covered by filled drawing elements, for example.
Defines that the drawing element is displayed in the foreground. This means that all circuit symbols are under it. In particular it means that symbols are covered by filled drawing elements, for example.

Reset

Reset the settings to the default values.

6.6.5 Rectangle

A rectangle is drawn by defining two diagonally opposite corner points.

A rectangle can be inserted using the corresponding button of the Draw group on the Insert ribbon page.

The rectangle-specific properties can be defined on the Drawing Properties tab of the Properties dialogue window for the rectangle:
Figure 6/12: Properties dialogue window of a rectangle: Drawing Properties tab

- **Position**: Defines the top left position of the rectangle.
- **Scale**: Defines the scaling in x or y direction.
- **Size**: Defines the width and the height of the rectangle.
- **Rotation**: Defines the rotation angle in degrees.
- **Color**: Defines the colour of the drawing element.
- **Fill Area**: Fills the rectangle with the specified colour.
- **Hatching**: If this option is active, the specified hatching is used to fill the rectangle.
- **Scale/rotate**: With this option, you define if the hatching is to be scaled and rotated with the drawing element or whether the set angles and spaces should be retained for the hatching, regardless of the drawing element.
- **Line Style**: Defines the line style.
Defines the line width.

**Background**
Defines that the drawing element is displayed in the background. This means that all circuit symbols are on top of it. In particular this means that symbols are not covered by filled drawing elements, for example.

**Foreground**
Defines that the drawing element is displayed in the foreground. This means that all circuit symbols are under it. In particular it means that symbols are covered by filled drawing elements, for example.

### 6.6.6 Circle

A circle is drawn by defining the centre and the radius. You can draw a circular arc by subsequently entering a start angle and an end angle in the *Properties* dialogue window for the circle under *Drawing Properties*.

A circle can be inserted using the corresponding button of the [Draw] group on the [Insert] ribbon page.

The circle-specific properties can be defined on the *Drawing Properties* tab of the *Properties* dialogue window for the circle:
Figure 6/13: Properties dialogue window of a circle: Drawing Properties tab

**Position**
Defines the centre of the circle.

**Scale**
Defines the scaling in x or y direction.

**Arc**
Defines the start and end angles of a circular arc.

**Size**
Defines the radii in the x and y directions.

**Rotation**
Defines the rotation angle in degrees.

**Color**
Defines the colour of the drawing element.

**Fill Area**
Fills the circle with the specified colour.

**Hatching**
If this option is active, the specified hatching is used to fill the circle.

**Scale/rotate**
With this option, you define if the hatching is to be scaled and rotated with the drawing element or whether the set angles and spaces should be retained for the hatching, regardless of the drawing element.
**Fill mode**
Determines whether the *circle sector* (circle sector between the “pie” radii) or the *circle segment* (circle segment along the chord of the circle) is to be filled.

**Line Style**
Defines the line style.

**Line Width**
Defines the line width.

**Start Cap**
Defines how the beginning of the line is displayed.

**End Cap**
Defines how the end of the line is displayed.

**Background**
Defines that the drawing element is displayed in the background. This means that all circuit symbols are on top of it. In particular, this means that symbols are not covered by filled drawing elements, for example.

**Foreground**
Defines that the drawing element is displayed in the foreground. This means that all circuit symbols are under it. In particular, it means that symbols are covered by filled drawing elements, for example.

**6.6.7 Ellipse**

An ellipse is drawn by defining a centre and two axially parallel radii. You can draw an elliptical arc by subsequently entering a start angle and an end angle in the *Properties* dialogue window for the ellipse under *Drawing Properties*.

An ellipse can be inserted using the corresponding button of the [Draw] group on the [Insert] ribbon page.

The ellipse-specific properties can be defined in the *Properties* dialogue window for the ellipse on the *Drawing Properties* tab:
Figure 6/14: Properties dialogue window of an ellipse: Drawing Properties tab

Position
Defines the centre of the ellipse.

Scale
Defines the scaling in x or y direction.

Arc
Defines the start and end angles of an elliptical arc.

Size
Defines the radii in the x and y directions.

Rotation
Defines the rotation angle in degrees.

Color
Defines the colour of the drawing element.

Fill Area
Fills the ellipse with the specified colour.

Hatching
If this option is active, the specified hatching is used to fill the ellipse.

Scale/rotate
With this option, you define if the hatching is to be scaled and rotated with the drawing element or whether the set angles and spaces should be retained for the hatching, regardless of the drawing element.
Fill mode
Determines whether the *ellipse sector* (sector between the “pie” radii) or the *ellipse segment* (segment along the axis) is to be filled.

Line Style
Defines the line style.

Line Width
Defines the line width.

Start Cap
Defines how the beginning of the line is displayed.

End Cap
Defines how the end of the line is displayed.

Background
Defines that the drawing element is displayed in the background. This means that all circuit symbols are on top of it. In particular this means that symbols are not covered by filled drawing elements, for example.

Foreground
Defines that the drawing element is displayed in the foreground. This means that all circuit symbols are under it. In particular it means that symbols are covered by filled drawing elements, for example.

6.6.8 Polyline (traverse line)

A polyline (also called a line chain, section chain or polygon chain) is drawn by defining two or more points. Each mouse click sets a further vertex. The polyline is ended by clicking the same point twice.

A polyline can be inserted using the corresponding button of the [Draw](#) group on the [Insert](#) ribbon page.

The properties of the polyline can be defined on the *Properties* tab in the *Drawing Properties* dialogue window:
Figure 6/15: Properties dialogue window of a polyline: Drawing Properties tab

Position
Defines the top left position of the surrounding rectangle.

Scale
Defines the scaling in x or y direction.

Rotation
Defines the rotation angle in degrees.

Color
Defines the colour of the drawing element.

Fill Area
If this option is active, the inner area of the polyline is filled with the specified colour.

Hatching
If this option is active, the inner area of the polyline is filled with the specified hatching.

Scale/rotate
With this option, you define if the hatching is to be scaled and rotated with the drawing element or whether the set angles and spaces should be retained for the hatching, regardless of the drawing element.

Line Style
Defines the line style.
Line Width

Defines the line width.

Start Cap

Defines how the beginning of the line is displayed.

End Cap

Defines how the end of the line is displayed.

Background

Defines that the drawing element is displayed in the background. This means that all circuit symbols are on top of it. In particular this means that symbols are not covered by filled drawing elements, for example.

Foreground

Defines that the drawing element is displayed in the foreground. This means that all circuit symbols are under it. In particular it means that symbols are covered by filled drawing elements, for example.

To change the vertices of a polyline or to set new vertices switch to “polyline edit mode” by selecting the Edit Poly Line menu item or by activating the button on the toolbar.

You can move the existing vertices by clicking and dragging them. The mouse pointer changes to when you mouse over an existing vertex. If the mouse pointer is over a line without a vertex is displayed and a new vertex is inserted as soon as you click.

You can remove an existing vertex by clicking the corresponding vertex while keeping the key pressed.

6.6.9 Connecting cable

A conduction line is drawn by defining two end points. A pneumatic or electric line of this type consists of two connectors with a line between them. Both connectors can be used as the starting point for further connections. The conduction lines can only be drawn horizontally or vertically.

On the ribbon page in the group select the menu item.
Type of connection line

Selects the conduction line type. The following are available: “Pneumatic”, “Hydraulic” and “Electric”.

Define multiple lines

Multiple conduction lines can be set one after the other if this option is active. You can cancel the action by pressing the Esc key.

If multiple conduction lines with the same distance between them are to be drawn horizontally or vertically then change the number in the “Number of lines” field. You specify the distance to be maintained between the lines using “Distance”.

Under “Start Point Appearance” and “End Point Appearance” you can define the representation of the respective end point. If the “Display Identification” option is selected then the identification of the start point is displayed. In order to guarantee that the same
identification is displayed for the start point and the end point, a
text reference for the start point is displayed for the end point
instead of its identification.

**Interruptions** are used as end points for conduction lines.

After confirming the dialogue window you switch to a special mode
where you define the end points of the line with two consecutive
mouse clicks. Alternatively you can also draw a line by clicking and
dragging it.

An electric conduction line can be a potential line. This is described
under **Potentials and conduction lines**.

### 6.6.10 Interruption/potential

If conduction lines are spread over several pages then the line ends
can be assigned interruptions. Interruptions can be used to define
that a conduction line is only interrupted in the drawing and is
continued elsewhere. An interruption can be assigned an identifica-
tion and linked with another interruption. The location of the linked
interruption can be displayed at the source interruption. If an
electric interruption is used with an electric line then this interrup-
tion represents a potential. The use of electric potentials is de-
scribed under **Potentials and conduction lines**.

You can insert an interruption into an existing line or position it
freely in a circuit.

→ On the **Insert** ribbon page in the **Link** group select the
**Interruption/Potential...** menu item.

A dialogue window opens where you can make various settings for
the interruption to be inserted.
Figure 6/17: [Interruption/Potential...] dialogue window

**Type of connector**
Defines whether a pneumatic, hydraulic or electric interruption (potential) is to be inserted.

**Define multiple connectors**
Multiple interruptions can be set one after the other if this option is active. You can cancel the action by pressing the **Esc** key.

You can edit the properties for an interruption by double-clicking it. The following dialogue window opens.
Figure 6/18: *Interruption/Potential* dialogue window

**Layer**
Defines the drawing layer for the interruption.

**Identification**
Defines the identification for the interruption. The identification is displayed in the circuit if the *Display* option is active.

**Target**
Interruptions can refer to each other in pairs. The opposite interruption can be selected from a list or entered directly in the list box. 

- **Browse...** opens a dialogue window where all interruptions are displayed in a tree structure and can be selected. Only interruptions that are not linked are shown in the list if the *Only Free Interruptions/Potentials* option is active.

- **Jump to Target**
If the interruption is linked with another interruption then this button can be used to jump to the opposite interruption.

- **Show Location**
If this option is activated and the interruption is linked with another interruption then the position of the opposite interruption is displayed as a page coordinate (e.g. page number/column).

**Representation**
A symbol that defines the representation of the interruption can be selected from a list. To illustrate the representation the relevant symbol always additionally shows the intersection of two lines.
6.7  Checking the drawing

Using the [Check Drawing] menu item in the [Page] menu you can have FluidDraw check your drawing for possible drawing errors. FluidDraw displays the following messages where necessary:

- Duplicated identification labels
- Duplicated cross-reference labels
- Unresolved link targets
- Superimposed objects
- Lines through connectors
- Superimposed lines
- Open connectors
- Open pneumatic connectors
- Open hydraulic connectors
- Open electric connectors
- Incompatible connections
- Cyclic object references
- Objects outside the drawing area
- Missing translations
- Translated numbers detected
- Ambiguous terminal strip references
- Unassigned cables
- Unassigned terminals
- Duplicated terminal references
- Connection errors found in the GRAFCET diagram.
— Syntax errors found in GRAFCET expression.

If there are messages, the corresponding objects are highlighted after confirming the dialogue window.
Chapter 7

The tab for the object browser is on the right side below the project window by default. This window can be attached just like the library or the project window, removed from the main window and hidden.

Whereas the project window gives a hierarchical overview of the pages of a project, the object browser provides a hierarchical view of all main components, secondary symbols, sub-objects, lines, terminal strips, etc. A filter can be used to show or hide specific object types in a selective manner. In addition, there is an input field for a text filter including placeholders.

7.1 Navigating in the object browser

The tree view of the object browser provides you with a quick overview of the components used, their hierarchy, links and their location.
Starting at an object, any secondary symbols, sub-objects and the page on which it is positioned are displayed as a structure. Opens the node to view the corresponding elements. Double-click a node in the object tree to display the corresponding page, select an object or open the properties dialogue, depending on the context.

Depending on the object type, various links are displayed as sub-nodes. All terminals of a terminal strip can thus be found, for example, or interruptions can be monitored. Conduction lines indicate e.g. the connectors connected to them and the corresponding components.

If you move your mouse on to an object node for a moment, a small preview window appears, showing the symbol or the corresponding page.
The context menu that you can access using the right mouse button provides more functions. You can jump to the object here, copy it, delete it or open the properties.

### 7.2 Filter criteria for the object browser

You use the filter criteria to determine which object types are to be displayed in the object browser. For a better overview, you can hide the complete filter area using the corresponding button. If you press the button again, the filter options are displayed again.
Figure 7/3: Object browser: filter criteria

**Match case**
Defines whether the (upper or lower) case is to be taken into account in the filter text in the input field.

**Whole word**
With this option, only those objects are displayed that contain the filter text as a complete word.

**Wild cards**
You can apply this option to use placeholders in the filter text. The asterisk "***" stands for any number of characters of any kind and the question mark "?" represents precisely one character of any kind. If e.g. the **Whole word** and **Wild cards** options are active, when the filter entry "MM***" is made objects with the identification "MM1" and also with the identification "MM23" is displayed. If you enter "MM?" only "MM1" fits because the question mark replaces the "2" in "MM23". The "3" remains, which is not detected by the placeholder. As the **Whole word** option is set "MM23" is not displayed.
Reset

Resets the filter criteria to the default setting.
Chapter 8

As well as the Festo product catalogue, user-defined product databases can also be managed in a FluidDraw-specific data format. These product databases can be created from scratch or opened as an existing FluidDraw product database file.

It is also possible to import databases that were not created using FluidDraw. Note that the external product databases cannot be managed in FluidDraw. This must be done using suitable database tools. The product databases are imported as a copy in the FluidDraw-specific data format.

A product or data record at least contains the “Supplier”, “Part number” and “Symbol” attributes. Each product can be assigned a symbol using the “Symbol” attribute. You can add any number of other attributes.

The dialogue window for managing the product databases is opened using the [Manage Custom Product Databases...] menu item.
Figure 8/1: Manage Product Database dialogue window

Product Database Using this drop-down list you can select the product database that you want to manage.

New... Using this button you can create a new product database. You will then be asked for a file name under which the product database should be saved.

Open... Opens a file selection dialogue window that you can use to open an existing FluidDraw product database.

Import... Opens a file selection dialogue window that you can use to open an external product database. The database must be in CSV (Comma-Separated Values) format, which most database programs can generate. Further settings for import are described further below.
Remove From List | Removes the selected product database from the drop-down list. The associated file is not changed.

Products | This tab displays the product database as a table. The “Supplier” attribute features a drop-down list containing all suppliers that can be selected. The suppliers are listed on the Supplier tab.

Supplier | This tab lists all suppliers in the product database. Further suppliers can also be added and provided with additional information.

Export... | Exports the selected table (Products or Supplier) as a CSV file.

Delete | Deletes the highlighted product from the product database.

Add Attribute... | Further attributes can be added to both the Products table and the Supplier table.

Attribute Properties... | Opens a dialogue window where the attribute properties can be defined. The dialogue window is described further below.

Assign Symbol... | Opens a dialogue window where you can select a symbol that is assigned to the highlighted product.

If a file was selected for importing an external product database then various settings can be made using the following dialogue window. FluidDraw analyses the CSV file to be imported and suggests practical default settings.
Figure 8/2: *Product Database* dialogue window

**Delimiter**

Defines the separator that can be used to distinguish the attributes.

**Text Identifier**

Defines whether and how quotation marks have been added to texts.

**Character Code**

Defines the character set to be used.

**Column Assignment**

Defines the attributes (columns) to be imported from the database and the attributes predefined in FluidDraw that they should be assigned to. The data type of the attribute can also be specified. You can select all attributes using the **Select All** button and reverse the selection using the **Invert Selection** button.
First Row is Column Header Defines that the first row contains the column headers (attribute names).

First Table Row Defines the row from which the data records are to be imported.

Preview Displays a preview of the data records that are being imported.

The following dialogue window opens if the Export... button was selected to export either the Products or Supplier table as a CSV file.

Delimiter Defines the separator that can be used to distinguish the attributes.

Figure 8/3: Product Database dialogue window
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Identifier</td>
<td>Defines whether and how quotation marks are to be added to texts.</td>
</tr>
<tr>
<td>Character Code</td>
<td>Defines the character set to be used.</td>
</tr>
<tr>
<td>Column Selection</td>
<td>Defines the attributes to be exported. You can select all attributes using the <strong>Select All</strong> button and reverse the selection using the <strong>Invert Selection</strong> button.</td>
</tr>
<tr>
<td>Column Header</td>
<td>Defines whether an additional first row containing the attribute names as column headers should be exported.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays a preview of the data records that are being exported.</td>
</tr>
<tr>
<td>Predefined Attribute</td>
<td>Attributes predefined in FluidDraw can be selected from a drop-down list. These include <em>Product name</em>, <em>Remark</em> and <em>Description</em>.</td>
</tr>
<tr>
<td>Predefined Online Service</td>
<td>For most of the components in the Festo product catalogue there is additional information that can be accessed via the Internet. It includes documentation, CAD drawings, product images, spare parts, etc. These sources for the highlighted component can be</td>
</tr>
</tbody>
</table>
accessed directly via the context menu in the circuit diagram. To also be able to use this function with your own product databases, external links to corresponding web sites can be stored under the corresponding categories.

User Defined Attribute

If this option is selected you can specify an attribute name and type for the new attribute.

You can list and remove the attributes in the Attribute Properties and Products tables using the Supplier button. The “Supplier”, “Part number” and “Symbol” attributes cannot be deleted.

Figure 8/5: Attribute Properties dialogue window

The selected attribute can be removed using the Delete Attribute button.
Chapter 9

Translation tables can be managed using FluidDraw. Each row in the table contains texts in different languages. Each column contains one language. The text ID is a special column. It is used as a placeholder for a text and can be used at different points in FluidDraw. Depending on the set language, the text in the corresponding language may be displayed instead of the text ID.

Figure 9/1: Example of a translation table

The text ID can be selected as desired. In the example above the English term with a preceding question mark was used.

It is also possible to use a language as the text ID. This must be specified during import, which is described further below. We do not recommend this approach since the text ID may not always be unique. For example, in the example above the word “modification” occurs twice, but is translated differently depending on the context.

The translation tables are stored in a FluidDraw-specific file format. The translation table and language to be used are specified in a project or circuit on the Language tab in the properties dialogue window. You can find further information under Language.

Text IDs can be used in user-defined attributes for both the attribute name and the attribute value. The text is displayed on a yellow background in the set language in the corresponding dialogue windows. As soon as you want to edit an attribute name or attribute value the text ID is displayed again in the corresponding field.
FluidDraw provides a search dialogue for finding a text ID for a specific text in the selected translation table. When you are editing a text box the following dialogue can be opened using the Translation Table... button.

Enter a language text here to find the associated text ID. You do not need to enter the text in full; you can select the desired row directly.

The selected text ID is displayed in the text box after you confirm the selection.

If the user-defined attributes are used in parts lists then they are displayed in the parts lists in the corresponding language. Note that the predefined attributes are independent of the chosen language in the translation table. The language of the predefined attributes is defined by the language set for the Festo product catalogue.

Text IDs can also be used in text components.
The dialogue window for managing the translation tables is opened using the **Manage Translation Tables...** menu item.

![Manage Translation Tables dialogue window](image)

**Figure 9/4: Manage Translation Tables dialogue window**

**Translation Table**

Using this drop-down list you can select the translation table that you want to manage.

**New...**

Using this button you can create a new translation table. You will then be asked to specify a file name under which the translation table should be saved.

**Open...**

Opens a file selection dialogue window that you can use to open an existing FluidDraw translation table.

**Import...**

Opens a file selection dialogue window that you can use to open an external translation table. The translation table must be in CSV format.
(Comma-Separated Values) format, which most database programs can generate. Further settings for import are described further below.

Remove From List
Removes the selected translation table from the drop-down list. The associated file is not changed.

Extract Project Texts
If you want to create a new translation table for an existing project, you can use it to collect the texts used in the project and use them as an initial list for the translations.

Extract Page Texts
If you want to create a new translation table for an existing page, you can use it to collect the texts used in the page and use them as an initial list for the translations.

Words
This tab displays the translation table.

Export...
Exports the translation table as a CSV file.

Delete
Deletes the highlighted language entry from the translation table.

Add Language...
Adds a further language to the translation table.

Languages...
Opens a dialogue window that lists all languages and can be used to remove a language.

If a file was selected for importing an external translation table then various settings can be made using the following dialogue window. FluidDraw analyses the CSV file to be imported and suggests practical default settings.
Figure 9/5: *Translation Table* dialogue window

**Delimiter**
Defines the separator that can be used to distinguish the languages.

**Text Identifier**
Defines whether and how quotation marks have been added to texts.

**Character Code**
Defines the character set to be used.

**Column Assignment**
Defines the languages to be imported from the database and the languages predefined in FluidDraw that they should be assigned to. You can select all languages using the **Select All** button and reverse the selection using the **Invert Selection** button.
First Row is Column Header  Defines that the first row contains the language names.

First Table Row  Defines the row from which the data records are to be imported.

Preview  Displays a preview of the data records that are being imported.

The following dialogue window opens if the Export... button was selected to export the translation table as a CSV file.

![Translation Table dialogue window]

**Figure 9/6:** Translation Table dialogue window

**Delimiter**  Defines the separator that can be used to distinguish the languages.
Defines whether and how quotation marks are to be added to texts.

Character Code
Defines the character set to be used.

Column Selection
Defines the languages to be exported. You can select all languages using the Select All button and reverse the selection using the Invert Selection button.

Column Header
Defines whether an additional first row containing the language names as column headers should be exported.

Preview
Displays a preview of the data records that are being exported.

Further languages can be added using the Add Language... button.

Figure 9/7: Add Language dialogue window

Two types of languages can be added.

Predefined Language
Languages predefined in FluidDraw can be selected from a drop-down list.

User Defined Language
You can enter any language if this option is selected.
Figure 9/8: Languages dialogue window

The languages in the selected translation table can be listed and removed using the Languages button. The "Text ID" column cannot be deleted.
Chapter 10

FluidDraw allows both automatic and manual dimensioning.

10.1 Drawing dimensions

The [Insert] ribbon in the [Dimension] group has the buttons that you can used to select a corresponding mode for drawing the dimension arrows. The following buttons are available:

- Horizontal
- Vertical
- Align
- Angular
- Flag

Horizontal, vertical and diagonal dimensioning is done by defining two points for the section as well as then clicking to position the dimension text. Angular dimensioning requires the centre point to be defined as well as two points for the angle. The fourth click in turn defines the position of the dimension text. The [Flag] dimensioning function can also be used for general labelling of important points in the circuit. Two points for a line with any pitch and a final click for the text are needed for this.
10.2 Settings for dimensioning

Figure 10/1: Dimension dialogue window

Layer
Defines the drawing layer for the dimension.

Automatic Dimensioning
Activates or deactivates automatic adaptation of dimensioning when the dimension length is changed.

Length
If the Automatic Dimensioning option is deactivated you can enter any number that is displayed as the length dimension. A unit can also be selected. Show Unit defines whether the unit should be displayed.

Decimals
Defines the number of decimal places.

Factor
Determines the factor with which the real length is multiplied for the displayed value. This is necessary if you are creating a drawing with a scale other than 1:1.

Color
Defines the colour for the dimension.
Line Style  
Defines the line style for the dimension.

Line Width  
Defines the line width for the dimension.

Dimensions, like all other objects in FluidDraw, can be moved, rotated, mirrored and scaled. The display value of the dimension is automatically adapted during scaling if the *Automatic Dimensioning* option is activated.
Chapter 11

FluidDraw supports the structured and hierarchical assignment of equipment identifications, i.e. a complete equipment identification can be made up of several component identifications.

The following attributes can be used for structuring and are put together according to predefined conventions to form a complete equipment identification:

- Installation
- Location
- Circuit
- Component
- Connector

The Installation, Location and Circuit attributes can be specified for a symbol, circuit and project. You can specify whether the attributes should be applied from a parent element (node). For example, you can apply the installation information from the circuit diagram so that it does not have to be individually entered for each symbol.

Designation conventions describe how the individual Installation, Location, Circuit, Component and Connector attributes are put together to form a full identification. They specify the order in which the individual attributes are put together to form a full identification and the separators (prefix or postfix) used between them.

The following example serves to illustrate this. The list below represents a set of designation conventions. Each attribute can have a preceding (prefix) or a trailing (postfix) separator. The separators to be used are inserted in quotation marks. The specified set of designation conventions corresponds to the default setting in FluidDraw for electrical engineering.

- “=” Installation
- “+” Location
- “-” Component
The value of the *Component* attribute is “B1” and is stored at the symbol to be identified. *Installation* is given the value “G1” and *Location* is given the value “X1”, which are both stored at the circuit. A note is included at the symbol that these attributes should be applied from the circuit. The full equipment identification is then as follows:

— =G1+X1-B1

If it is clear from the context that *Installation* and *Location* are stored at the circuit then this information can be hidden when displaying the equipment identification in the circuit for a better overview. The *Suppress Inherited Parts* option must be selected at the associated symbol for this. The identification that is displayed is then:

— -B1

FluidDraw also supports the hierarchical structuring of identifications. Using a hierarchy makes sense if a symbol is a subobject of another object, for example the plug in a plug strip or the solenoid coil in a solenoid valve. The full identification is put together according to the defined designation conventions. The *Component* attribute is also added in accordance with the defined object hierarchy. You start at the top hierarchy level when identifying an object.

The hierarchy is defined by establishing a reference between a symbol (object) and the parent object. To illustrate this, we will continue with the example described above. The symbol with the *Component* attribute with the value “B1” was not previously hierarchically structured. This is changed by defining at the symbol that it has “A1” as the parent symbol. The full identification of “B1” is as follows:

— =G1+X1-A1-B1

The identification that is displayed remains unchanged.
11.1 Renumber Designations

Designations of symbols are automatically assigned when symbols are created. FluidDraw supports the reassignment of the designations within a circuit diagram or for all pages of the project. You can define which symbols are to get new identifications and the order in which they are to be renumbered.

Renumbering is started via the [Page] [Renumber Designations...] or [Project] [Renumber Designations...] menu. The following dialogue window opens.
For each symbol you can specify the designation convention to be used. You can specify the designation conventions to be taken into consideration during renumbering under **Object Types**. Only those symbols with the appropriate convention are given a new identification.

Only symbols that have not yet been given an identification are taken into account.

If the **Enumerate Automatically** option is selected on the **Designation Conventions** tab in the program options then FluidDraw automatically assigns identifications for newly created symbols. If this option is not active IDs beginning with a question mark will be assigned. According to the convention, FluidDraw interprets these symbols as not having any identification.
If this option is active renumbering is done in two passes. The main elements are re-identified in the first pass and the subordinate elements in the second pass. A main element is e.g. a valve and its silencers are subordinate objects.

Labelling Order

The labelling order can be defined using the various buttons.

Renumbering is started after you click the **Next** button.

**Figure 11/2: Renumber Designations dialogue window**

**Current Identification**

Shows the current full identification.

**New Identification**

Contains the suggested new identification for the component. You can change this suggestion. The new full identification is displayed in the **Full Identification** field.
<table>
<thead>
<tr>
<th><strong>Full Identification</strong></th>
<th>Shows the new full identification.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Displayed Identification</strong></td>
<td>Shows the new identification as it is displayed in the circuit. If the <em>Suppress Inherited Parts</em> option is selected then parts of the identification such as “Installation”, “Circuit” or “Location” are hidden if they have been stored in the circuit diagram or project.</td>
</tr>
<tr>
<td><strong>Designation Conventions</strong></td>
<td>The designation conventions for the component to be identified can be selected here.</td>
</tr>
<tr>
<td><strong>Inherit From Page</strong></td>
<td>If this option is not active the following identification components can be defined for the symbol: “Installation”, “Location” and “Circuit”. Only components that are used in the set designation convention are available.</td>
</tr>
</tbody>
</table>

The [Next] button applies the new identification and the [Skip] button leaves the old identification unchanged. The system then continues with the next symbol.
Chapter 12

Component attributes

The FluidDraw circuit symbols correspond to the components in the Festo product catalogue to a large extent. Even if you have not installed the product catalogue FluidDraw can read most of the component attributes from the database supplied with the program.

Open the Properties dialogue window for the component by double-clicking a symbol or using the [Home] menu and the [Properties...] menu item.
12.1 Component attributes in the *Properties* dialogue window

![Properties dialogue window of a component](image)

Figure 12/1: *Properties* dialogue window of a component

The properties of a component are stored as attribute value pairs. The attributes are split up into different groups. The first group contains general properties:
### Symbol
Displays the name of the circuit symbol. The symbol name is used to assign fitting products in the Festo product catalogue. The symbol name cannot be changed by the user.

### Description
Contains a more detailed description or the complete name of the circuit symbol where applicable. The user can change it. The identification is shown as text in the circuit drawing if the “Display” option is selected.

### Part number
The part number identifies a product unambiguously. You can enter the part number manually or use the Find... button the product catalogue to search for it. Only in the event of a selection via the product catalogue are the component attributes stored in the catalogue automatically applied. You can find these attributes in the Properties dialogue window of the component on the Catalogue Properties tab.

### Layer
In this drop-down list, you define the drawing layer of the symbol. Depending on the setting for drawing layers, the symbol might not be displayed or might not be able to be edited. In order to make the symbol visible or change its settings, you have to temporarily activate the drawing layer in the Page or Project menu under the Drawing Layers... menu item.

### Identification
Here you can assign an identification that uniquely identifies the component in the circuit diagram. The identification is shown as text in the circuit drawing if the “Display” option is selected.

Note: FluidDraw automatically assigns a unique identification when inserting or copying circuit symbols. An automatically assigned identification text begins with a question mark and can be edited by

---

![Properties dialogue window for a component: general properties](image)

**Figure 12/2:** Detail from the **Properties** dialogue window for a component: general properties
the user (FluidDraw shows a warning if you are assigning an identification that already exists).

You can make more detailed settings for the equipment identification on the Identification tab.

Display in Parts Lists
Deselect this option if you do not want the symbol to appear in the parts lists.

12.2 Identification

On the “Identification“ tab you can enter properties that influence how the identification for the symbol is displayed in the circuit diagram. You can find further information under Equipment identifications and designation conventions.

![Identification tab](image)

Figure 12/3: Detail from the Properties dialogue window for a component: Identification tab

Treat as Contact Actuator
If this option is activated then contacts can be linked with this symbol and the symbol is assigned a contact image. This allows the number of symbols that can actuate contacts to be extended as a
user-defined setting. For example it allows custom relay magnets to be defined.

**Parent Object**
If this option is activated then a parent object can be specified whose identification is used to make up the full identification. Parent objects can be selected via the list box or their full identification entered directly. The “[Browse... ]” button opens a dialogue window that shows all objects in the project as a tree.

**Full Identification**
This field shows the full equipment identification.

**Inherit prefix/postfix**
If this option is deactivated then the separators that are inserted before (prefix) or after (postfix) the identification can be specified. The separators specified in the designation conventions are ignored in this case. In combination with parent objects this enables aspect changes as described in EN 81346-1.

**Displayed Identification**
This field shows the equipment identification displayed in the circuit diagram. If the *Suppress Inherited Parts* option is selected then parts of the identification such as “Installation”, “Location” or “Circuit” are hidden if they have been stored in the circuit diagram or project. The parts of the parent object’s identification are also hidden if a parent object was specified.

**Designation Conventions**
Here you define the designation convention to be used for the identification. The following are available: Fluidics, Electrics, User Defined and Free Input. The properties dialogue window for the circuit where the designation conventions can be displayed and customised is opened using the [Designation Conventions...] button.

**Installation**
The *Installation* property that can be used as part of the identification is defined in this field. If the *Inherit From Parent Object* option is selected then the property is applied from the circuit, project or specified parent object. This field is only visible if *Installation* is used in the set designation convention.

**Location**
The *Location* property that can be used as part of the identification is defined in this field. If the *Inherit From Parent Object* option is selected then the property is applied from the circuit, project or specified parent object. This field is only visible if *Location* is used in the set designation convention.
The *Circuit* property that can be used as part of the identification is defined in this field. If the *Inherit From Parent Object* option is selected then the property is applied from the circuit, project or specified parent object. This field is only visible if *Circuit* is used in the set designation convention.

### 12.3 Catalogue Properties

Component attributes from the product catalogue as well as attributes specified by the user are displayed in tabular form on various tabs. The table entries from the catalogue cannot be edited. The value of an attribute is listed in the “*Value*” column. This value can be displayed as text in the circuit diagram next to the symbol if the “*Display*” option is activated.

The component attributes applied from the product catalogue are displayed on the “*Catalogue Properties*” tab.
12.4 User Defined Properties

You can enter your own component attributes on the “User Defined Properties” tab.

Text Buffer

When you edit a text box, you can use this button to insert a text that you would have recently entered elsewhere. That saves work and any input errors.

Translation Table...

If you are editing a text box you can use this button to open a search dialogue via which you can find the text ID for a language text from the translation table.
To change an entry, the corresponding row must be highlighted with a click. By another click of the table cell to be changed, you can edit the entry in the cell.

A row can be deleted by first clicking the row to highlight it. The highlighted row can then be deleted using the Del key.

You can add any attributes of your own by filling in the empty cells in the last row.

12.5 Drawing Properties

You can enter a number of drawing properties that influence how the symbols are displayed in the circuit diagram on the “Drawing Properties” tab.

![Drawing Properties](image)

**Figure 12/6:** Detail from the Properties dialogue window for a component: Drawing Properties tab

- **Position**
  - Defines the top left position of a component.
Scale: Defines the scaling factor in the x or y direction. The scaling factor can also be defined using the mouse pointer. This is described in the section: “Scaling symbols”.

Rotation: Defines the rotation angle in degrees. The rotation angle can also be defined using the mouse pointer. This is described in the section: “Rotating symbols”.

Override Color: If this option is selected, you can select a different colour for displaying the symbol.

Reset: Sets the geometry settings to the default values: scaling to 1, rotation to 0 and “Override Color” deactivated.

12.6 Main and secondary elements

As described under Component attributes in the Properties dialogue window the FluidDraw circuit symbols correspond to the components in the Festo product catalogue to a large extent. These symbols are called main elements. However there are also secondary elements, which do not correspond to elements in the Festo product catalogue. These secondary elements are usually symbolic representations of a partial aspect of an associated main element.

All product properties are stored at the main element. The secondary elements only have a description and a reference to the associated main element. In electrical engineering in particular, components such as relays are divided into main and secondary elements where the coil is the main element and the contacts are the secondary elements.

12.7 Linking main and secondary elements

Main and secondary elements are linked using the symbol for the secondary element. The circuit diagram detail shows a relay comprising a coil as the main element and two contacts as the second-
ary elements. The contacts are to be linked with the coil. This information is evaluated when displaying the contact image.

Figure 12/7: Relay comprising coil with two contacts

The symbol identifications are the default settings used in FluidDraw. The symbols are not linked to each other yet.

→ Open the corresponding properties dialogue window by double-clicking a contact.
Figure 12/8: Properties dialogue window for a contact

**Description**
Defines a description of the secondary element. In the case of a contact, this is shown in the contact image.

**Main Component**
A compatible main element can be selected from a list. The main element identification can also be entered directly as text.

**Browse...**
Opens a dialogue that shows all compatible main elements as a tree in accordance with the object hierarchy.

**Link**
If this box is given a check mark then the secondary element is logically linked with the main component. If the main component is then renamed, the link is retained and the identification of the linked secondary element is adapted as appropriate to the main element identification.

**Find Target...**
If the secondary element is logically linked with a main element, a search can be performed for the associated main element using this button.

**Display**
If this box is given a check mark then the main element's identification is shown as the identification for the secondary element.

**Suppress Inherited Parts**
If there are designation conventions assigned to the main element, parent parts of the identification that are defined in the circuit diagram or project are hidden.
From the list of compatible main elements select “Q1”. Proceed in the same way for the second contact.

Selecting from the list of compatible main elements automatically establishes the logical links between the contacts and the coil. The circuit diagram should now look like as follows.

Figure 12/9: Relay comprising coil with two contacts

If you now change the identification of the coil in “Q2” the logical links mean that the identifications at the contacts are automatically also changed to “Q2”.

Examples of this are relays with the coil as the main element and the contacts as secondary elements as well as electromagnetic directional control valves with the pneumatic symbol as the main element and the valve solenoids as secondary elements in the electrical part of the circuit diagram.
12.8 Linking solenoid valves and solenoid coils

The coils belonging to solenoid valves are usually displayed separately in the electrical part of a circuit diagram. The link between a solenoid valve and the associated coils is defined at the solenoid valve symbol.

The following circuit diagram shows a solenoid valve and the symbols for two separate solenoid coils. No link has been established yet between the solenoid valve and the coils.

![Circuit Diagram](image)

Figure 12/10: Solenoid valve and two separate coils

There are two ways of establishing a link between a solenoid valve and a coil. The first is using the properties dialogue window for the solenoid valve.

→ Open the appropriate properties dialogue window by double-clicking the solenoid valve and select the **Connector Labels** tab.
Figure 12/11: Properties dialogue window, Connector Labels tab

This tab shows all solenoid valve's connectors. Connectors refer, among other things, to the logical connection options for the solenoid coils. The input fields of the left-hand electric connector are described below. The descriptions apply in the same way to the right-hand connector and other types of logical connectors.

**Electric Connector (Left)**

The identification for the left-hand solenoid coil can be entered in this list box or selected from a list. When you click this field the corresponding connector is highlighted in the preview. This helps to locate the connector, particularly when dealing with turned or mirrored symbols.
Opens a dialogue that shows all compatible solenoid coils as a tree in accordance with the object hierarchy.

If this box is given a check mark then the solenoid coil is logically linked with the connector at the solenoid valve. If the solenoid coil is renamed the link is retained and the identifications of the coils at the solenoid valve are changed to match the coil identifications.

If the connector at the solenoid valve is logically linked with a coil a search can be performed for the associated coil using this button.

If this box is given a check mark the coil’s identification is shown as the identification for the solenoid valve connector.

→ Select: “-K1” from the list of compatible solenoid coils.

Figure 12/12: Left connector linked with “-K1” coil

The second way to link a solenoid valve with a coil is to double-click the solenoid valve’s connector directly. The coil connectors are represented like pneumatic connectors within the solenoid valve by means of small circles.

→ Double-click the right connector of the solenoid valve.

A dialogue window opens whose fields correspond to the entries for a connector on the Connector Labels tab of the Properties dialogue window.
Select: "-K2" from the list of compatible solenoid coils.

The (electric) connectors of the solenoid valve are now linked with the solenoid coils.

The above-mentioned ways of linking a solenoid valve and coils should only be used if each symbol has been individually inserted into the circuit diagram. For projects, FluidDraw manages the associated coil symbols for each solenoid valve internally. When a solenoid valve is inserted into a circuit diagram, the associated solenoid coils are simultaneously placed in a special library. This concept is described under Unplaced objects.

12.9 Attributes of the text components

In FluidDraw, text components are for inserting comments and captions, on the one hand. On the other hand, they can be used to define identifications and accessories without symbol representa-
Double-click a text or select the **Home** menu and the **Properties...** menu item to open the *Properties* dialogue window for the text component.

![Properties dialogue window for a text component](image)

**Figure 12/15:** *Properties* dialogue window for a text component

A text component has all attributes of a *standard component*. The text properties are to be found on the "*Edit Text*" tab.
Enter your text in the input field on the left side. You can also enter a multi-line text. For a line break, press the Return key.

Defines the horizontal or vertical alignment of the text in the text box.

Defines the font type of the text.

Defines the colour of the text.
Frame Text
Draws a frame around the text box.

Fixed Width
Normally, FluidDraw automatically adapts the width of the text boxes to the text contents. You can define a fixed width with this option if you do not want it. That may be practical if you have only limited space. The text is then compressed, if necessary, in order that it fits in the defined box.

Attribute Link
If this option is activated a text that identifies a link to an attribute is displayed instead of the text entered. The value of the selected attribute is displayed in the circuit diagram. You can find a detailed description of this function under Linking text components with attributes. A predefined placeholder such as the page number can also be selected using the button.

Character Map...
Opens a dialogue with all available characters to facilitate the input of letters and symbols that cannot be accessed directly using the keyboard.

Translation Language
Defines the language from the selected translation table to be used. The text is displayed in the selected language, provided the selected translation table has a corresponding entry for this language.

The language defined on the page is used by default. In deviation, e.g. to create a multilingual document, you can select a different language for every text.

Translation Table...
If you are editing a text box you can use this button to open a search dialogue via which you can find the text ID for a language text from the translation table.

12.10 Linking text components with attributes

Text components can also display attributes of other components, values of predefined placeholders, attributes of a circuit or the project. The text component must be linked to the corresponding attribute for this. The linked attribute is defined in the input field of the “Edit Text” tab in the Properties dialogue window for the text.
component. The activated *Attribute Link* option defines that the text in the text box should not be displayed but rather interpreted as a link.

Example:

Let us assume your project is called “Project1” and has the page “Page1”. On it is a “V1” symbol whose value of the “supplier” attribute you want to display, i.e. in the example the value “Festo”.

→ Insert a text component into the circuit drawing by selecting the [Text] entry on the [Insert] ribbon page in the [Object] group and then left-clicking the circuit drawing. The [Properties] dialogue window for the text component then opens.

Note: You can open the dialogue window of an existing text component by double-clicking it or using the [Home] menu and the [Properties...] menu item.

→ Select the *Attribute Link* option and then click the [Browse...] button.

A window opens displaying the hierarchy of all available attributes. Please note that only those objects are listed that have an identification assigned by the user. Identifications beginning with a question mark “?” are not also listed. These are identifications that have been automatically assigned by FluidDraw. The desired attribute is to be found under “*Attribute Tree*” - “Project1” - “Page1” - “Supplier”.
Highlight the desired “supplier” attribute and then click the Select button.

In the input field the “Project1.Page1.-V1. Supplier” value is displayed and in the preview “Festo” is displayed. The complete and unique name of an attribute also includes all hierarchy levels, starting with the project. The individual levels in the name are separated by dots. It is also possible to only enter the attribute name in the input field. In this example “supplier”. The attribute is searched for in the hierarchy upwards, starting with the text component. If the desired attribute is not found at the component, the attribute is searched for in the circuit and then in the project.

If the attribute is not found, the attribute name is displayed in pointed brackets in the circuit. The missing attribute can be created at a later point in time. The link is then created automatically.

A text object as an attribute link can display various attribute values and variables, provided it is in its own text line.
12.10.1 Text constants

If the *Attribute Link* option is selected, the entered texts are not displayed directly, but interpreted as attributes or predefined variables. If a fixed text is to be displayed in addition to an attribute or variable value, it can be inserted in quotation marks. Such text constants must be in a line of their own, like also the links.
12.11 Text components with predefined links

For component attributes and connector identifications that can be displayed, text components are automatically created that are linked to the corresponding attributes. Open the Display Attribute dialogue window for adapting how the text is displayed by double-clicking the text component or via the Home menu and the Properties... menu item.
Alignment

Defines the horizontal or vertical alignment of the text in the text box.

Scale

Defines the scaling factor of the text in the x or y direction.

Note: You can also change the text size by selecting another font size in the font type dialogue window. You open this dialogue window using the [Font...] button under Text Attributes.

Rotation

Defines the rotation angle of the text box in degrees.

Font...

Defines the font type of the text.

Color...

Defines the colour of the text.

Frame Text

Draws a frame around the text box.

Find Target...

The destination of a linked text is the attribute to which the text refers. This button is used to open the Properties dialogue window of the object that includes this attribute.
12.12 Changing the properties of several objects simultaneously

If several different objects are highlighted, a dialogue window appears with different categories on selecting the Properties... menu item in the Home menu. Corresponding tabs are available for the various object types depending on the objects highlighted.

Figure 12/20: Properties dialogue window with several highlighted objects

The individual tabs of the dialogue contain the same control elements as the dialogues of the individual objects.

If a specific setting does not have the same value for all objects selected, this is indicated by the fact that the control element indicates an “undefined” state or no value is entered. If you keep it this way, the individual values of this property remain untouched for the selected objects. If you change the value, however, it is adopted for all objects selected.
Managing projects

Chapter 13

FluidDraw supports the management of projects by being able to combine different pages under one name in a project file.

13.1 Creating a new project

→ Select the File / New... menu item from the Project... menu and enter a file name for the new project.

Project files have the file extension fdprj.

In the project window, a project is displayed hierarchically. The top element is the project node. Any sub-folders and the corresponding pages are displayed underneath. It is practical to create sub-folders for various content-related areas, such as for pneumatic connections, electrical activations and parts lists or other reports.

![Hierarchical representation in the project window](image)

Figure 13/1: Hierarchical representation in the project window

The folders and pages in the project tree can be moved interactively with the mouse to change the order. You can also change the hierarchy by dragging folders to another position. If you hold down the Ctrl key, you can also move the nodes using the cursor keys on the keyboard.
13.2 Project node

Every project has a project node as the topmost element. The project node is used to save all project-specific settings. Right-clicking a project node opens a context menu. You can also find the menu items in the Project menu. You can also find the functions for adding and removing files here.

Under the Project menu item from the Properties... menu you can define properties for the project. Properties that can be specified for both projects and circuits are described under Circuit and project properties.

13.3 page node

A page node is created beneath the project node for every page file that belongs to the project. The page node is used to save all circuit-specific settings.

Right-clicking a page node opens a context menu containing the following menu items:

Open... Opens the selected page in a window. The window can also be opened by double-clicking the node in the project tree.

Close Windows Closes the window of the selected page.

Delete Deletes the selected page and removes it from the project.

Rename... Changes the description of the selected page.

Properties... In this dialogue window you can enter data for the page.
Here you can define the circuit dimensions and orientation, both of which are relevant for printing.

Reumber Pages... Opens a dialogue window for renumbering the pages.

Prefix Defines the prefix. It precedes all pages.

Start number Defines the first page number of the new numbering.

Postfix Defines the postfix. It is attached to all pages.

Leading zeros Defines the number of places. An appropriate number of zeros precede numbers with a small number of digits.
Only this project node

Defines if only the pages are to be renumbered that are directly under this node or all pages in all sub-folders of the selected node. Note: Select the topmost project node and remove this option if you want to renumber all pages of the entire project.

13.4 Global objects

Most symbols are for components that correspond directly to a part number. Some symbols have several representations in the circuit, whereas others are sub-objects of other symbols. Certain components do not have any direct equivalent in the circuit. These include terminal strips, cables and also valve terminals.

Terminal strips

The individual terminals are drawn in the circuit diagram. A terminal strip can be entered in the properties dialogue for the terminals. These terminal strips are not displayed as symbols, however, but are managed by FluidDraw as global objects.

Cables

The individual cable symbols are inserted in the circuit diagram. A cable can be entered in the properties dialogue for the cable symbols. Like the terminal strips, these cables are not displayed as symbols but are also managed by FluidDraw as global objects.

Valve terminals

If a valve terminal is created by inserting an order code, the corresponding valve slices, end plates, etc. are to be found as grouped symbols on a circuit page. These symbols represent actual components. However, they should not appear individually in parts lists. Instead the virtual “valve terminal” object includes all attributes to be displayed in the parts lists. Such valve terminal objects are also managed by FluidDraw as global objects.

There are three ways to edit the properties of global objects:

Find Target, Jump to Target

In the properties dialogue of a subordinate object, a terminal or a cable symbol, you have the option of jumping to the corresponding parent object.
Object browser

Global objects are displayed in the object browser just like all other objects on the pages of the project.

Figure 13/4: Properties dialogue window: *Find Target*
In the Project menu under Manage you can open special dialogues that allow you to manage the various global objects. Here, you can also open the corresponding properties dialogues, delete objects or create new ones.
13.5 Unplaced objects

Various symbols consist of a main element and several secondary elements. For solenoid valves in particular FluidDraw manages the associated solenoid coils automatically. The linking of solenoid valves with their solenoid coils is described in detail under Linking solenoid valves and solenoid coils.

If a main element is inserted into a circuit diagram, the associated coils are automatically entered in the Unplaced Objects symbol library.
Figure 13/7: Circuit diagram with solenoid valve and associated solenoid coils in the *Unplaced Objects* symbol library

The associated coils are already internally linked with the solenoid valve in the circuit diagram. Clicking one of the “electric connectors” in the solenoid valve automatically highlights the corresponding coil in the *Unplaced Objects* library.

Figure 13/8: Highlighting the connector link with associated solenoid coil

As soon as you drag a coil from the library into a circuit diagram it is “used up” and removed from the library. The valve is entered as the parent object for the coil.
Assigning a new identification to the coil has a direct effect on the valve since the coil and valve are linked. The identification is displayed at the valve.

If you delete the solenoid coil in the circuit diagram it is automatically added to the Unplaced Objects symbol library again. This symbol library is completely self-managing.
Chapter 14

pages and projects have a number of common properties. The properties set in the project can be used by pages in the project. All properties that can be specified for both pages and projects are listed below. The figures show dialogue windows for the pages.

As pages normally contain circuits, the term circuit is used as a synonym for page in the following. Pages can also contain e.g. parts lists.

![Figure 14/1: Properties dialogue window](image)

**Properties**

The file name field displays the file name of the circuit or project along with the complete path. The file name is transferred to the
input field for the “Description” and can be edited there. This entry is displayed at the upper edge of the window as well as next to the circuit or project node.

Page number

Here you can specify a page number. The page number can be made up of any character string. The page number can be accessed using the predefined placeholder “%PageNumber”. This placeholder can also be used in text components and drawing frames.

Drawing Frame

Here you can make settings for the drawing frame. This function is described in the section: Drawing frame.

14.1 Attributes

Any number of attributes can be created for every circuit or node in a project. The attributes are listed in a table on the “Attributes” tab. New attributes can be entered in the empty cells at the end of the table. The use of attributes is described in the section: Attributes of the nodes in a project.

The attributes of a project node are automatically copied to all circuit list nodes (inherited) and are thus available in all circuit drawings.

This concept is particularly useful for the drawing frames if project attributes are to be displayed in the circuit diagram, for example. You can find further information in the section: Linking text components with attributes.

Circuit attributes copied from a project cannot be edited initially. The corresponding row in the Page tab of the Attributes dialogue window is greyed out and the “Inherit From Project” option in the column is activated.

However it is possible to overwrite a copied attribute in a circuit. The option in the “Inherit From Project” column must be deactivated for this. The value of the attribute can then be edited. This function can be used to assign individual page numbers in the drawing frame, for example. If the “Inherit From Project” option is
reactivated then the attribute value is copied from the project again.

![Translation Table](image)

Figure 14/2: Attributes tab

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Action</th>
<th>Inherit From Project</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional text 1</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional text 2</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 3, Index</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 3, Text</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 3, Name</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 2, Index</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 2, Text</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 2, Date</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 2, Name</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drawn, Date</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drawn, Name</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Created, Date</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Attribute**: This column contains the name of the attribute.
- **Value**: This column contains the value of the attribute.
- **Action**: The buttons in this column allow the following actions: if the attribute was created in the parent project node then the “Find Target...” action is available. Clicking this opens the Project or Circuit dialogue window for the project node as the destination that contains the corresponding attribute. If the attribute was created in the same node then the “Delete” action that allows you to delete the attribute is available.
- **Inherit From Project**: If the attribute was created in the same node then this option is deactivated and greyed out. This applies to all attributes of the project node since it does not have a parent node. For child nodes the value of the attribute from the project node is copied when this option is activated. After deactivating this option it is possible to locally overwrite the attribute value.
<table>
<thead>
<tr>
<th>Comment</th>
<th>Here you can enter a comment on the attribute.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation Table...</td>
<td>If you are editing a text box you can use this button to open a search dialogue via which you can find the text ID for a language text from the translation table.</td>
</tr>
</tbody>
</table>

### 14.1.1 Predefined placeholders

FluidDraw provides a number of predefined placeholders. These placeholders can also be used in text components and drawing frames.

The placeholders begin with a percentage sign. The following predefined placeholders are some of those available:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%PageNumber</td>
<td>The page number is specified in the properties dialogue window for the circuit diagram.</td>
</tr>
<tr>
<td></td>
<td>If reports are spread across several pages, the number of the sub-page is added to the page number with a minus sign. If, for example, the entered page number is “42-01” and the page displayed is the third page in a report then the placeholder “%PageNumber” is replaced by the character string “42-01-03”.</td>
</tr>
<tr>
<td>%PageDescription</td>
<td>The description for the page is specified in the properties dialogue window for the circuit diagram.</td>
</tr>
<tr>
<td>%PageCircuit</td>
<td>Specifies the “Circuit” value of the page’s designation convention.</td>
</tr>
<tr>
<td>%PageLocation</td>
<td>Specifies the “Location” value of the page’s designation convention.</td>
</tr>
<tr>
<td>%PageInstallation</td>
<td>Specifies the “Installation” value of the page’s designation convention.</td>
</tr>
<tr>
<td>%PageFileName</td>
<td>Stands for the file name of the page without the file path.</td>
</tr>
<tr>
<td>%PageFullFilePath</td>
<td>Stands for the file name of the page with the full file path.</td>
</tr>
</tbody>
</table>
%PageFileDateTime  Stands for the date and time of the most recent change to the circuit diagram.

%PageFileDate  Stands for the date of the most recent change to the circuit diagram.

%PageFileTime  Stands for the time of the most recent change to the circuit diagram.

%ParentDescription  Stands for the description of the page's parent project node.

%ProjectDescription  Stands for the description of the project.

%ProjectFullFilePath  Stands for the file name of the project with the full file path.

%TotalPages  Specifies the total number of pages of the project.

### 14.2 Page Dividers

Page dividers can only be defined for pages. Editing page dividers is described under [Page dividers](#).

### 14.3 Basic Unit Length

The symbols in the FluidDraw symbol libraries are created according to various DIN ISO standards. Instead of specifying absolute units of length, the standards simply use a relative basic unit of length “M”. All symbols have been created with reference to this basic unit of length “M”. The actual size of the symbol is not defined until the symbol is inserted into a circuit.

Information on how to convert the basic unit of length “M” is stored with the circuit diagram. You can change the set values for a circuit diagram by opening the properties dialogue window for the circuit.
As soon as the value of “M” is changed, the sizes of the existing symbols are recalculated with respect to the specified basic unit of length. The specification has no effect on elements in the drawing frame.

The *Basic Unit Length* tab is also to be found in the project settings. The settings made on this tab are used as a template for circuit diagrams created from scratch in the project tree.

### 14.4 Language

The language settings are to be found on the *Language* tab. The settings made on this tab affect language-dependent text, etc. in parts lists. The language used for program elements such as buttons is defined via the program options, see *Language*. 
Inherit From Parent Node  
Copies the language settings from the parent project node.

Copy from global options  
This is for copying the settings defined under Manage in Options... / Language.

Product Catalogue  
Defines the language used for the Festo product catalogue. All product attributes are displayed in the relevant language. The predefined attributes are also displayed in this language.

Translation Table  
Defines the translation table to be used.

Translation Language  
Defines the language from the selected translation table to be used. The user-defined attributes are displayed in the selected language.

14.5 Encryption

Projects and circuit diagrams can be encrypted. The encryption method used is AES-128. Pages that are components of a project cannot be encrypted individually. In such a case, you can only encrypt the entire project.
Enable Encryption

This option activates and deactivates encryption. When encryption is activated the password to be used can be entered in the Password input field.

Figure 14/5: Encryption tab
14.6 Designation Conventions

Designation Conventions tab

This tab is used to define the settings for the designation conventions. You can find further information under Equipment identifications and designation conventions.

Copy from global options

This is for copying the settings defined under Manage in Options... / Designation Conventions.

Frame Identification

Defines that the identifications produced by the selected set of conventions are framed.

Specifications can be made for Installation, Location and Circuit that are evaluated for displaying the symbol identifications. If the Inherit From Parent Node option is active then the specification is applied from the parent project node.

Example

The example shown illustrates the effects of the selected designation conventions.
14.7 Cross Reference Representation

Figure 14/7: Cross Reference Representation tab

This tab is used to define the settings for the cross-reference representation. You can find further information under Cross-reference representation. If the Inherit From Parent Node option is active then the settings are applied from the parent project node.

Copy from global options

This is for copying the settings defined under Manage in Options... / Cross Reference Representation.

Example

Illustrates the effects of the settings using an example.
14.8 Representation

This tab is used to define the settings for the crossing lines. You can find more information under Line jumps. If the Inherit From Parent Node option is active then the settings are applied from the parent project node.

Copy from global options: This is for copying the settings defined under Manage in Options... / Appearance.

Display Line Jump: Crossing lines are represented as jumps.
Chapter 15

FluidDraw provides fixed tables and automatic reports. Whereas a table is for displaying fixed lines and columns with static or dynamic contents, an report is used to list objects of a page or of the entire project according to specific rules and automatically adapt them if objects are added or omitted.

FluidDraw provides typical reports, such as parts lists, terminal diagrams or content overviews. These templates can be adapted flexibly. You can also use an editor with a wide range of functions to define individual reports and then save them as user-defined templates. You can find more information in the section: Reports.

15.1 Using tables

Tables can be inserted using the Insert menu under [List]. A table is inserted at the position of the mouse pointer with a click like the drawing elements. That opens a dialogue, which can be used to define the initial size of the table. The table is then inserted in the current page and the properties dialogue window opens for filling in and formatting the table.
15.1.1 Editing contents

You can change the contents and formatting of the table using the table’s properties dialogue window. The way to edit the table is similar to that of familiar Office products.

To enter any text, highlight the desired cell using the mouse and enter the text using the keyboard. To edit existing text in a cell without overwriting it completely, press the F2 function key. That takes you to the cell where you can edit the existing contents.

In addition to fixed text, attribute links and predefined placeholders can also be used in tables. The contents of the corresponding cell then result dynamically from the value of the corresponding attribute link or the predefined placeholder. If you want to enter an attribute link in a cell, select the *Attribute Link* option below the view of the table to do this. Then, either select a predefined place-
holder using the [Predefined variable...] button or select an attribute using the [Browse...] button.

Texts from a translation table stored in the project/page can also be used in the table. You can use the [Translation Table...] button to select a text from the translation table. The text from the translation table is displayed in the corresponding translation language of the page that contains the table.

Images can also be inserted in individual cells instead of a static or dynamic text. The [Choose picture...] below the displayed table can be used to load an image file and insert it in the currently highlighted cell. The inserted image is always scaled to the available size of the cell. In the program options, you can define if an image is embedded by default when it is inserted in the table or if only a reference to the original file is inserted. Images are always embedded with the default setting.

Existing table data e.g. of an Office application can usually be applied using copy and paste. Only the contents are applied, no formatting. If the copied table is bigger than the current table, it can be increased in size accordingly on request.

15.1.2 Formatting

Via the toolbar above the table in the properties dialogue, you can change the formatting of the currently selected cells of the table.

You can define the column width and row height of the corresponding columns and rows of the table interactively using the mouse. To do this, move the mouse pointer to the edge of a cell in the table. There, the mouse pointer is converted into a shift pointer and, keeping the left mouse button pressed, you can move the edge of the cell, thus changing the column width or row height.
Chapter 16

In addition to compiling the circuit documentation, overviews in tabular form of the components used are required in various views. A parts list or order list of all components for procuring the required parts, a terminal diagram for the correct wiring by the electrical engineer in the control cabinet and a tube list for the correct identification and connection of all pneumatic components by the equipment manufacturer.

16.1 Using reports

Reports can be inserted using the Insert menu under List. A report is inserted at the position of the mouse pointer with a click like the drawing elements.

In previous versions of FluidDraw a defined set of reports was available that could be adapted to your requirements to a limited extent. With version 6, these options have been expanded significantly, so that now all reports provided can be adapted very flexibly to the requirements of the corresponding project.

Reports in FluidDraw are always a tabular list of objects. The result of a report that is displayed on a page in the project is created dynamically while the program is running and displayed in the circuit diagram. If any change is made to the objects included in the report, this is automatically reflected in the report result.

In version 6, reports have been completely re-designed and implemented. The layout of the templates provided corresponds to that of the known templates in version 5. Reports from version 6 are not downward-compatible with version 5. That means reports created using version 6 cannot be displayed in version 5.

The use of some standard reports is shown first in the following sections. Then the basic concepts of the reports are described in detail.
16.2 Parts lists

All those objects are listed in the predefined parts lists that have set the “Display in Parts Lists” ID in their properties. That applies to the following elements of the project: main components, subcomponents, connection lines, terminal strips and cables.

If a part number from the Festo catalogue or a separate product database is assigned to a symbol, the ID is automatically set. The ID is not automatically set for conduction lines. Please open the properties here and set the ID so that it appears in the parts list.

Single position parts list

Each object is listed individually in the parts list.

Accumulated parts list

All objects with the same part number, type, item name and supplier are summarised in one line. The total number of components summarised in the line is displayed in the Quantity column.

16.2.1 Inserting a new parts list

Proceed as follows to insert a new parts list:

→ In the Insert menu select Report under List.

→ Select a point on the page where the new parts list is to be inserted. That opens a selection dialogue that you can use to select a report that is to be inserted on the current page.

→ You can find the single position parts list on the left side of the tree structure under Standard reports ⇒ Parts lists ⇒ Single Position Parts List. Select Single Position Parts List. As soon as you select the entry, a preview of the report is displayed on the right side for the currently open project.
Confirm the selection the parts list by exiting the selection dialogue using the OK button.

Before the report is inserted at the desired point on the page, a properties dialogue appears with the settings of the selected report. You have the option of defining specific settings here directly before the report is inserted in the circuit diagram.

Confirm the properties dialogue and the parts list is inserted in the circuit diagram at the point you selected.

16.2.2 Adapting a parts list

You can use the properties dialogue of the parts list to define important settings and adapt the parts list to a certain extent.

You can generally select the drawing layer at the top right and at the bottom left, the Save as new template... button provides you with the option of saving the current report as a new template.

In addition, the details of the parts list are defined on the individual tabs of the properties dialogue, which are now explained in detail.
Figure 16/1: Properties of the parts list: *Object selection* tab

On the object selection tab, you can select which pages of the project are to be taken into account in the parts list.

- **Include this page’s components only**: Only lists the components of the page on which the parts list is positioned.
- **Include All Project Files**: Lists all components from all pages of the project.
- **Include Selected Files**: Only lists the components from the selected pages of the project.
- **Exclude global objects**: Excludes *global objects* from the report.
You can use the *Column selection* tab to influence which columns are to be included in the parts list and how the parts list is sorted.

All columns are listed on the *Selected columns* table that are currently included in the parts list. A column of the parts list is displayed in every line with the following data:

**ID**
Consecutive number of the corresponding column.

**Column heading**
Heading of the corresponding column in the parts list.

**Contents**
Contains one or more placeholders, similar to the predefined placeholders in a text box for the property or the attribute that is to be displayed in this column.

**Display**
Defines whether the column is displayed or not.

Those columns are displayed in the list under *Available columns* that can also be added to the parts list. You can use the buttons between the *Available columns* list and the *Selected columns* table to add more columns to the parts list or remove selected columns.
columns from the existing list. You can use the buttons to the right of the table to change the order of the columns.

Below the table Selected columns the button Combine columns is available for merging columns. The button is deactivated as long as only one row is selected in the table. When more than one row is selected, the Combine columns button is activated. If this button is pressed, the following dialog opens in which the details of the summary can be defined.

![Combine columns dialog](image)

**Figure 16/3: Combine columns**

- **Column heading**
  The column header of the new merged column.

- **Combination**
  The first value found in the selected columns is output in the combined column.

- **Concatenation**
  The contents of the selected columns are displayed in the combined column one after the other, separated by the specified separator.

You can adapt the sort order of the parts list using the Sorting button. Click this button to open the sort dialogue.
Figure 16/4: Default sort order of a parts list by the Identification column

Sorting in ascending order by the Identification column is set by default.

Figure 16/5: Properties of the parts list: Appearance tab

How the parts list is displayed on the page can be adjusted on the Appearance tab. The changes made are displayed directly in the preview.
16.2.3 Adding user defined attributes to the parts list

The templates supplied for parts lists and accumulated parts lists are designed to list components with stored catalog data from the Festo catalog or from your own product database. If components are inserted via the menu items Insert => From Festo Catalog or From Custom Database or subsequently assigned catalog data via a part number, the evaluations immediately contain the appropriate data. The situation is different if user-defined attributes for type, supplier etc. are used and these are to be listed in the parts list. To do this, the supplied template must be modified accordingly. This is possible in the properties of an report in the Column selection tab.

![Property of Parts List: Column Selection Tab](image)

**Figure 16/6: Properties of the parts list: Column selection tab**

On the left-hand side of the Column selection tab, a list is displayed with all properties of the components contained in the project that are available for evaluation. These are the properties of components, lines, terminal strips and cables. The properties are indicated here with their name. To differentiate between user-
defined attributes and catalog attributes, the suffix *User Defined Attribute* is appended to the name of those attributes.

The standard templates for item BOMs and summarized BOMs are designed to list the part number, type, and item name from the catalog attributes, and description and vendor from the user-defined attributes. You can recognize this by the placeholders entered in the *Contents* column. “dki-attribute” refers to catalog attributes and “user-attribute” to user-defined attributes.

If you do not use product databases in your project and store the product data such as the type directly in the user-defined properties, the template must be adapted as follows:

→ In the *Available columns* list, search for the user-defined attributes that you have entered. Look for the suffix *User Defined Attribute*.

→ Select the required attributes and add them to the parts list. You can use the > button or drag and drop the columns into the list of selected columns.

The selected user-defined columns are now also displayed in the parts list. The two buttons to the right of the table with the selected columns can be used to adjust the order of the columns in the parts list.

If you do not use any components with product data in your project, you can delete the corresponding columns from the parts list by selecting them and clicking [Delete].

However, it is often the case that both components with catalogue data, such as Festo products, and components without catalogue data are present in the circuit diagram. In this case, it is unpleasant that the catalog attributes and the user-defined attributes are output with the same heading in different columns. This can be solved by combining the corresponding columns into one column. To do this, proceed as follows:

→ Select the columns with the same heading or meaning in the table *Selected columns*. Press and hold the [Ctrl] key to select several rows successively.
As soon as more than one line is selected, the *Combine columns* button is activated. Click this button. The following dialog appears, in which you can define how the columns should be combined.

![Combine columns dialog](image)

Figure 16/7: Combine columns

If necessary, change the column header and leave the summary type at *Combination*.

The selected columns are then replaced by the new combined column, which now combines the contents of the previous columns in one column.

### 16.2.4 Editing the parts list contents

The identification, description and user-defined attributes of individual components in the parts list can be edited directly in the parts list on the page.

→ Insert a parts list on a page and highlight it by simply clicking it with the left mouse button.

→ Then, switch to edit mode by selecting **Edit** from the context menu of the report (right mouse button). Alternatively, you can also highlight the report and select **Edit ➞ Edit List/Table** in the menu.
In edit mode, all fields that cannot be changed are highlighted in grey. The remaining fields can be edited directly.

→ If you click such a field, you can change the contents. Finally, confirm your input with Enter or by using the arrow up/down keys to switch to another line.

The new value is then transferred directly to the component.

Note: If you change the identification of a component, as the sort order in the parts list is changed that may also change the position of the component in the parts list. Therefore, pay attention to the order of the components if you want to edit several identifications in succession.

16.2.5 Exporting a parts list

Every parts list can be exported to a text file with separators. These files can then easily be further processed with other applications, such as spreadpage programs.

→ Highlight the parts list you want to export and open the context menu. Select [Export...] from the context menu.

The following export dialogue appears in which you can define the format for export.
Figure 16/8: Settings for exporting a parts list

Column Header
If this option is selected, the column headings of the parts list are displayed in the first line.

Quotation Marks
If this option is selected, all values of the parts list are displayed in quotation marks.

Delimiter
You can define here which separators are to be used to separate the individual columns.

Character Code
Defines the character coding for the text file created. Change this value if umlauts and special characters are not exported correctly.

After confirming the export dialogue, you can define the location and file name of the text file to be created. Then, the parts list is exported.
16.2.6 Sending it to the Festo Online Shop

All components of a parts list that have a part number and for which either Festo or nothing is entered as the supplier can be sent to the Festo Online Shop and transferred to the shopping basket there. A parts list may basically also include products of other suppliers, which are filtered out during transmission to the Online Shop.

→ To transfer the selected parts list to the Online Shop, select Send to Festo Online Shop... from the context menu.

The standard Internet browser defined on your PC automatically opens. The parts list is displayed to you again there with the items relevant to the Online Shop. You have the option of adapting the quantity again here prior to transfer to the shopping basket. Click Send to transfer the items to the shopping basket.

16.2.7 Differences between parts lists in version 5 and 6

The reports in version 6 have been greatly improved compared to the lists in version 5, so that they can be better adapted to individual requirements. Previously, tube lists or cable diagrams, for example, were fixed and could not be supplemented with additional columns. With the standard templates for reports, we try to simulate the predefined lists of version 5. However, there are some points that work somewhat differently in the new reports as compared to the known lists of version 5.

In the case of parts lists, this applies especially to the automatic listing of attributes. In the old part lists of version 5, every newly added user-defined attribute was automatically listed in the parts list. This is no longer the case with the new part lists in version 6. Certain columns are preset in the standard template for the item parts list and are not automatically supplemented with new columns when new attributes are defined. This means that if new user-defined attributes are added, they must be added manually via the part list properties. You do this by opening the parts list properties...
and switching to the *Column selection* tab. There you can select from the list on the right those attributes and properties that you want to appear in the parts list.

Another difference to version 5 is that user-defined attributes no longer automatically overwrite catalog attributes with the same name. Instead, certain columns can be grouped together in the new reports.

Tip: In principle, you only have to customize the parts list once to meet your individual requirements. You can then use the [Save as new template...] button in the parts list properties to save it as a new template. You can then use your individual template instead of the standard template for new part lists.

### 16.3 Table of contents

The table of contents consists of a list of all pages or of selected pages of a project. The name of the page and the number of pages are displayed.

You can use the properties of the table of contents to have further attributes of the individual pages displayed, such as date information, change notes, etc.

### 16.3.1 Inserting a new table of contents

→ Select the Report item from the [Paste] menu.

→ Select the point on the page where the table of contents is to be inserted.

→ You can find the table of contents in the tree under *Standard reports* ⇒ *Index / Directories* ⇒ *Table of contents*. Select it
and click **OK**. Alternatively, you can also double-click the entry in the tree.

### 16.3.2 Adapting the table of contents

You can define in the properties of the table of contents which pages are to be displayed and which additional page attributes are also to be displayed.

### 16.4 Connector lists / terminal diagrams

In addition to the previously described parts list, the accumulated parts list and the table of contents, there are further pre-defined reports that are to be found in the selection dialogue in the branch with the connector lists and terminal diagrams.

### 16.5 Reports in detail

Reports in FluidDraw are always a tabular list of certain, selected objects.

The selection of the objects to be listed is therefore the basis for the report. An *object* at this point refers to the various elements of a project, such as components, conduction lines, terminals, cables, etc. How objects are structured in the reports is described in the following section on object selection.

The result of a report is always a table with values of the properties of the selected objects. The table created consists of a defined number of header lines and a variable number of position or result lines. The header lines are displayed once at the beginning of the
table. If the report is distributed over several pages, the header lines are displayed again on each page.

A table template consisting of the header lines and a template for the position line are the basis for the table view. Details are provided in the following section on representation.

The reports in FluidDraw provide several ways of evaluating the objects included in the project. However, the following reports are not possible:

— Cross-project reports are not possible. You can only create reports within a project that refer to the current project.

— Filters on grouped data can be defined. Reports for listing all components that occur more than five times in the project are not possible, for example.

— Sub-queries or nested reports are not possible.

Various dialogues are used in FluidDraw to influence the properties or the structure of a report. If you double-click a report on the page or its properties, the properties dialogue appears first. Only certain, selected settings of the report can be modified in this dialogue. The “Edit details...” button can then be used to open a further dialogue with the details of the report. In this dialogue, the report can be adapted completely, compared to the properties dialogue.

This separation into two dialogues is done in FluidDraw to simplify the use of reports during daily work and to conceal the complex details of a report. The dialogues are designed such that it should normally not be necessary to jump to the details of a report when using a report in the project. The corresponding details only need to be adapted if the basic structure of a report needs to be adapted.

For a comprehension of the concepts and dialogues described below, we recommend that you study the default reports provided with their settings and use them as the starting point for your own reports. All concepts described below are used more or less in the default reports and are thus explained.
16.5.1 Object selection

Every FluidDraw project consists of a wide range of different objects, such as components, conduction lines, cables, terminal strips and terminals, which are organised on different sides. In addition, there are global objects in which the higher-order data of several components is stored, such as for a valve terminal.

The object selection defines which of these objects from the project are to be taken into account in the report. Should the report include all connector lines or should it be a report of all components including their connections? This is defined fundamentally with the object selection and determines which properties and attributes are available for displaying the results of the report.

Every object in FluidDraw has certain properties and attributes, which can be displayed and edited using the properties dialogue of the corresponding object. These are e.g. the description of a page or a component, the various IDs such as “Display in Parts Lists” or the catalogue and user-defined attributes. In the object selection, you can define filter criteria based on the values of these properties and attributes to limit the number of objects listed in a suitable manner.

The object selection is split up into two views:

**Object selection at properties dialogue**

The properties dialogue contains the selection of the pages included in the report and it displays the quick filters.

**Object selection at report details**

You can use the “Edit details...” button in the properties dialogue of a report to access the details of the report. You can specify in detail there on the object selection tab which objects are to be taken into account in the report.
The objects included in the report are listed under “Selected objects”. You can use the “Add” button to select an object class and add it to the report. You can use the “Remove” button to remove the currently selected object class from the report again.

If you highlight a selected object class, additional control elements are displayed below the list of selected objects that you can use to define filter criteria for the object class selected.

Simplified quick filter
This option defines how the quick filters, which are explained below, are displayed in the properties dialogue.

Hide page selection
Defines whether the report can be limited to specific pages or not in the properties dialogue.

If you press the “Add” button, the following dialogue appears for selecting the object class:

---

Figure 16/9: Details of a report: Object selection tab
Some objects in FluidDraw are organised in a hierarchical structure, which is also displayed in the object browser. That applies e.g. to the terminals of a terminal strip or to the connectors of a component.

A report can use this hierarchical structure in the object selection e.g. to also evaluate the corresponding sub-objects for the corresponding main object at the same time, or to be able to define specific filters at the sub-object.

That means that e.g. specific main components can be evaluated and also all connectors of precisely these main components. The question is only how the sub-objects, i.e. in the example the connectors of the main components, are to appear in the report. There are generally two ways to do this. They are illustrated using the following example. The following three cylinders with their connectors are evaluated:

![Figure 16/11: Circuit diagram example for illustrating the output mode](image)

In the event of a report of the main components only, like in a single position parts list, you will get the following result:
Figure 16/12: Result of the object selection with main components only

The circuit diagram contains the three main components that meet the filter criteria for selecting objects. In this example, the same criterion is used as in the single position parts list (“Display in Parts Lists” must be set). Therefore, the result of the report has three lines, one line for each component.

If the connectors of the main components are now also to be evaluated, the connectors can also be added to the object selection as sub-selection for the main components. The object selection would then look like as follows:

<table>
<thead>
<tr>
<th>Pos. No.</th>
<th>Identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-M1</td>
</tr>
<tr>
<td>2</td>
<td>-M2</td>
</tr>
<tr>
<td>3</td>
<td>-M3</td>
</tr>
</tbody>
</table>

Figure 16/13: Object selection with main components and connectors

The report now not only contains the main components but also the corresponding connectors of the main components. In this example, components M1 and M2 each have two connectors and M3 has one connector. Previously, only main components were listed in the result. Where are the additional connectors now to be displayed? For this, there are the following two options, that are distinguished via the output mode:

**Next to each other**

In *Next to each other* output mode, the sub-objects are each displayed in the same line with their parent object. For the example, this would then look like as follows:
Figure 16/14: Report result in 'next to each other' mode with main components and connectors

The result now has five lines as the three components have a total of five connectors.

**Below each other**

In *Below each other* output mode, the sub-objects are displayed in their own separate rows below the main objects. For the example, this would look like as follows:

![Diagram](image1.png)

Figure 16/15: Report result in 'below each other' mode with main components and connectors

The result now has eight lines: three for the components and five for the connectors. This representation highlights the hierarchy of the objects. That can be further emphasised by colouring the object classes, like in the example here.

**Contents of the report result**

As previously shown, the result of the report in the event of an object selection with sub-objects depends on the selected output mode. That does not only apply to the number of result lines creat-
ed, but also to the contents of the result lines. If the definition was made in the column selection for a specific column that e.g. the identification is to be displayed there, it depends on the corresponding output mode selected how this is interpreted.

In *Below each other* output mode, the individual objects selected are displayed below each other in the result. That means that precisely one object is represented in the result with each line. In this case, the properties selected in the column selection therefore always refer to the corresponding object of the line. In the example above, the identification of the main component would be displayed in a column with the identification, followed by the identification of the connectors in the lines below.

In *Next to each other* output mode, the main objects are displayed with their sub-objects together in one line, as described above. The number of sub-objects determines the number of result lines. In this case, the properties selected in the column selection refer to the selected sub-objects. In the example above, that means that only the identification of the corresponding connectors is displayed in succession a column with the identification. In the example above, this is the third column with the heading: *Connector*.

If you want to access the properties of a main object in an output line in *Next to each other* output mode, what is called a level selector must be inserted in front of the variable. It has the following syntax:

<table>
<thead>
<tr>
<th>Level selector</th>
<th>level</th>
</tr>
</thead>
<tbody>
<tr>
<td>e[0].</td>
<td>Topmost level of the object selection</td>
</tr>
<tr>
<td>e[1].</td>
<td>First sub-level of the object selection</td>
</tr>
<tr>
<td>e[2].</td>
<td>Second sub-level of the object selection</td>
</tr>
<tr>
<td>e[3].</td>
<td>Third sub-level of the object selection</td>
</tr>
</tbody>
</table>

In the example above, the level selector e[0] was used for the second column with the *Component* heading to display the identification of the main component. Therefore in the column select, for the *Component* column “e[0].designation” is entered as the content whereas for the third *Connector* column, only “designation” is entered.
Filter criteria

The selected object classes can be limited to specific objects using a separate filter. It is thus e.g. possible to only have those components of a specific supplier displayed or whose identification starts with a specific letter.

To configure or adapt the filter criteria for an object class, highlight them in the list of the selected objects. An additional group then appears with input fields for the filter criteria. The input fields in this group always only apply to the currently selected object class from the view of the objects to be listed. A separate filter can thus be set individually for every class.

A filter consists of one or more filter criteria that are listed in individual lines. Every filter criterion consists of the following elements:

1. ID
   - An automatically assigned consecutive number for the filter criterion. This ID is used later on in the filter logic for the identification of a filter criterion.

2. Property
   - A specific property or an attribute by which the object selection is to be limited. The properties of the corresponding object class are available here. The available attributes are determined from the current project. That means that e.g. for the `Main Component` object class, all attributes are available here that are currently used in the components of the project.

3. 1. OP
   - Defines the first operator for this filter criterion. The following operators are available:

<table>
<thead>
<tr>
<th>Operator</th>
<th>meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Is equal to</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Unequal</td>
</tr>
<tr>
<td>{}</td>
<td>Is empty</td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>!()</td>
<td>Is not empty</td>
</tr>
<tr>
<td>[*]</td>
<td>Contains</td>
</tr>
<tr>
<td>[!*]</td>
<td>Does not contain</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Same or greater than</td>
</tr>
<tr>
<td>&lt;</td>
<td>Smaller than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Same or smaller than</td>
</tr>
</tbody>
</table>

1. **Value**
   - The value for the application with the first operator.

2. **OP**
   - To define a value range, a second operator can be defined here. The first and second operators are always linked logically with AND.

   **Comparison method**
   - Controls how the comparison operators such as greater than or smaller than are applied. This is especially important for properties that include both letters and numbers.

   **Quick filter**
   - If this ID is set, the filter criterion is provided in the properties dialogue on the object selection tab as a quick filter. The filter criterion value can thus be adapted quickly and directly in the properties of the report and does not need to be changed in the details of the report.

   **Lock operators**
   - Disables the operators against changes in the quick filter in the properties dialogue. Only the value for the filter criterion can then be changed in the properties dialogue, not the operator.

   **Display name**
   - Defines a display name for the selected property in the quick filter.

### Filter logic

If more than one filter criterion is specified, by selecting the filter logic you can define how the individual criteria are to be linked to each other. The following selection is available here:

**AND conjunction**
- All criteria must be met in order that an object appears in the report.
At least one criterion must be met in order that an object appears in the report.

The individual criteria are linked to each other by a user-defined logic. It can be entered in the input field to the right of the selection. The individual criteria are addressed via their corresponding ID number. AND and OR are available as the operators. Partial expressions can be inserted in round brackets. The following filter logic is thus e.g. possible: \( 1 \text{ AND } (2 \text{ OR } 3) \)

The filter logic is checked directly while it is entered and if there are errors a note is displayed directly in the input field. As soon as the entered filter logic is valid, it can be applied using the Apply button and saved.

### 16.5.2 Column selection

The column selection is used to define which properties or attributes of the selected objects are to be output in which column of the report. That defines the basic structure of the report result as the report result always has as many columns in the position lines as selected here and that have the Show ID.
Figure 16/17: Details of a report: Column selection tab

Selected columns

The main element of the column selection is the table of selected columns. All columns taken into account in the report are listed here with the following data:

ID

Consecutive numbering of the column. Is used as the index for addressing the column headings.

Column heading

Freely selectable column heading for the corresponding column.

Contents

The contents of the column. This is explained in more detail below.

Display

Defines whether the column is displayed in the report result or not. A hidden column can still be used for sorting and/or for grouping.

Function

The column is only displayed in the table if the Group option is selected. Defines the grouping function for the corresponding column of the report.

Available columns

The list of available columns is to be found on the left side of the tab. All those properties and attributes are listed there that are not included yet in the report. This is controlled using the Hide already selected columns.
used columns option below the list. Deselect this option if you also want to view the properties already used in the list.

The list of available properties contains all properties and attributes of the objects from the current project. That means only those attributes are available here that are also used in the objects of the current project.

Adapting the selected columns

You can add new columns of the report using the buttons between the list with the available columns and the selected columns or delete columns. Alternatively, you can use the Add button to create a new empty column at the end of the list of columns and use the Remove button to delete the currently selected column.

You can also transfer new columns from the list of available columns via drag and drop to the list of the selected columns. This has the benefit that you can define directly at which position the new column is to be inserted.

You can use the two buttons to the right of the list of the selected columns to change the order of the columns.

Contents of a column

Normally only one placeholder is specified in the Contents field of an individual column for a property of the objects to be listed. This can e.g. be the part-number placeholder for the part numbers of components.

In addition, a fixed text can be entered in quotation marks if it is also to be displayed in every line of the result. For example, by entering “T:” part-number in the result, the fixed text “T:” can precede every part number. The quotation marks can be omitted if the fixed text does not contain any letters or numbers. That means individual separators, such as blanks, colons etc. can also be entered without quotation marks.

In this field it is still also permitted to specify several placeholders for properties. The corresponding placeholder is replaced in the resulting list with the value of the property. It is thus possible e.g. to display several properties together in one column. For example, you could enter part-number:attribute[Supplier] to display the part number and the supplier together in a column, separated by a colon.
If no value is specified for the property of the placeholder used or if this property does not exist in the listed object, the placeholder is replaced by an empty string.

**Sorting**

Every report can be sorted by one or more selected columns. The sort order is set using a separate dialogue that can be accessed using the **Sorting** button.

![Sort Dialogue](image)

Figure 16/18: Dialogue for sorting a report by specific columns.

You can use the buttons above the sort criteria to add more sort criteria, delete/copy existing criteria or change their order. The columns of the sort criteria have the following contents:

<table>
<thead>
<tr>
<th>Column</th>
<th>Selection of the column by which sorting is carried out.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>A...Z: ascending order; Z..A: descending order</td>
</tr>
<tr>
<td>Mode</td>
<td>Default (natural)</td>
</tr>
<tr>
<td></td>
<td>Natural sort order of the values. (A1 &lt; A2 &lt; A11)</td>
</tr>
<tr>
<td></td>
<td>Alphabetical</td>
</tr>
<tr>
<td></td>
<td>Lexographic sort order of the values. (A1 &lt; A11 &lt; A2)</td>
</tr>
<tr>
<td></td>
<td>Numeric</td>
</tr>
<tr>
<td></td>
<td>An attempt is made to interpret the contents of the column as a number and to sort according to this number.</td>
</tr>
</tbody>
</table>

**Grouping**

Instead of specifying each individual object in the result of the report, the result can also be summarised. To do this, select the “**Group**” option at the top right of the tab. After selecting the option, the additional “Function” column appears in the table of the selected columns. The grouping function can be selected for every col-
umn in this new column. The following grouping functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Defines the column as a criterion by which its values are to be grouped.</td>
</tr>
<tr>
<td>List</td>
<td>Connects the grouped individual values to form a list separated by commas.</td>
</tr>
<tr>
<td>Sum</td>
<td>Calculates the sum of the grouped individual values.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Calculates the minimum of the grouped individual values.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Calculates the maximum of the grouped individual values.</td>
</tr>
<tr>
<td>Count</td>
<td>Determines the number of grouped individual values.</td>
</tr>
</tbody>
</table>

An example of the grouped report is the standard template of the accumulated parts list.

### 16.5.3 Appearance

The table view of the report in the project can be set in a similar manner to the object selection in the properties dialogue and also in the details of the report. The options in the properties dialogue are more limited than in the details of the report. The drawing properties can only be edited in the properties dialogue.
In the properties dialogue, you can define the following settings on the Appearance tab:

**Font size**
Adaptation of the font height in percent of the font used in the report. The size of the table is not changed by this adjustment.

**Additional Line Spacing**
Increases the height of all lines by the specified percentage factor. (50% means that every line is displayed with 1.5 times the height.) That does not change the font height.

**Additional Cell Spacing**
Increases the width of all columns by the specified percentage factor. (50% means that every column is displayed with 1.5 times the width.)

**Lines per Page**
You can also use this option to define how many lines of the report result are to be displayed on each page. If this option is selected and a value greater than 0 is entered, the report result is displayed distributed among several pages. The specified number of lines refers to the result lines below the header lines of the report. The header of the report is repeated on every page.
Figure 16/20: Properties of a report: *Drawing Properties* tab

In the properties dialogue, you can define the following settings on the Drawing properties tab:

**Anchor Position**
- The result of a report is created dynamically from the current data of the project and is updated accordingly on a continuous basis. That may change the size of the report on the page. You can use this option to define which corner of the report is to have a fixed position on the page. If the report is updated, this point remains fixed and the report only grows in the other direction.

**Scale Factor**
- Defines the scaling of the report in the horizontal and vertical directions.

**Rotation**
- Defines the rotation angle for rotating the table.

You can use the Reset button to reset all values on this tab to the default settings.
The basic table template for the table view of the report can be adjusted in detail on the Appearance tab in the details of a report. The table template is displayed in the centre of this tab. It is split up into header lines and a single position line. The header lines and the position line are displayed in the table template with a small space between them to emphasise the difference between the header part and the position part. No space is displayed between the header and position lines at this point in the finished report on the page. There is also a note in the dialogue to the right of the header lines that informs you which lines belong to the header lines.

The table template defines the basic structure for the output of the report in the project. The specified header lines are output once in the header of the report and the position line is duplicated according to the number of lines in the result. Therefore, the position line is only displayed once here in the view of the template. Afterwards, in the result of the report, it is naturally displayed several times, if applicable. Unlike on the Appearance tab in the properties dialogue, this view is not a preview of the result of the report, it only represents the structure.
The number of header lines of a report is generally not limited and a report without header lines is also possible. There is always only precisely one position line, by contrast.

The number of columns of the table template matches the number of selected columns with Display ID on the column selection tab. The variables/placeholders of the corresponding column in the column selection are entered in the position line, in the respective column. In addition to the column selection, the contents can also be adapted here. The available properties of the selected objects are provided in the Variables list on the left side of the tab for this purpose. They can be assigned to the corresponding cells of the table template e.g. using drag and drop.

Variables can also be used in the headers of a report in addition to fixed texts. To use the column heading defined in the column selection there is the fixed column[x] variable. The ID of the corresponding column must be entered instead of the x. This variable is replaced by the corresponding column heading when the report is created.

Like in the position lines, properties of the selected objects can also be output in the header lines. For this, the same variable can be used that was specified in the position line. When you create the report, the first object is applied to replace this property.

Like in the position line, fixed texts and variables can be combined in the header lines. However, unlike in the position lines it is not necessary to insert a fixed text explicitly in quotation marks in the header lines and if a variable could not be replaced it is retained in the form of text.

Each cell of the template can be given a specific formatting using the toolbar above the table. This works here like the formatting of cells of the table drawing element or the header of a drawing frame. The formatting options are described in more detail in these chapters.

In addition to the toolbar above the table, the background colour can be set below the table for various lines of the report. Select here for which lines you want to save a specific background colour. Changes concerning the position line, such as a background colour for uneven lines are only visible in the project.
Chapter 17

You can find the function diagram in the FluidDraw standard library. You can apply the functions in the [Edit] menu to the function diagram. Double-click the function diagram, or use the [Home] page and the [Properties...] menu item to open the *Functional diagram*.

The *Functional diagram* can be used to draw a function diagram with signal lines, signals and diagram lines. The lines of the function diagram consist of two parts: the table text boxes on the left and the diagram area on the right. The table text boxes may consist of several columns and an adjustable grid can be applied to the diagram area. The grid represents the different states of the diagram in rows and the time sections in columns.

![Functional diagram interface](image)

Figure 17/1: Functional diagram

### 17.1 Edit modes

The *Functional diagram* provides various edit modes that are selected via the toolbar at the top of the editor. The edit modes and their operation are shown briefly below.
You can always use the Esc key to switch back from every mode into Edit Mode. The current selection is cancelled with the right mouse button. That can be particularly helpful e.g. for drawing signal lines (see Draw signal lines and insert signal connections).

17.1.1 Edit Mode

In Edit Mode, the objects can be adapted within the function diagram. Objects can be moved and the size of free text boxes and table text boxes can be changed.

To move an object, click it with the left mouse button and keep it pressed. If you move the mouse, a preview of the new position of the object is displayed. The object is moved to the new position when you let go of the left mouse button.

To change the size of a text box, move the mouse pointer to the edge (or to the corner if it is a free text box) until the cursor is converted into the “change size” cursor. With a left-click and by keeping the mouse button pressed, you can now adapt the size of the text box. If a text box is reduced in size to the extent that the text no longer fits in it, the font size is reduced. However, if the size of the text box is increased, that will also increase the font size up to the previously selected font size.

All moving and dragging operations can be cancelled using the Esc key. As already mentioned, the current selection can be cancelled by a click with the right mouse button. Undo and Redo can be used to undo and redo operations.

Properties of objects can be changed in Edit Mode by double-clicking the object. That opens the properties dialogue window for the object.

Selected objects (apart from diagram columns and table text boxes) can be deleted by pressing the Del key.
In addition, in *Edit Mode*, you can copy texts between the table text boxes by clicking a table text box while keeping the left mouse button pressed. The text of the box is displayed at the mouse pointer and if you let go of the left mouse button over another table text box it is copied there. If you keep the Shift key pressed when you let go of the left mouse button, the text is moved and removed from the original text box.
17.1.2 Drawing a diagram curve

The diagram lines can be drawn in this mode. A vertex is created on the grid of the diagram column with each left-click. The points are automatically connected.

Keeping the left mouse button pressed, you can move existing vertices like in Edit Mode. Marked vertices are shown in grey. The Del key is used to delete a selected vertex.

Should the automatic connection of points in diagram line mode not result in the desired diagram, points can be exchanged by dragging one point to the other. For this, the points must be below each other vertically (in the same step). The points are exchanged and the automatic connection is created.

It is also possible to create a “peak” within a step. Set a point in the diagram and set another point within the same step (vertically below each other). Then set a point at the starting point. That results in a vertical deflection.
17.1.3 Insert text boxes

Text boxes can be inserted with a left-click in this mode. Free text boxes can be created above the table text boxes, in the diagram column and also below and to the right of the diagram. When you create a text box, the text box dialogue opens, in which the text and the font can be set. The text box is adapted to the text entered when the dialogue is confirmed.

In “Edit Mode”, you can change the size and the position of a text box with the mouse pointer.

17.1.4 Insert signal elements

In this mode, signal lines can be inserted in the diagram columns with a left-click. If you select the Insert signal elements button with a simple left-click, after adding a new signalling element, the mode switches back to Edit Mode. If you select the mode with a double-click, you can add several signalling elements in succession.

The signalling elements are aligned with the grid of the diagram column by default. If the signalling element is to be positioned freely, you can keep the Alt key pressed during positioning, which prevents any alignment with the grid.

Keeping the left mouse button pressed, you can move signalling elements like in Edit Mode.
17.1.5 Draw signal lines and insert signal connections

In this mode, signal lines can be freely created and automatically inserted between diagram vertices or from signalling elements.

Creating signal lines freely

Vertices are added to the current line with a left-click. If no line is selected, the first click creates a single vertex and the second click creates a line to the second vertex. All other vertices are immediately added to the selected line, as shown in the preview. You can press the Esc key to exit the mode completely and switch back to Edit Mode.

To start a new signal line, you can cancel the current selection with a right-click and start a new signal line with a left-click.

An existing line can be continued by clicking once with the right mouse button (cancel selection) and then left-clicking to select the starting point / end point of an existing signal line. It is marked and the line can be continued.

Individual vertices that do not belong to any signal line are deleted when signal line mode is exited.

If you keep the Shift key pressed when setting a vertex, the new point is aligned vertically or horizontally to the currently selected vertex. To do this, the mouse pointer must be moved roughly to the same height above / below or next to the starting point.

You can insert another vertex within an existing signal line by keeping the Ctrl key pressed while you click the desired point on the line with the left mouse button.

Creating signal lines from signalling elements

Every signalling element has a connecting point for signal lines. Starting at this point, signal lines can be automatically drawn to a grid point. The editor creates a signal line with vertices and arrow head.
To create a signal line this way, you must first right-click the selection to cancel it. Then, move the mouse pointer over a the connecting point of the signalling element until the cursor is converted into a connecting cursor. If you now click with the left mouse button and keep it pressed, a preview of the new signal line is displayed, which can be moved to the desired grid point. The new signal line is created when you let go of the left mouse button.

Signal lines can be created between vertices of the diagram lines with support. After cancelling the selection (right-click with the mouse), the cursor is moved over a vertex of the diagram line until it changes and becomes a connecting cursor. If you now click with the left mouse button, keep it pressed and move the mouse pointer over another diagram line vertex, a preview of the new signal line is
displayed. The new signal line is created when you let go of the left mouse button.

The signal line is created, as shown in the preview, with vertices and is given an arrow head.

Creating signal links

Signal lines can be connected using signal links. If you move the mouse pointer over a signal line, the mouse pointer is converted into a connecting cursor. If the selection was previously empty, left-click the signal line to create a signal link. It is used as the starting point for the linked signal line. An existing signal line can also be
ended with a signal link if the last point ends on a signal line, as described.

Signal links can be moved on the signal line in *Edit Mode* and, unlike vertices, they cannot be positioned freely.

Signal links are displayed as logical AND links by default (filled, large circle). In the signal link properties dialogue, the representation can also be converted to a logical OR link.

### 17.1.6 “Format” mode

With “Format” mode, properties of a text box can be copied and transferred simply to other text boxes. If “Format” mode is activated, the corresponding dialogue opens immediately in which all properties of a text box (apart from the size) can be selected. If a text box is already selected when the mode is activated, the values of the selected text box are applied. They can be subsequently changed. If no text box is selected, the last settings are used.

After confirming the dialogue, the cursor changes to the “Format” cursor. Left-click a text box (free text box or table text box) to transfer all properties. The mode can be exited at any time by pressing the *Esc* key.
For a new function diagram, you can use the “Format” dialogue at the start to define how all newly created text boxes are to be formatted by selecting the “Use as default” option. This has no effect on text boxes already in the diagram.

17.2 Properties dialogues

The properties dialogues of the various objects are listed in the following sections and the individual options are explained. The properties dialogues can be accessed by double-clicking an object with the left mouse button. Only the general diagram properties of the complete function diagram can be accessed using the button.
17.2.1 Diagram properties dialogue

Click the Properties button to open the diagram properties dialogue that includes basic settings for the function diagram (e.g. the number and size of the table text boxes).

![Diagram properties dialogue](image)

Figure 17/2: Functional diagram: properties

<table>
<thead>
<tr>
<th>Text columns – Number</th>
<th>Defines the number of table text boxes. If the number is changed, all table text boxes are adapted to a standard size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text columns – Width</td>
<td>Defines the width of the individual table text box. If the width is changed, all table text boxes are set to the selected width.</td>
</tr>
<tr>
<td>Diagram columns – Number</td>
<td>Defines how many grid columns the diagram column is to have. The number of grid columns in the diagram column can also be changed by pulling the right edge of the diagram.</td>
</tr>
<tr>
<td>Diagram columns – Width</td>
<td>Defines how large the space is to be between the grid columns.</td>
</tr>
<tr>
<td>Color</td>
<td>Opens the colour dialogue that enables the colour to be selected in which the grid lines are drawn in the diagram columns.</td>
</tr>
<tr>
<td>Row height</td>
<td>Defines the height of a row. Unlike the width of the individual table text boxes that can be subsequently adapted, all rows have the same height. The height of the rows can also be adapted by pulling the lower edge of the diagram.</td>
</tr>
</tbody>
</table>
17.2.2 Text box properties dialogue

Double-click a text box to open the text box properties dialogue, in which the font and the alignment can be set.

![Text box properties dialogue](image)

Figure 17/3: Text box: properties

**Font...**
Opens the font dialogue that you can use to set the font and font size. The function diagram editor also supports text in bold, italics, crossed out and underlined.

**Color**
Opens the colour dialogue that enables the font colour to be selected.

**Frame**
For free text boxes only: specifies whether a frame is to be drawn around the text box. If no frame is drawn, the text box is displayed on a transparent background. If this option is selected, the text box is given a white background.

**Width**
Defines the width of the current text box. If the size is changed the current text is reduced in size if it is too long. If it is a table text box,
the size of the complete table column is adapted. Unlike when changing the width of a table text box with the mouse, with this option the cell is increased / reduced in size without changing the size of adjacent text boxes.

Height
Defines the height of the current text box. If the size is changed the current text is reduced in size if it is too high. If it is a table text box, the height of all lines is adapted.

Horizontal adjustment
Specifies the horizontal alignment of the text within the text box.

Vertical adjustment
Specifies the vertical alignment of the text within the text box.

Negate text
Negates the text in the text box. Like in mathematics, a line is drawn over the actual text for this.

Using a text box as a table
To format the contents of a text box like a table, you can use tabulators. They are inserted by keeping the Ctrl key pressed while pressing the Tab key. Each line can thus be split up into cells of equal size that are arranged according to the alignment. Each text box line can have a different number of cells. The arrangement of text within the cell is thus highly flexible.

17.2.3 Diagram columns properties dialogue

Double-click a diagram column to open the diagram columns properties dialogue, in which the numbering, the grid and the representation of the column can be adapted.
**Figure 17/4: Diagram columns: properties**

**States – Number**
Specifies the number of states, thus defining the number of horizontal lines of the diagram column.

**States – Base state**
Defines the basic state of the diagram column. Diagram curves that are drawn between two points in the basic state are displayed with a thinner line.

**Numbering – Number**
Specifies how many steps are to be numbered. 0 must be entered if numbering is not to be carried out.

**Numbering – Start column**
Defines the column at which numbering is to be started.

**Numbering – Start number**
Defines the number with which numbering is to be started.

**Numbering – Step width**
Defines the increment between two numbers. With an increment of 2 and a start number of 1, numbering would be 1, 3, 5, 7, etc.

**Numbering – Loop**
Specifies whether the numbering is to represent a loop. If this option is selected, an equality sign and the start number are also
Displayed after the last number. For 3 numbered steps with a start number of 1 and an increment of 1, numbering would be 1, 2, 3 = 1.

**Representation – Display arrows**
Specifies whether two arrows are to be displayed in the top left corner of the diagram column that point to the right and downwards.

**Representation – Display grid**
Specifies whether the grid of the diagram column is to be displayed.

**Representation – Display text 1**
Defines whether a text box is to be displayed. The text box is displayed to the right of the horizontal arrow if the *Display arrows* option is selected. The text box is linked to this diagram column and cannot be moved to any other line.

**Representation – Display text 2**
Defines whether a text box is to be displayed. The text box is displayed to the right of the vertical arrow if the *Display arrows* option is selected. The text box is linked to this diagram column and cannot be moved to any other line.

**Representation – Line color**
Opens the colour dialogue that enables the colour of the diagram lines to be selected.

### 17.2.4 Signalling element properties dialogue

Double-click a signalling element to open the properties dialogue for signalling elements, in which the representation of the signal can be selected.
Specifies how the signalling element is to be displayed.

Defines whether a text box is to be displayed for labelling the signalling element. The text box can be moved freely. However, it is linked to the signal. When moving the signal, the text box is moved along with it.

Opens the colour dialogue that enables the colour of the signalling element to be selected.

**17.2.5 Signal lines properties dialogue**

Double-click a signal line to open the signal lines properties dialogue, in which the colour and the display options of the signal line can be set.
Figure 17/6: Signal lines: properties

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display description</td>
<td>Inserts a text box that can be moved on the signal line.</td>
</tr>
<tr>
<td>Display additional description</td>
<td>Inserts a text box that can be used to add an additional description. The text box can be positioned freely. However, it is linked to the description on the signal line. If the text box is moved on the signal line the additional description is moved along with it.</td>
</tr>
<tr>
<td>Start with arrow</td>
<td>An arrow head is displayed at the start of the line. The arrow head can be moved freely on the line.</td>
</tr>
<tr>
<td>End with arrow</td>
<td>An arrow head is displayed at the end of the line. The arrow head can be moved freely on the line.</td>
</tr>
<tr>
<td>Color</td>
<td>Opens the colour dialogue that enables the colour of the signal line to be selected.</td>
</tr>
</tbody>
</table>

17.2.6 Signal link properties dialogue

Double-click a signal link to open the signal link properties dialogue, in which the representation of the signal link can be selected.
Figure 17/7: Signal link: properties

Representation

Specifies how the signal link is displayed.

17.2.7 “Format” dialogue

Click the “Format” button to open the “Transfer format” dialogue, in which the settings can be selected that can then be transferred to other text boxes.
Figure 17/8: Transferring the format

Font... Opens the font dialogue that you can use to set the font and font size. The function diagram editor also supports text in bold, italics, crossed out and underlined.

Color Opens the colour dialogue that enables the font colour to be selected.

Frame For free text boxes only: specifies whether a frame is to be drawn around the text box. If no frame is drawn, the text box is displayed on a transparent background. If this option is selected, the text box is given a white background.

Horizontal adjustment Specifies the horizontal alignment of the text within the text box.

Vertical adjustment Specifies the vertical alignment of the text within the text box.

Negate text Negates the text in the text box. Like in mathematics, a line is drawn over the actual text for this.

Use as default Specifies whether the selected settings are to be applied as the default settings to all new text boxes.
17.3 Rows

The number of rows and their position in the function diagram can be subsequently changed. Therefore, in addition to adding and deleting rows, it is also possible to copy rows with their complete contents or move them in the diagram.

17.3.1 Add row

Click the Add row button to add a new, empty row at the end of the function diagram. The table text boxes are created with the default settings (see Defining default settings).

17.3.2 Insert row

Click the Insert row button to add a new, empty row in front of the selected row. If an object is selected that is in a line, the new line is inserted above the assigned line.

17.3.3 Copy row

It is possible to copy lines in the function diagram. As the diagram lines and texts of the table text boxes are frequently similar or identical, the copy function saves a great deal of manual work.

Click the Copy row button to copy the currently selected line and insert it under the selected line. If an object is selected that is in a line, the assigned line is copied.
When copying, the contents and settings of the table text boxes and the diagram column, the diagram lines and the signalling elements are copied. Free text boxes and signal lines are not copied.

17.3.4 Moving rows

Rows in the function diagram can be subsequently moved. That enables a flexible arrangement of existing rows without having to delete rows.

Click the “Move row up” and “Move row down” buttons to move the currently selected row up / down. If an object is selected, the corresponding row is moved. All objects of the row are also moved, apart from free text boxes. As vertices of signal lines are also affected, moving a row can result in changes in the signal lines.

17.3.5 Delete row

Click the “Delete row” button to delete a highlighted diagram row. If an object is selected that is in a row, the assigned row is deleted.

17.4 Scrolling and zooming in and out

The mouse wheel can be used to scroll the view vertically (if scroll bars are displayed). If you keep the Shift key pressed, you can use the mouse wheel to scroll horizontally.
Click the “Zoom In” and “Zoom Out” buttons to increase / reduce the size of the view. If you keep the Ctrl key pressed, you can also use the mouse wheel to change the zoom factor.

The “Standard Size” button can be used to restore the default zoom factor.

The “Fit to Window” button is used to automatically select the zoom factor so that the complete function diagram is displayed in maximum size.
18.1 Potentials and conduction lines

The creation of horizontal and vertical potential lines is supported by drawing conduction lines. The end points of the conduction line consist of potentials that also serve as interruptions. In the dialogue window for drawing conduction lines you can specify whether the potentials should have an identification.

In this following, three horizontal potential lines are to be drawn where each line comes from a preceding page “1” and is to be continued on a page “3”.

To open a dialogue window where you can make the settings displayed, press the Conduction Line... button in the Link group on the Insert ribbon page.
Figure 18/1: Settings for the potential lines to be created

You can then define the end points of the line with two consecutive mouse clicks.

![Diagram of potential lines]

Figure 18/2: Three horizontal potential lines

The identifications of the potentials can be changed. In this example we want to rename the potential from L4 to L6.

→ Double-click the left-hand potential L1. Then enter L4 for the identification in the dialogue window.

Then, the following prompt opens.
FluidDraw supports the automatic renaming of the potentials linked with the source potential. If you answer “Yes”, the potential L1 on the right-hand side is also renamed as L4.

→ Rename the potentials L2 and L3 to L5 and L6 in the same way.

→ Then enter the corresponding labels for the predecessors or successors in the properties dialogue windows for the potentials. If the corresponding cross-references have the same labels in the respective predecessor and successor pages, the potential lines might look like as follows.

![Diagram](image)

Figure 18/4: Three horizontal potential lines with cross-references

18.2 Cables and wiring

Cables and wiring are represented in the circuit diagram by a special cable symbol. All lines defined by the cable symbol are assigned to a cable or to wiring. You can define for the symbol whether it is a cable or wiring.

A wiring only summarises the defined lines (wires) graphically in the circuit diagram and is assigned the identification “W” by default. Wiring is not listed in reports such as cable maps and cable lists. Unlike a cable, wiring cannot be assigned to a product. With wiring, product information can only be saved in the lines.
If the cable symbol represents a cable then a cable object must be assigned to the symbol. Product properties can be saved in the cable object and are analysed in cable maps and cable lists, etc. Several cable symbols can refer to same cable object. This is the case if, for example, a cable has to be spread over several pages.

Figure 18/5: Cable symbol

To define a cable or a wiring select the [Cable] button in the [Electrics] group on the [Insert] ribbon page.

This activates a mode that allows you to insert a cable symbol by making two consecutive clicks. All lines that are below the cable symbol are initially assigned to a wiring.

If you want to use a cable instead of a wiring you can assign a cable object to the symbol using the properties dialogue window for the cable symbol.
Figure 18/6: *Cable Symbol* dialogue window, *Wires* tab

**Layer**
Defines the drawing layer for the cable symbol.

**Cable – Wiring**
Defines whether the cable symbol represents a cable or wiring comprising single wires. Any wiring is not listed in cable maps, etc. If *Wiring* is selected then an identification can be specified that can be displayed with *Display Identification*.

If *Cable* is selected then an existing cable object can be assigned to the cable symbol using a drop-down list. A new cable object can be created using the *Create New...* button. Clicking *Properties...* opens the properties dialogue window for the selected cable object.

**Wires**
In order to analyse cable maps the component connectors that join a wire must be determined. The connectors are automatically entered in the list box if they can be uniquely assigned. If a unique assignment is not possible, the relevant connector must be select-
ed manually via the list box. The identification of the individual wires can also be entered. These are saved in the individual lines (wires). The wire identifications are displayed at the cable symbol using the Display button.

Reverse Direction
The entries in the From and To columns are automatically defined as the direction of the wires when creating the cable symbol. Clicking the Reverse Direction button reverses the directions of all wires.

Renumber From:
Clicking this button renumbers all wires defined by the cable symbol, starting with the number entered in the list box.

![Cable Symbol dialogue window, Display Attributes tab](image)

Figure 18/7: Cable Symbol dialogue window, Display Attributes tab

On the “Display Attributes” tab you can select the attributes of the associated cable object that are to be displayed at the cable symbol.
Click the **Create New...** button to create a new cable symbol.

The following dialogue window opens.

![New Cable dialogue window](image)

**Figure 18/8: New Cable dialogue window**

<table>
<thead>
<tr>
<th>Identification</th>
<th>Enter the identification for the cable here.</th>
</tr>
</thead>
</table>
| Number of Wires | Enter the number of lines (wires) in the cable here. The number can be higher than the lines below if, for example, a concrete cable has unconnected wires. If the associated cable symbols covers more lines than are defined in the cable object, a warning is output when the page is checked and the corresponding entries are highlighted in colour in the cable lists. After you specify the identification for the cable and confirm the dialogue, the cable object is created and the cable symbol is assigned to it.

Click the **Properties...** button to edit the properties of the cable object.
Number of Wires

Defines the number of lines (wires) in the cable. The number can be higher than the lines covered by the associated cable symbols if, for example, a concrete cable has unconnected wires. If the associated cable symbols covers more lines than are defined in the cable object, a warning is output when the page is checked and the corresponding entries are highlighted in colour in the cable lists.

The associated cable symbols are listed in rows in the table. You can jump to the associated cable symbol using the “Find...” button. The *User Defined Properties* tab in the properties dialogue window for the cable symbol lists the cable-specific product properties such as *Cable Type* and *Length*. These properties and the entries in the *Cable* tab are analysed in the cable map, etc.

18.2.1 Managing cables

All cables within a project can be listed and renamed using the *Manage Cables...* button in the *Manage* group of the *Project* ribbon page. You open the *Properties...* properties dialogue window for the relevant cable object using the button.

In older versions of FluidDraw it was possible to assign a cable to a specific page. That sometimes caused confusion; all cables therefore now become *global objects* that belong directly to the project and not to an individual page any more.

For existing circuits created with a previous version of FluidDraw, you can still access all cables belonging to the page via the *Manage Cables...* menu item under *Page*. 
You can add a new cable object to the project using the **Create New...** button.

After pressing the **Create New...** button for confirmation, a dialogue opens where you can define the name and number of wires for the new cable object. The dialogue window is described under Cables and wiring.

### 18.2.2 Inserting a cable map

You can insert an associated cable map for a cable into the circuit diagram. You do this by inserting a cable map into a circuit diagram and then assigning a cable to this diagram.

→ To insert a cable map in the circuit diagram, press the **Report** button in the **List** group on the **Insert** ribbon page.
The mouse pointer changes to a crosshair. Click the position in the circuit diagram where you want to insert the cable map.

A dialogue window then opens where you can assign the relevant cable and customise the appearance.

18.2.3 Inserting a cable list

You can insert a cable list into a circuit diagram.

→ To insert a cable list in the circuit diagram, press the Report button in the List group on the Insert ribbon page.

The mouse pointer changes to a crosshair. Click the position in the circuit diagram where you want to insert the cable list.

A dialogue window then opens where you can select the associated cables and customise the appearance.

18.3 Terminals and terminal strips

18.3.1 Setting terminals

You can set individual terminals or multiple terminals in one step.

→ To define an individual electric terminal select the Terminal button in the Electrics group on the Insert ribbon page.

This activates a mode that allows you to insert a terminal by clicking a free point on the electric line.
As soon as you have set a new terminal this way the dialogue window containing the settings for this terminal appears. You can use this dialogue window to assign the terminal to a terminal strip. This assignment can also be made or changed later.
Figure 18/12: *Terminal* dialogue window

**Description**
Contains the description of the terminal or the terminal designation.

**Display**
If this box is given a check mark then the description entered is displayed next to the terminal.

**Layer**
Defines the drawing layer for the terminal.

**Pos.**
Defines the position of the terminal within the associated terminal strip. An entry is only possible once the terminal has been assigned to a terminal strip.

**Level**
Defines the level of the terminal.

**Display**
If this box is given a check mark then the terminal's level is displayed next to the terminal.

**Internal # External**
Changes the direction of the terminal. The direction is indicated in the circuit by an arrow that shows which connector is inside the control cabinet and which is outside. The arrow head points at the control cabinet.
Show Direction

If this box is given a check mark then the direction arrow is displayed at the terminal.

Terminal Strip

Defines the terminal strip containing the terminal in question. The list contains the terminal strips already created. You open the properties dialogue window for the selected terminal strip using Properties... . You can also create a new terminal strip using Create New... .

Display Identification

If this box is given a check mark then the identification for the associated terminal strip is displayed next to the terminal.

18.3.2 Setting multiple terminals

As well as the option of setting individual terminals, FluidDraw also offers a mode that allows you to set multiple terminals one after the other. You can keep inserting terminals by simply clicking the electric lines until you exit the mode again.

→ To do this, click the Multiple Terminals... button in the Electrics group on the Insert ribbon page.
Figure 18/13: Setting multiple terminals

The operation begins with a dialogue window where you can make some settings for the new terminals. Above all you need to first select an existing terminal strip or create a new one. If a suitable terminal strip does not already exist then a prompt for creating a new one automatically appears.
Figure 18/14: Define Multiple Terminals dialogue window

**Description**
Defines how the new terminals are to be numbered. The *Enumerate Manually* option allows you to specify a start number at which numbering continues. Otherwise a free terminal from the selected terminal strip is automatically used. The start number “2” was specified in the example shown.

**Display**
If this box is given a check mark then the description entered is displayed next to the terminal.

**Direction**
Defines the direction of the new terminals. The direction is indicated in the circuit by an arrow that shows which connector is inside the control cabinet and which is outside. The arrow head points at the control cabinet. The direction can also be changed later using the properties dialogue window for the individual terminals.

**Layer**
Defines the drawing layer for the line.

**Terminal Strip**
Defines the terminal strip containing the terminals in question. The list contains the terminal strips already created. You open the properties dialogue window for the selected terminal strip using **Properties...**. You can also create a new terminal strip using **Create New...**.
Display Identification

If this box is checked then the identification for the associated terminal strip is displayed next to the new terminals.

18.3.3 Creating terminal strips

FluidDraw does not treat terminal strips as visible objects within the circuit pages which explains why they cannot be interactively selected using the mouse in order to highlight them, delete them or change their properties. Terminal strips can either be managed via the associated terminals or using the [Manage Terminal Strips...] menu item under [Page] or [Project].

Figure 18/15: New Terminal Strip dialogue window

All properties can also be changed later at any time. You open the properties dialogue window for a terminal strip via any terminal in that terminal strip using the Properties... button.
If the destination of a terminal inside the control cabinet is unambiguous due to the wiring, FluidDraw automatically enters the identification for the connected component. Otherwise the list contains the identifications of all objects that can be reached from the terminal. The destination search can be controlled by selecting a junction symbol as a T-distributor.

The destinations of the terminals outside the control cabinet are listed here. As with the internal destinations, unique links are automatically entered.
18.3.4 Managing terminal strips

All terminal strips within a project can be listed and renamed using the [ Manage Terminal Strips... ] menu item from the [ Project ] menu. You open the [ Properties... ] properties dialogue window for the relevant terminal strip using the button.

In older versions of FluidDraw it was possible to assign a terminal strip to a specific page. That sometimes caused confusion; all terminal strips therefore now become global objects that belong directly to the project and not to an individual page any more. For existing circuits created with a previous version of FluidDraw, you can still access all terminal strips belonging to the page via the [ Manage Terminal Strips... ] menu item under [ Page ].
You can add a new terminal strip to the project using the **Create New...** button.

A new dialogue opens where you can define the properties of the new terminal strip. The dialogue window is described under **Creating terminal strips**.

### 18.4 Terminal diagram

You can insert an associated terminal diagram for a terminal strip into the circuit diagram. You do this by inserting a corresponding report into a circuit diagram and then assigning a terminal strip to this diagram.

→ To insert a terminal diagram in the circuit diagram, press the **Report** button in the **List** group on the **Insert** ribbon page.
The mouse pointer changes to a crosshair. Click the position in the circuit diagram where you want to insert the terminal diagram.

A dialogue window then opens where you can assign the relevant terminal strip and customise the appearance.

18.4.1 Setting links

You can set what are called *links* in a terminal strip. These links are drawn in the circuit diagram as regular electric lines and marked as links. The representation of the T-distributors can be customised using their properties dialogue window. The following example shows a circuit diagram with a terminal strip X1 with 10 terminals and the associated terminal diagram. A link plug is to be set between terminals “7” and “8” at layer “1”, a link plug between “8” and “9” at layer “2” and a wire link between “9” and “10”.

Figure 18/18: Terminal diagram

→ Double-click the electric line between terminals “7” and “8”. 
The properties dialogue window for the electric line opens. The options for setting the links are in the top right:

- **Link**
  - Defines that this line is to be treated as a link.

- **Link Plug**
  - Defines that the link is a link plug.

- **Level**
  - Specifies the layer if a link plug was selected.

- **Wire Link**
  - Defines that the link is a wire link.

→ Set “Link”, “Link Plug” and “Level 3”.

FluidDraw tracks the line across one distributor point at most. This means that the specified link finds the contacts “7” and “8”. This link is represented in the terminal diagram as follows.
→ Proceed in the same way to set a link plug between “8” and “9” at layer “2” and a wire link between “9” and “10”.

The terminal diagram then has the following appearance.
18.5 Contact image

The contact images can be displayed within a circuit diagram beneath relay coils and similar symbols. The contact images list all contacts of the associated relay coil and show which current paths these contacts are in. The division of the page or circuit diagram can be defined using the page dividers.

To show or hide a contact image, press the Display Contact Images button in the Contact image group on the View ribbon page.

Contact images can be highlighted, moved and aligned like other symbols.
Figure 18/23: Contact image

You can have all contacts in a contact image displayed in a list and customise the appearance by double-clicking the contact image or highlighting the contact image and selecting the **Home** menu item from the **Properties...** menu.
You can customise the representation of the contact image on the “Print Options” tab.

The “Contacts” tab lists all associated contacts. You can jump to the corresponding contact in the circuit diagram using the [Jump to Target] button.
Chapter 19

19.1 Printing circuits and parts lists

FluidDraw projects can be printed by opening the Print dialogue window via the File menu and the Print... menu item.

Figure 19/1: Print dialogue window

Printer

Select the desired output device from the list of available printers.
<table>
<thead>
<tr>
<th><strong>Properties...</strong></th>
<th>This button is for opening the dialogue for setting the printer options.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print to File</strong></td>
<td>Select this option if you want to output the print data to a file.</td>
</tr>
<tr>
<td><strong>Print Project Files</strong></td>
<td>If you are working in a project, you can select which circuits and parts lists are to be printed.</td>
</tr>
<tr>
<td><strong>Copies</strong></td>
<td>Select the number of copies. If the printout consists of several pages, you can make FluidDraw output stacks of paper sorted accordingly.</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>You can increase or reduce the output size by entering a scaling factor. If the dimensions of the area to be printed are larger than the printable area on the paper then the printout is spread over several pages (tiled). You can see the page divisions in the print preview.</td>
</tr>
<tr>
<td><strong>Note:</strong> Please note that it may not always be possible to precisely comply with the page margins. Therefore you should plan a certain amount of leeway for the page margin.</td>
<td></td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>Here you can specify additional margins in order to manually customise the print area.</td>
</tr>
<tr>
<td><strong>Margins</strong></td>
<td>You can select which page the print preview displays.</td>
</tr>
</tbody>
</table>

### 19.2 Importing DXF files

Files stored in DXF format can be imported while retaining most element attributes. If some special features are taken into account when creating a drawing using a CAD program, you can extend the symbol library of FluidDraw without any trouble.
Figure 19/2: Dialogue window, **DXF import**

**Drawing Size**

- Defines the paper size for import. The preview is also set to this size.

**Include objects on paper space**

- Applies the objects in DXF format in the paper area.

**Include objects on model space**

- Applies the objects in DXF format in the model area.
Include hidden objects  Applies the objects defined in DXF format as hidden.

Scale Factor  Defines the scaling factor for import.

Fit to Paper Size  Adapts the scaling in such a way that the complete drawing fits in the paper area defined above.

Not all DXF programs make a distinction between paper and model areas. This also depends on how the CAD drawing was created. The preview in the import dialogue can be used in cases of doubt to simply test which options produce the desired result.

19.3 Exporting circuits

The FluidDraw circuits can be saved as a file with a variety of different formats. The BMP, JPG, GIF, WMF, PNG, DXF, PDF, SVG, TIF and PDF formats are available. Once you have selected the [File] menu item from the [Export...] menu a dialogue window opens where you can define the different settings for export. The settings depend on the format selected.
Then, you will be asked to select a file name or enter a new one.

**Format**
- Select the desired file format.

**Resolution**
- Defines the resolution. This setting is only available for specific image formats.

---

*Figure 19/3: Export Page dialogue window*

- Export Project Files
- Select All
- Total project pages equals selection
- Create overview page (PDF format only)
- Drawing Layers
- Target Size
  - Percent Scale
    - Scale: 100%
  - Absolute Size (mm)
    - Width: 195 mm
    - Height: 294 mm
  - Absolute Size (Pixel)
    - Width: 2304 Pixel
    - Height: 3488 Pixel

[Diagram of Export Page dialogue window]
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color depth</td>
<td>Defines the colour depth. This setting is only available for specific image formats.</td>
</tr>
<tr>
<td>Transparent background</td>
<td>Sets a transparent background. This setting is only available for specific image formats.</td>
</tr>
<tr>
<td>Print lattice</td>
<td>Exports the background grid set in the page.</td>
</tr>
<tr>
<td>Encode unicode characters</td>
<td>Displays umlauts and special characters with a special code. This option is only necessary for the DXF format.</td>
</tr>
<tr>
<td>Export cross-reference links</td>
<td>Exports termination points and other connected objects as links. This option is only available for the DXF format.</td>
</tr>
<tr>
<td>Override Color</td>
<td>Links that you click with the mouse during export can thus be displayed in the defined colour. The existing links are thus easier to recognise. This option is only available for the DXF format.</td>
</tr>
<tr>
<td>Total project pages equals selection</td>
<td>When exporting, only the selected pages are counted and used for the predefined variable &quot;%TotalPages. This is mainly displayed in the drawing frame as the total number of project pages.</td>
</tr>
<tr>
<td>Create overview page (PDF format only)</td>
<td>Use this option to create an overview page. This contains the selected project pages as thumbnails on a single page. This option is only available for the PDF format.</td>
</tr>
<tr>
<td>Drawing Layers...</td>
<td>Select which drawing layers you want to show or hide when exporting.</td>
</tr>
<tr>
<td>Target Size</td>
<td>Define the desired scaling or the absolute export size here.</td>
</tr>
</tbody>
</table>

Bear in mind that a high resolution will result in very large files being created, which can make the export process take longer. You can cancel the image export at any time, however.
Chapter 20

Templates for specific contents are managed at several points in FluidDraw. Every file contains a template. Previously, these were only drawing frames. With version 6, however, this concept has been extended to include project templates and report templates.

The templates are stored in individual files to make it easier to exchange them as well as to facilitate their joint use. These templates are managed using a standardised central dialogue that can be accessed via the menu item: [Manage / Manage templates...].

20.1 Template management dialogue

![Figure 20/1: Dialogue for managing templates](image)

You can select the template type whose templates you want to organize on the left side of the dialogue. The currently selected template type is always displayed on the right side.
As every template is stored in a single file, template management is primarily for the clear organisation of access to these files, which may be located in very different directories on the local PC, removable data storage media or network drives. The aim is therefore to create options so that the user can manage and make these templates accessible in such a way that fast access to the template required is ensured.

The main element on the right side of the dialogue for template management is a flexible folder structure similar to the project tree in the project explorer or the Windows file system. How you can adapt this folder structure to your own requirements is described in detail below.

20.2 Adjustment of the folder structure

By default, the folder structure has two directory links below the main folder for the corresponding template type. This is the reference to the default templates provided in the installation directory of the program and also the reference to the user folder of the current folder in which normally the user-defined templates are stored. The reference to the installation directory cannot be changed. The reference to the user folder can be changed, however.

→ To do this, highlight the link and click the **Edit...** button below the folder structure. You can then select another directory that is to be searched for the user’s own templates.

The two default references to the default templates and to the user-defined templates cannot be deleted, but they can be hidden.

→ To do this, highlight the corresponding link in the folder structure and click the corresponding **Hide** button.

Apart from the restrictions for these two predefined folders, you can define the folder structure as desired. You can use the following basic elements to define your own structure:
**Add folder**

You can use the **Add folder...** button to add a virtual folder to the folder structure to an existing folder, e.g. from the local hard disk or a network drive. A link to this directory is then added to the structure and the directory including all sub-directories is searched for templates of the currently selected template type. All templates found in the corresponding directory are displayed in the structure below the directory link. If templates are found in sub-directories, they are also listed.

**Add files**

You can use the **Add files...** button to add individual or several concrete templates to a virtual folder of the structure.

**New Folder**

You can use the **New Folder...** button to create a virtual folder in the folder structure. Virtual folders, directory links or individual file links can be inserted in this virtual folder. These three buttons are only available if a virtual folder is selected in the folder structure. To begin with, this is only the main folder of the corresponding template type at the very top in the folder structure. The other buttons below the folder structure can be used to subsequently modify it.

**Create Copy**

Creates a copy of the selected template in the file system. You can use this function to create copies of the templates provided and then adapt them to your own requirements.

**Edit**

If a template is currently selected in the folder structure, it is opened for editing. If a directly link is selected a dialogue opens for selecting a different directory.

**Rename**

Allows templates and virtual folders to be renamed.

**Remove**

Removes the selected object from the folder structure. No files are deleted from the file system when this is done. The button is not available for the default directories or for the elements below a directory link.
The **Options...** button of the *Options* group on the *Manage* ribbon page takes you to the *Options* dialogue window that permits various program settings.
21.1 General

Figure 21/1: Options dialogue window: General tab

21.1.1 Language

Programme

Defines the language for the program interface including dialogue windows and messages.
21.1.2 Menu bar

Use classic style menus

FluidDraw uses ribbons by default with pages and groups for displaying the menus and buttons. If the “Use classic style menus” option is active, the classic menu representation is used.

21.1.3 Dialogue boxes

Leave property dialogues open

The properties dialogues of various objects remain open by default until they are closed by the user. You can continue to work on the circuit diagram while the dialogues are open. Any number of dialogues can remain open simultaneously. This performance is also called *non-modal*.

Depending on the way you work, it may be practical to keep several properties dialogues open simultaneously. However, that can also get confusing very quickly. You can deselect the option if you desire. Then, any dialogue open for editing must be closed first before other edit functions can be used. This is also referred to as *modal*.

21.1.4 Project

Undo operation across all project pages

If you want to undo an operation, use the corresponding *Undo* function. You can also undo multiple operations by using the function several times.

If you edit different pages of a project alternately, it may be desired to undo all operations made on the various project pages in precisely the same order. Alternatively, you can define that the undo operation always only applies to the page you are just editing.
Please note that operations that change different pages of a project simultaneously may result in undesired results if the undo operations are not carried out in chronological order. That includes e.g. spreading valve terminal on to several pages or editing global objects such as terminal strips or cables.

Create Unplaced Objects

Some symbols such as for solenoid valves in the pneumatic diagram require additional corresponding solenoid coils in the electrical part. FluidDraw can automatically provide the corresponding components in a special library when such objects are inserted. It is on the left in the area with the component library. It is managed separately for each open project and has the caption: Unplaced Objects.

If you do not require these components that were automatically added to the project, deselect the Create Unplaced Objects option.

21.1.5 Check for updates at start-up

FluidDraw can search the Internet for a new version when the program starts. You can activate or deactivate the automatic search here.

Check for updates now... As soon as there is an Internet connection you can use this button to trigger the search for a new FluidDraw version.
## 21.2 Save

**Save**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compress Files</td>
<td>FluidDraw normally compresses the stored files in order to save memory capacity on the disk. If you deactivate the option the files are saved as XML files without compression. You can find further information in the <strong>Circuit files</strong> section.</td>
</tr>
<tr>
<td>Create Backup Files</td>
<td>The “Create Backup Files” option is used to create previous versions of stored files with the file extension <code>.bak</code>. You can restore the previous version this way.</td>
</tr>
<tr>
<td>Verify File Write</td>
<td>Activate this option if you want to ensure after a save operation that the file was written correctly.</td>
</tr>
<tr>
<td>Create Folder For New Projects</td>
<td>A folder with the project name where all project files are stored is automatically created when a new project is created if this option is active.</td>
</tr>
<tr>
<td>Embed Image Files</td>
<td>If you want to insert an image file in FluidDraw you will be requested to select a file path. You have the choice of embedding the image or of saving the file path as an external link. If you frequently want to forward or archive your circuit drawings, you should embed the images.</td>
</tr>
</tbody>
</table>

Figure 21/2: *Options* dialogue window: *Save* tab
Save source path

If you have embedded an image file the original file path is no longer required. However, it may still be practical if you can also see later on where the image came from.

⚠ Please note that even if the option is selected the image is not updated if the image file has changed. The file path is for your information only. If you desire an automatic update, do not embed the image but create an external link instead.

21.3 Product Catalogue

![Figure 21/3: Options dialogue window: Product Catalogue tab](image)

Retrieve additional data when inserting products

If this option is active, FluidDraw will attempt to obtain additional product properties via an Internet connection.

⚠ When this is done, no individual or personal data is transferred to Festo or third parties.

Products

Specifies which products from the Festo product catalogue are to be used, for example Europe or Festo worldwide.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default period for shopping baskets</td>
<td>From Festo Shopping Basket can be used to import shopping baskets in FluidDraw. You define here what period is set as the filter by default. You can also change this period later on using the insertion dialogue.</td>
</tr>
<tr>
<td>Language</td>
<td>Defines the language used for the Festo product catalogue.</td>
</tr>
<tr>
<td>Insert symbols with type attribute</td>
<td>If this option is selected, when components are inserted from the Festo product catalogue with the circuit symbol, a text box is automatically inserted with a link to the attribute with the type designation of the product.</td>
</tr>
<tr>
<td>Insert FluidDraw symbol instead of catalogue symbol</td>
<td>There are different symbol representations for some products. If you insert anything from the Festo product catalogue you can choose which symbol you want to apply. You define the default setting with this option.</td>
</tr>
<tr>
<td>Insert legacy valve terminal symbols</td>
<td>FluidDraw can automatically convert order codes of some frequently used valve terminals into the corresponding symbol representation. You can select here whether you prefer the new horizontal representation or the vertical representation of the previous version of FluidDraw.</td>
</tr>
<tr>
<td>Text fields for accessories</td>
<td>If you insert accessories without symbol representation, texts appear with the type designation of the products. You can limit the number of text boxes inserted here.</td>
</tr>
</tbody>
</table>
21.4 Folder Locations

Figure 21/4: *Options* dialogue window: *Folder Locations* tab

<table>
<thead>
<tr>
<th>Category</th>
<th>Default Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Templates</td>
<td>This is the default path for your own project templates.</td>
</tr>
<tr>
<td>Project Files</td>
<td>This is the default path for opening and saving projects.</td>
</tr>
<tr>
<td>Library Files</td>
<td>This is the default path for opening and saving library files.</td>
</tr>
<tr>
<td>Drawing Frames</td>
<td>This is the default path for opening and saving drawing frames.</td>
</tr>
<tr>
<td>Database Files</td>
<td>This is the default path for opening and saving database files.</td>
</tr>
<tr>
<td>User defined reports</td>
<td>This is the default path for your own reports, such as parts lists, terminal diagrams, wiring lists, etc.</td>
</tr>
</tbody>
</table>
This is the default path for opening and saving circuits.

21.5 Translation Table

![Translation Table](image)

Figure 21/5: Options dialogue window: Translation Table tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation Table</td>
<td>Defines the translation table to be used.</td>
</tr>
<tr>
<td>Translation Language</td>
<td>Defines the language from the selected translation table to be used.</td>
</tr>
</tbody>
</table>
21.6 Connector Links

![Options dialogue window: Connector Links tab](image)

**21.6.1 Connect Automatically**

FluidDraw supports the automatic connection of connectors. The following settings define which connectors should be automatically created.

- **Pneumatic – Horizontal**: Pneumatic connectors that are on one horizontal line are automatically connected when a symbol is inserted or moved.
- **Pneumatic – Vertical**: Pneumatic connectors that are on one vertical line are automatically connected when a symbol is inserted or moved.
- **Electric – Horizontal**: Electric connectors that are on one horizontal line are automatically connected when a symbol is inserted or moved.
- **Electric – Vertical**: Electric connectors that are on one vertical line are automatically connected when a symbol is inserted or moved.
- **GRAFCET – Horizontal**: Connectors of GRAFCET objects that are on one horizontal line are automatically connected when a symbol is inserted or moved.
- **GRAFCET – Vertical**: Connectors of GRAFCET objects that are on one vertical line are automatically connected when a symbol is inserted or moved.
Only connectors of the same type can be connected if this option is active. For example a line from an electric connector to a pneumatic connector cannot be created in this case.
21.7 Warnings

![Warnings]

Figure 21/7: Options dialogue window: Warnings tab

21.7.1 Warnings

Enable Background Check

All circuits are checked during editing if this option is active. Only the criteria that would lead to the warnings specified under “Show Warnings” are checked. Objects that caused an error are highlighted in red in the circuit. If this option is not active then the check
must be triggered manually using the [Page – Check Drawing] menu.

**Drawing Tools**  
Objects that result in a warning are highlighted in red. If you also activate this option the reason is displayed in an information window if you move the mouse over the relevant object.

### 21.7.2 Show Warnings

Different types of warnings that FluidDraw should or should not issue can be activated and deactivated here. These warnings include "Duplicated identification labels" and "Superimposed objects".
21.8 Appearance

![Options dialogue window: Appearance tab](image)

Figure 21/8: *Options* dialogue window: *Appearance* tab

21.8.1 Override Default Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Defines the default font used to insert text.</td>
</tr>
<tr>
<td>Pen width</td>
<td>Defines the default line width used to insert drawing elements.</td>
</tr>
</tbody>
</table>

21.8.2 View

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Snap Radius</td>
<td>To simplify the connection of connectors, FluidDraw draws a small circle around the connector points of the circuit symbols. Deselect</td>
</tr>
</tbody>
</table>

© Festo AG & Co. KG • Art Systems GmbH • FluidDraw
21.8.3 Zoom

Mouse wheel | Defines the direction and the additional key to be used to zoom in and out using the mouse wheel.

21.8.4 Grid

To display the grid press the Show Grid button in the Drawing Tools group on the View ribbon page.

Grid Width | You set the width of the grid here. In addition to values such as “mm” you can also specify the relative basic unit of length “M”.

Style | You set the grid style here.

21.9 Designation Conventions

This tab is used to define the default settings for the designation conventions. You can find further information under Equipment identifications and designation conventions.

The settings are only applied to newly created projects or circuits. They have no effect on existing objects.
21.9.1 Default Settings

- **Automatically frame identification for free input**
  - Defines that the identifications are framed in the event of a free input without using the designation conventions.

- **Enumerate Automatically**
  - Defines that the identifications of newly inserted symbols are automatically numbered.

- **Consider All Project Files**
  - All project files and not just the current circuit are taken into account for numbering if this option is active.
21.9.2 User Defined

Frame Identification  Defines that the identifications are framed.

21.10 Cross Reference Representation

Figure 21/10: Options dialogue window: Cross Reference Representation tab

This tab is used to define the default settings for the cross-reference representation. You can find further information under Cross-reference representation.

The settings are only applied to newly created projects or circuits. They have no effect on existing objects.
21.10.1 Default Settings

Example
Illustrates the effects of the settings using an example.

Reset
Resets the settings to the settings defined in FluidDraw.
21.11 Text Sizes

This tab defines the font sizes to be used for objects newly inserted into the circuit diagram.

The defined fonts and font sizes are shown here according to an example.
21.12 Dimension

This tab is used to define the default settings for the dimensions. You can find further information under Dimension.

Figure 21/12: Options dialogue window: Dimension tab

All settings are only applied to newly created dimensions. They have no effect on existing dimensions in the circuit.
21.12.1 Default Settings

Layer
Defines the drawing layer where the newly created dimensions are placed.

Automatic Dimensioning
Activates or deactivates automatic dimensioning. If this option is activated then the displayed dimensioning is automatically adapted if the dimensions are scaled.

Unit
Defines the unit to be used for the dimension.

Show Unit
Defines whether the unit should be displayed.

Decimals
Defines the number of decimal places.

Scale Factor
Determines the factor with which the real length is multiplied for the displayed value. This is necessary if you are creating a drawing with a scale other than 1:1.

21.12.2 Preview

The default settings of the dimensions are shown here using an example.

21.13 Drawing Layers

This tab is used to define the default settings of the drawing layers.

The settings are only applied to newly created projects or circuits. The settings have no effect on existing pages.
Figure 21/13: Options dialogue window: Drawing Layers tab

Default Settings

Resets the settings of the drawing layers to the default values.
Chapter 22

22.1 Quick access toolbar

The quick access bar provides some functions that are frequently used and that are therefore available regardless of the currently selected ribbon page.

- Save File
- Undo
- Redo
- Check Drawing
- Connect Automatically

22.2 File
New / Page
Opens a new window for creating a new page that is added to the current project.

New / Project
Opens the dialogue window for creating a new project.

New / Project from template...
Opens the dialogue window for creating a new project that is based on a project template.

Open...
Opens the dialogue window for selecting an existing project or a circuit file. The most recently opened files can be selected for opening from a list.

Save File
Saves the active project.

Save All
Saves all open projects.

Save Project As...
Saves the active project under a new name on the data storage medium. With external file references you must bear in mind that changes to these files affect all projects containing them.
Print...  
Opens the FluidDraw dialogue window for setting the print options for the active project.

Close  
Closes the active project.

Import/Export  

DXF Import...  
Opens the dialogue window for selecting a stored DXF file. The selected file is then converted into a FluidDraw drawing. The original file remains unchanged.

Export...  
Exports the circuit drawing of the active window as BMP, JPG, GIF, PNG, TIF, WMF, DXF, PDF or SVG file to the data storage medium.

Save as Component Library...  
Saves the active project as a library. A new library symbol is then created for every circuit. The project name is applied as the name of the new library with the file extension lib.

22.3 Home  

Clipboard  

Paste  
Inserts the objects from the clipboard into the active circuit.
Copy
Copies the selected objects to the clipboard.

Cut
Deletes the selected objects and inserts them in the clipboard.

Select Properties...
If the circuit symbol is selected, opens the Properties dialogue window for entering the component properties. It can also be used to apply the attributes from the Festo product catalogue.

If you highlight the component connector, the Connector dialogue window opens for entering the connector properties.

When a line segment is highlighted a dialogue window opens enabling you to enter the line properties.

If several objects are highlighted, a dialogue window appears with the different and common properties of the highlighted objects.

Select All
Highlights all objects of the active circuit.

Delete
Deletes the highlighted objects of the active circuit.

Delete Connector
Deletes the highlighted component connector.

Group
**Group**

Groups the highlighted objects.

**Create Macro Object**

Creates a macro object from the highlighted objects.

**Ungroup/Break Off**

Deletes the highlighted groups or macro objects.

**Create Cross-reference**

Creates a cross-reference.

**Rotate**

**Right**

Rotates the highlighted objects 90 degrees clockwise. Grouped objects are rotated around the centre of the group rectangle.

**Left**

Rotates the highlighted objects 90 degrees anti-clockwise. Grouped objects are rotated around the centre of the group rectangle.

**Mirror**

**Horizontally**

Mirrors the highlighted objects horizontally. Grouped objects are mirrored at the axis of the group rectangle.
Vertically

Mirrors the highlighted objects vertically. Grouped objects are mirrored at the axis of the group rectangle.

Align

The buttons of this group can be used to align the highlighted objects to each other.

Drawing Layers

Highlighted objects can be assigned to the specified drawing layer. If no objects are highlighted, the specified drawing layer is the standard layer.

Zoom

Fit to Window

Selects the zoom factor that allows the entire circuit drawing to fit in the window.

Standard Size

Shows the circuit drawing in its original size.

View Detail

Defines the new view by drawing a rectangle with the left mouse button pressed.

Previous View

Shows the circuit drawing in the last view. Activate this function repeatedly to switch back and forth between the views last set.
### 22.4 Insert

**Object**

- **Text**
  
  Inserts a text at the mouse position.

- **Picture**
  
  Inserts an image file at the mouse position.

**Draw**

- **Line**
  
  Draws a line by defining two end points.

- **Rectangle**
  
  Draws a rectangle by defining two diagonally opposite corner points.

- **Circle**
  
  Draws a circle by defining the centre and the radius.

- **Ellipse**
  
  Draws an ellipse by defining a centre and two axially parallel radii.
Poly Line

Draws a polyline by defining the vertices with successive mouse clicks. The drawing operation can be cancelled by pressing the Esc key or by clicking the right mouse button. The last vertex must be set with a double-click.

Symbol

Find Symbol Description...

Opens the search dialogue for selecting a symbol by its appearance or by its description.

From Festo Catalogue...

Opens the Festo product catalogue for selecting a component via the product properties.

From Custom Database

Opens a dialogue window similar to the Festo product catalogue for selecting a component via the product properties. It is not the database of the Festo product catalogue that is used, however, but the selected user database.

Collection

From Festo Shopping Basket

From Festo Shopping Basket / Online (Internet access required)...

Opens the dialogue for applying components from an existing online shopping basket.
From Festo Shopping Basket / Offline (from local product catalogue)...
Opens the dialogue for applying components from an existing offline shopping basket.

From File...
Opens the dialogue window for selecting an existing text file in CSV format that was created by export from the Festo product catalogue.

**Link**

Conduction Line...
Opens a dialogue window that defines the settings for one or more conduction lines that are to be inserted in the circuit diagram after the dialogue window is confirmed.

Interruption/Potential...
Adds an interruption or an electric potential to the circuit diagram.

Define Connector...
Creates a new component connector the next time you use the left mouse button to click a circuit symbol.

**Electrics**

Terminal
Inserts a terminal in the circuit diagram.

Multiple Terminals...
Inserts multiple terminals in the circuit diagram.
Cable

Inserts a cable in the circuit diagram.

List

Table

Inserts a fixed table in the page.

Report

Inserts a report in the page.

Dimension

Using the buttons of this group, you can insert a dimensioning symbol in the active page.

22.5 Select

You can use these options to set selection filters.

Options

Active Drawing Layer Only

The selection filters only include the currently selected drawing layer.

Protect connector texts

Prevents any inadvertent displacement of the connector texts.

Object Types
Select the desired **object types** here.

- All Objects
- Main Components
- Sub components
- Connection Lines
- Component Designations
- Line Designations
- Connector Designations
- Cable Designations
- Text Objects
Defines the drawing layer to which the filters apply when the **Active Drawing Layer Only** option is selected.

### 22.6 Edit

#### Edit

**Enable Rotate**
Activates and deactivates “Rotation permitted” mode that allows you to **rotate symbols** using the mouse pointer.

**Enable Scale**
Activates and deactivates “Scaling permitted” mode that allows you to **scale symbols** using the mouse pointer.

**Edit Poly Line**
Activates or deactivates “Edit Polyline” mode that allows you to **edit a polyline**.

**Edit List/Table**
Activates or deactivates “Edit Table” mode that allows you to **edit a table**.

**Connect Automatically**
FluidDraw supports the automatic connection of connectors. You can temporarily activate or deactivate the function with this option.

#### Snap
Defines the options for the **object snap**.
Snap to End Point

Snap to Mid Point

Snap to Intersection

Snap to Centre

Snap to Grid

Snap to Connector

**Color**

Defines the drawing colour. This setting applies both to future drawing operations, therefore also (on request) to the currently marked objects.

**Line Style**

Defines the line style. This setting applies both to future drawing operations, therefore also (on request) to the currently marked objects.
Line Width
Defines the line width. This setting applies both to future drawing operations, therefore also (on request) to the currently marked objects.

Start Cap
Defines how the beginning of the line is displayed. This setting applies both to future drawing operations, therefore also (on request) to the currently marked objects.

End Cap
Defines how the end of the line is displayed. This setting applies both to future drawing operations, therefore also (on request) to the currently marked objects.

T-Node
Defines how the T-distributor is displayed. This setting applies both to future drawing operations, therefore also (on request) to the currently marked objects.

22.7 View

Drawing Tools
Show Page Borders
Shows or hides the page borders in the form of a red rectangle. This rectangle represents the limits of the paper format set using the [Drawing Size...] menu. You use the print preview to decide whether and how the drawing is distributed over several pages.
Show Grid

Shows a **background grid** in the active circuit window. The grid settings can be made on the \textit{Tools} tab under the \textit{Options...} menu item in the \textit{General} menu.

Show Rulers

Shows or hides the rulers in the active circuit window.

Show Page Dividers

Shows or hides the **page dividers** in columns and rows. Cross-references can refer to the column and row containing a symbol. The position and number of the columns and rows can be interactively defined via the page dividers shown.

**Show Connector Descriptions**

Shows or hides the connector descriptions. The \textit{Display} option can be selected in the properties dialogue window for the connectors. This option is only evaluated if “\textit{Individual}” was selected.

**None**

Hides all connector descriptions regardless of the settings at the connectors.

**All**

Shows all connector descriptions regardless of the settings at the connectors.

**Individual**

Shows only the connector descriptions for those connectors with the \textit{Display} option activated.

**Show Terminal Directions**
Shows or hides the direction arrows at the terminals. The arrow head points at the control cabinet.

**None**
Hides all arrows regardless of the settings at the terminals.

**Individual**
Shows only the arrows for those terminals with the *Show Direction* option activated.

**All**
Shows all arrows regardless of the settings at the terminals.

**GRAFCET**
Defines whether for GRAFCET elements the formula is to be preferably displayed or a text description.

**Use settings of individual elements**

**Description, if available**

**Always show formula**

**Display Contact Images**
Shows or hides the contact images.

**Window**
**New Window**

Opens a window with an additional view of the active window.

**Navigation Pane**

Opens an overview window with a miniature view of the entire circuit drawing. The currently visible part of the active window is displayed as a white area. The non-visible part of the drawing is on a grey background. By creating a rectangle with the mouse pointer in the overview window, you can determine a section of the circuit drawing that is displayed in the active window. Simply click in the overview window with the left mouse button to move the visible area while maintaining the zoom factor.

**Cascade**

Cascades the windows.

**Tile Horizontally**

Arranges the windows below each other.

**Tile Vertically**

Arranges the windows next to each other.

**Close All**

Closes all open windows.

### 22.8 Page

**Drawing**
Check Drawing

Checks the active circuit drawing for drawing errors.

Numbering

Renumber Designations...

Opens a dialogue window enabling you to interactively renumber the symbol identifications.

Manage

Manage Terminal Strips...

Opens a dialogue window enabling you to manage the terminal strips in the circuit.

Manage Cables...

Opens a dialogue window enabling you to manage the cable objects in the circuit.

Properties

Drawing Size...

Opens a dialogue window enabling you to set the size of the drawing.

Drawing Layers...

Opens a Drawing Layers dialogue window enabling you to set the properties of the drawing layers.

Language...

Opens a dialogue window enabling you to set the circuit language.
22.9 Project

**Page**

- **Import Current Page**
  Adds the active window to the file list of the open project.

- **Delete Current Page**
  Removes the active window from the file list of the open project.

**Numbering**

- **Renumber Designations...**
  Opens a dialogue window enabling you to interactively renumber the symbol identifications.

- **Renumber Pages...**
  Opens a dialogue for renumbering the project pages.

**Manage**

- **Manage Terminal Strips...**
  Opens a dialogue window enabling you to manage the terminal strips in the project.
Manage Cables...
Opens a dialogue window enabling you to manage the cable objects in the project.

Manage Cross References...
Opens a dialogue window enabling you to manage the cross-references in the project.

Manage Global Objects...
Opens a dialogue window enabling you to manage the global objects.

Properties

Drawing Layers...
Opens a Drawing Layers dialogue window enabling you to set the properties of the drawing layers.

Language...
Opens a dialogue window enabling you to set the project language.

Properties...
Opens the dialogue window for entering the project properties.

22.10 Library

Add
Create New Library...  
Creates a new library.

Add Existing Library...  
Opens the dialogue window for selecting a stored library file with the file extension .lib. The library stored in the file is then added to the library window.

Add Existing Symbol Folder...  
Opens the dialogue window for selecting an existing folder. The entire contents of the selected folder including all circuit symbols and sub-folders are displayed as a library.

Active Library  
Sort Current Library Alphabetically  
Sorts the contents of the active library alphabetically. This function is only available for libraries created by the user. Write-protected libraries are automatically sorted and cannot be resorted by the user.

Rename Active Library...  
Opens a dialogue window for entering the name of the library. This function is only available for libraries created by the user. In write-protected libraries, the name of the folder is displayed on the tab.

Close Current Library  
Removes the active library from the list in the library window. The library file is not deleted by this action and can be opened again using the Library menu and the Add Existing Library... menu item.

Identification
Two-letter designations

This is for defining if the reference designations of the components from the standard libraries are to be proposed with one or two reference code letters. Two letters are normally used according to newer standards.

Manage reference designations...

If a symbol does not have a default identification in the library or if you want to change it, you can assign an individual identification to every symbol. This dialogue provides you with an overview of all user IDs.

22.11 Manage

Sources

Manage templates...
Opens a dialogue window for managing templates.

Custom Product Databases...
Opens a dialogue window for managing the product databases.

Translation Tables...
Opens a dialogue window for managing translation tables.

Options

Options...
Opens the dialogue window with program settings, file paths and language options.
Restore Defaults...
Resets the program settings to the default values. This enables you to undo unintentional settings made.

Note: Use this function if you feel that FluidDraw is behaving unexpectedly or files and windows appear to have suddenly disappeared.

Licences

Licence Information...
Opens the dialogue window with information on the licence currently used.

Manage Licences...
Opens the Online licence manager where the licences that belong to a ticket number can be managed.

22.12 Help

User's Guide

Contents
Displays the contents of the FluidDraw help pages.

Index
Displays the index of the FluidDraw help pages.

Search
Displays the search dialogue of the FluidDraw help pages.
Version

Check for updates...
As soon as there is an Internet connection you can use this menu item to trigger the search for a new FluidDraw version.

About...
Displays the FluidDraw programme information.
Chapter 23

Using the new “Adjust ribbon” dialogue, the new user interface of FluidDraw can be adjusted completely to the users individual preferences. Besides adjusting the default configuration, all new user configurations can be created, exported and imported. Changes to the shortcuts are also possible using the dialogue.

You can access the configuration dialogue via the quick access at the top of the window.
Figure 23/1: “Adjust ribbon” in the quick access bar

Figure 23/2: Adjust Ribbon Dialogue

FluidDraw allows almost complete customisation to the ribbon. This includes deleting and customising predefined default pages.
and groups. Every page can be deleted to start with an empty ribbon, which can be built from scratch to fit the users needs.

### 23.1 The Ribbon

The new ribbon interface in FluidDraw P6 works similar to ribbon interfaces from other common software. It is divided in pages, groups and commands, the latter of which also able to contain subcommands. In the tree view this results in a maximum of 4 levels. On the top level, the pages are housed, which contain the groups housing the commands.
23.2 Tree view and Command view

By default, the dialogue opens up showing in tree view mode, which displays the ribbons default configuration on the left side and the user configuration on the right side. Upon opening the dialogue for the first time, both sides are identical.
The tree view mode can be changed to the command view mode. In command view mode, all commands are listed alphabetically on the left side, providing easy access to select the desired command.

23.3 Adding Elements

You can edit the user configuration using the mouse or the buttons inside the dialogue. To add an element to the configuration, first select the position inside the right tree view, where you want to insert the new element.
New elements are inserted behind the selected element on the right side. On inserting a page while e.g. a command is selected, the page is added after the page housing the selected command.

Afterwards, select the element, which is to be inserted, in the left tree view or command view. The “Add” button is then shown as active. By pressing the button or using the context menu when right clicking the element to insert, the selected element is copied into the right tree view.

Some elements, like separators or mutual exclusive commands, cannot be added using the Add button. New separators can be added using “New...” - “Separator”. Mutual exclusive commands, like “View” – “Show Terminal Directions” – “None”, “Individual”, “All” cannot be added on their own, but only the whole group “Show Terminal Directions” can be added.

You can also select elements from the left-hand tree by mouse and drag them over into the right tree to copy them. An insert point is shown for valid operations while dragging the element. Release the mouse to perform the operation.
Figure 23/5: Drag&Drop Operation
23.4 Removing Elements

As previously mentioned in the introduction, all predefined elements can be removed from the user configuration. You can delete any element by either selecting it in the right tree and clicking the “Remove” button or right clicking the element and selecting the “Remove” command from the context menu.
23.5 Moving Elements

The elements in the right-hand tree can be moved and arranged. You can use either the buttons “Up” and “Down” or the respective entries in the context menu. Elements always move on their own level, so groups will always be child elements of pages and may jump to the next or previous page accordingly. Additionally, drag&drop is also available to move elements with the preview showing like described in Adding Elements.

23.6 Creating new Elements

Using the “New...” button, you can create new pages, groups and separators. After selecting the position in the right-hand tree to insert the new element at, it is inserted by clicking the respective entry in the “New” menu.

Separators can only be inserted when a command is selected.

New pages are initially named “New Page” whereas new groups are initially named “New Group”. Using the “Rename...” function, you can of course change the names to your liking. Being user defined elements, the names will be shown in bold font. Separators are added by using the “New...” – “Separator” button. They get inserted after the selected command as well and will be deleted on saving the configuration, if they are the last element inside a group.
23.7 Renaming Elements
Click the “Rename...” button underneath the right-hand tree to rename any element but separators. Like user created elements, renamed elements are shown in **bold font**.
Besides user created new pages and groups, all renamed elements can be reverted to their original name. Right click the respective element and select “Revert name to ‘#’” from the context menu.

Elements with customised names, showing up in bold font, won’t be translated on switching the language. Resetting an elements name will result in the element being translated again.

23.8 Large / Small Symbol

To highlight commands that are more important or to allow for a better layout, the size of the commands in the ribbon can be changed. Use the check box “Large Symbol” beneath the right-
hand tree to switch between large and small display of the command. On selecting the command, the check box gets checked accordingly. If checked, the symbol is displayed as a large symbol (Large Symbol is displayed behind the command name in the tree as well).

Not all elements support the large symbol appearance. This includes all commands displaying a check box or radio button themselves as well as separators.

### 23.9 Reset to default settings

Using the “Reset” button on the right side beneath the right-hand tree, all changes can be reverted and the default configuration is restored.

Restoring the default configuration also reverts all shortcuts to their default assignment.

### 23.10 Import / Export

Customised configurations can be exported and imported via the “Adjust ribbon” dialogue. This way, different configurations can be designed to fit individual scenarios that can easily be exchanged. Exchanging customised configurations with other users is also possible. Ribbon configurations are saved with the file extension PathEx-tFдр.

On importing a ribbon configuration, the currently used configuration is discarded and can only be restored by cancelling the dialogue. Export your current configuration before importing another configuration, if you plan to use the current configuration again later.
23.11 Assign shortcuts

Using the “Assign Shortcut...” button, you can access the configuration dialogue for shortcuts. The dialogue allows for any assignment of shortcuts to single commands. All currently assigned shortcuts can also be viewed in the dialogue. Each row in the command list shows the commands name, the default position in the ribbon as well as the current shortcut.
23.11.1 Assign new Shortcut

First, select the command from the list you wish to customise and select the shortcut text field afterwards. Shortcuts support an arbitrary combination of the modifier keys \texttt{Shift}, \texttt{Ctrl} and \texttt{Alt} and any regular key. You can also decide not to use the modifier keys at all and directly assign a key. After selecting the text field, press the shortcut you want to use on the keyboard. Assign the showed shortcut by clicking the “Assign” button.

If the shortcut is already assigned to another command, a red warning message appears below the text-field. Assigning the shortcut will have to be confirmed in an additional dialogue then. If a shortcut from the text field is not assigned on changing the command, a prompt will ask if the shortcut should be discarded.
### Edit Shortcuts

<table>
<thead>
<tr>
<th>Command</th>
<th>Command path</th>
<th>Current Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always show formula</td>
<td>View : GRAFCET</td>
<td></td>
</tr>
<tr>
<td>Angular</td>
<td>Insert : Dimension</td>
<td></td>
</tr>
<tr>
<td>Attribute Links</td>
<td>Select : Object Types</td>
<td></td>
</tr>
<tr>
<td>Bottom</td>
<td>Home : Align : Vertical</td>
<td></td>
</tr>
<tr>
<td>Cable</td>
<td>Insert : Electrics</td>
<td></td>
</tr>
<tr>
<td>Cable Designations</td>
<td>Select : Object Types</td>
<td></td>
</tr>
<tr>
<td>Cables</td>
<td>Select : Object Types</td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td>View : Window</td>
<td></td>
</tr>
<tr>
<td>Check Drawing</td>
<td>Page : Drawing</td>
<td>F6</td>
</tr>
<tr>
<td>Check for updates</td>
<td>Help : Version</td>
<td></td>
</tr>
<tr>
<td>Circle</td>
<td>Insert : Draw</td>
<td></td>
</tr>
<tr>
<td>Circles/Ellipses</td>
<td>Select : Object Types</td>
<td></td>
</tr>
<tr>
<td>Close All</td>
<td>View : Window</td>
<td></td>
</tr>
<tr>
<td>Close Current Library</td>
<td>Library : Active Library</td>
<td></td>
</tr>
<tr>
<td>Component Designations</td>
<td>Select : Object Types</td>
<td></td>
</tr>
<tr>
<td>Conduction Line</td>
<td>Insert : Link</td>
<td></td>
</tr>
<tr>
<td>Connect Automatically</td>
<td>Edit : Edit</td>
<td>A</td>
</tr>
<tr>
<td>Connection Lines</td>
<td>Select : Object Types</td>
<td></td>
</tr>
<tr>
<td>Connector Designations</td>
<td>Select : Object Types</td>
<td></td>
</tr>
</tbody>
</table>

- **Command**: Check for updates
- **Current Shortcut**: None
- **New Shortcut**: A

*This shortcut is already assigned to 'Check Drawing'.
23.11.2 Remove Shortcut

If a command with an assigned shortcut is selected, you can remove the shortcut by clicking the “Remove” button next to the shortcut. Removing a shortcut this way will not bring up a prompt to confirm.
If you want to delete all assigned shortcuts at once, use the “Remove all shortcuts” button. You will have to confirm the operation in a prompt again.

23.11.3 Restore shortcuts

Using the “Reset” button the default assignment for shortcuts can be restored. In contrast to the Adjust ribbon dialogues “Reset” button, this will only reset all shortcuts, the ribbon configuration is left unchanged.
### Index

**A**
- Alignment ........................................... 87
- Alignment line ..................................... 117
- Attribute link ...................................... 199
- Auxiliary line ...................................... 117

**B**
- Backup copies ...................................... 325
- Blanking plug ....................................... 79
- BMP
  - export ............................................ 315

**C**
- Cable .................................................. 290, 293
  - manage ............................................ 293
- Cable list .......................................... 295
- Cable map .......................................... 294
- Check
  - drawing ........................................... 150
- Circle ............................................... 139
- Circuit
  - check ............................................... 150
  - input .............................................. 312
  - node ............................................... 208
  - open ............................................... 208
  - output ............................................ 312
  - print .............................................. 312
  - properties ....................................... 208
- Component attributes ............................ 181
- Compression files ................................ 325
- Conduction lines ................................ 286
- Configurable cylinders ......................... 84
- Configurable directional control valves ...... 82
- Connector
  - connect .......................................... 69
  - define ............................................ 81
  - delete ............................................ 82
  - identification ................................... 79
  - properties ....................................... 79
  - seal ............................................... 79
<table>
<thead>
<tr>
<th>Connector Labels</th>
<th>________________________________________________________________________</th>
<th>194</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>________________________________________________________________________</td>
<td>191</td>
</tr>
<tr>
<td>Contact image</td>
<td>________________________________________________________________________</td>
<td>311</td>
</tr>
<tr>
<td>Control line</td>
<td>________________________________________________________________________</td>
<td>77</td>
</tr>
<tr>
<td>Cross Reference Representation</td>
<td>____________________________________________</td>
<td>128</td>
</tr>
<tr>
<td>Cross-reference create from symbol</td>
<td>____________________________________________</td>
<td>126</td>
</tr>
<tr>
<td>Cylinder configure</td>
<td>________________________________________________________________________</td>
<td>85</td>
</tr>
<tr>
<td>Cylinder editor</td>
<td>________________________________________________________________________</td>
<td>85</td>
</tr>
<tr>
<td>D</td>
<td>________________________________________________________________________</td>
<td></td>
</tr>
<tr>
<td>Defining page dividers</td>
<td>____________________________________________</td>
<td>113</td>
</tr>
<tr>
<td>Delete</td>
<td>________________________________________________________________________</td>
<td></td>
</tr>
<tr>
<td>line</td>
<td>________________________________________________________________________</td>
<td>79</td>
</tr>
<tr>
<td>Designation conventions</td>
<td>____________________________________________</td>
<td>175</td>
</tr>
<tr>
<td>Designations</td>
<td>________________________________________________________________________</td>
<td></td>
</tr>
<tr>
<td>numbering</td>
<td>____________________________________________</td>
<td>177</td>
</tr>
<tr>
<td>Dialogue</td>
<td>________________________________________________________________________</td>
<td></td>
</tr>
<tr>
<td>cable</td>
<td>____________________________________________</td>
<td>290, 293</td>
</tr>
<tr>
<td>circle</td>
<td>____________________________________________</td>
<td>140</td>
</tr>
<tr>
<td>circuit</td>
<td>____________________________________________</td>
<td>46</td>
</tr>
<tr>
<td>component</td>
<td>____________________________________________</td>
<td>182</td>
</tr>
<tr>
<td>connector</td>
<td>____________________________________________</td>
<td>80</td>
</tr>
<tr>
<td>contact</td>
<td>____________________________________________</td>
<td>191</td>
</tr>
<tr>
<td>Cross Reference Representation</td>
<td>____________________________________________</td>
<td>128</td>
</tr>
<tr>
<td>diagram properties</td>
<td>____________________________________________</td>
<td>274</td>
</tr>
<tr>
<td>dimension</td>
<td>____________________________________________</td>
<td>173</td>
</tr>
<tr>
<td>drawing area</td>
<td>____________________________________________</td>
<td>277</td>
</tr>
<tr>
<td>drawing frame</td>
<td>____________________________________________</td>
<td>92, 93</td>
</tr>
<tr>
<td>drawing layers</td>
<td>____________________________________________</td>
<td>120</td>
</tr>
<tr>
<td>drawing size</td>
<td>____________________________________________</td>
<td>46</td>
</tr>
<tr>
<td>electric line</td>
<td>____________________________________________</td>
<td>78</td>
</tr>
<tr>
<td>electric terminal</td>
<td>____________________________________________</td>
<td>297</td>
</tr>
<tr>
<td>ellipse</td>
<td>____________________________________________</td>
<td>142</td>
</tr>
<tr>
<td>Functional diagram</td>
<td>____________________________________________</td>
<td>265</td>
</tr>
<tr>
<td>image</td>
<td>____________________________________________</td>
<td>134</td>
</tr>
<tr>
<td>line</td>
<td>____________________________________________</td>
<td>78, 79, 136</td>
</tr>
<tr>
<td>line chain</td>
<td>____________________________________________</td>
<td>144</td>
</tr>
<tr>
<td>line options</td>
<td>____________________________________________</td>
<td>280</td>
</tr>
<tr>
<td>Manage Cross References...</td>
<td>____________________________________________</td>
<td>129</td>
</tr>
<tr>
<td>object browser</td>
<td>________________________________________________________________________</td>
<td></td>
</tr>
<tr>
<td>filter</td>
<td>____________________________________________</td>
<td>155</td>
</tr>
<tr>
<td>page</td>
<td>____________________________________________</td>
<td>216</td>
</tr>
</tbody>
</table>
Graphical element ................................................................. 130
Grid .......................................................................................... 117
Grid options ............................................................................... 335
Group ....................................................................................... 86
delete ....................................................................................... 87
form ........................................................................................... 86

H
Hatching .................................................................................. 131
Hide
  automatically ........................................................................... 59
Hide window ............................................................................... 59

I
ID code ....................................................................................... 66, 67
Image ......................................................................................... 133
Image file .................................................................................... 133
Insert
  symbol ..................................................................................... 52
Inserting T-distributors ............................................................ 72
Interruption ................................................................................. 147

J
JPG
  export ....................................................................................... 315

L
LabelTranslationTable ............................................................. 329
Language text
  search ..................................................................................... 165
Layer .......................................................................................... 119
Libraries ..................................................................................... 51
Library ......................................................................................... 54, 59
Library window .......................................................................... 59
Line ............................................................................................ 135
delete ....................................................................................... 79
electric ....................................................................................... 145
intersect ..................................................................................... 121
move .......................................................................................... 74
pneumatic .................................................................................... 145
Line chain .................................................. 143
Line jump .................................................. 121
Line segment ............................................. 74
Line type
define .................................................. 77
Link ........................................................... 199
Links .......................................................... 307
Macro object
create ..................................................... 86
delete ....................................................... 87
Manage Cross References... ............................. 129
Mirror ....................................................... 87, 89
Object browser ............................................ 59
tree view ................................................... 153
line ........................................................... 154
Object snap .................................................. 118
Online shop .................................................. 63
Options
Appearance .................................................. 334
Connector Links ........................................... 330
Cross Reference Representation ......................... 337
Designation Conventions ................................ 335
Dimension ................................................... 340
Drawing Layers ............................................ 341
Folder Locations .......................................... 328
General ....................................................... 322
Grid ........................................................... 335
Save .......................................................... 325
Text Sizes ................................................... 339
Translation Table .......................................... 329
Warnings .................................................... 332
Order code ................................................... 66, 67
Page
node .......................................................... 208
open .......................................................... 208
properties ................................................... 216
Page dividers .......................................................... 220
Parts list
  print ........................................................................ 312
PDF
  export ..................................................................... 315
Pneumatic line .......................................................... 145
PNG
  export ..................................................................... 315
Polygon chain ............................................................ 143
Polyline ................................................................. 143
Potential ................................................................. 147
Potentials ............................................................... 286
Predefined attributes ................................................ 219
Predefined placeholders ............................................ 219
Predefined variables ................................................ 219
Print ........................................................................ 312
Product catalogue ..................................................... 61
Project ...................................................................... 58, 59, 207
  add ....................................................................... 208
  node ..................................................................... 208
  print ..................................................................... 312
  properties ................................................................ 216
  remove .................................................................... 208
XML file ................................................................... 58
Project window ......................................................... 59
Properties ................................................................... 216
Properties dialogue .................................................... 46
  cable symbol ........................................................... 290
  circle .................................................................... 140
  component ............................................................. 182
  connector ............................................................... 80
  contact ................................................................... 191
Cross Reference Representation ................................ 128
cylinder ................................................................... 85
dimension .................................................................. 173
directional control valves ........................................... 83
drawing layers .......................................................... 120
electric line ............................................................. 78
ellipse ...................................................................... 142
image ...................................................................... 134
line ........................................................................ 78, 79, 136
line chain ............................................................... 144
Manage Cross References ......................................... 129
page ........................................................................ 216
pneumatic line .......................................................... 78
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show window</td>
<td>59</td>
</tr>
<tr>
<td>Silencer</td>
<td>79</td>
</tr>
<tr>
<td>Snap</td>
<td>118</td>
</tr>
<tr>
<td>Storage locations</td>
<td>328</td>
</tr>
<tr>
<td>SVG</td>
<td></td>
</tr>
<tr>
<td>export</td>
<td>315</td>
</tr>
<tr>
<td>Symbol</td>
<td></td>
</tr>
<tr>
<td>align</td>
<td>87</td>
</tr>
<tr>
<td>group</td>
<td>86</td>
</tr>
<tr>
<td>insert</td>
<td>61</td>
</tr>
<tr>
<td>mirror</td>
<td>87, 89</td>
</tr>
<tr>
<td>move</td>
<td>61</td>
</tr>
<tr>
<td>rotate</td>
<td>88</td>
</tr>
<tr>
<td>scale</td>
<td>89</td>
</tr>
<tr>
<td>search</td>
<td>53</td>
</tr>
<tr>
<td>Symbol library</td>
<td>54</td>
</tr>
<tr>
<td>Symbols</td>
<td>51</td>
</tr>
<tr>
<td>T</td>
<td></td>
</tr>
<tr>
<td>T-distributor</td>
<td></td>
</tr>
<tr>
<td>set</td>
<td>81</td>
</tr>
<tr>
<td>Terminal</td>
<td>297</td>
</tr>
<tr>
<td>Terminals</td>
<td>300</td>
</tr>
<tr>
<td>Text</td>
<td>133</td>
</tr>
<tr>
<td>Text attributes</td>
<td>199</td>
</tr>
<tr>
<td>Text component</td>
<td>196</td>
</tr>
<tr>
<td>Text constant</td>
<td>202</td>
</tr>
<tr>
<td>Text ID</td>
<td></td>
</tr>
<tr>
<td>search</td>
<td>165</td>
</tr>
<tr>
<td>Text link</td>
<td>199</td>
</tr>
<tr>
<td>TIF</td>
<td></td>
</tr>
<tr>
<td>export</td>
<td>315</td>
</tr>
<tr>
<td>Tiles</td>
<td></td>
</tr>
<tr>
<td>printout</td>
<td>46</td>
</tr>
<tr>
<td>Toolbar</td>
<td></td>
</tr>
<tr>
<td>drawing</td>
<td>130</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Valve editor</td>
<td>83</td>
</tr>
<tr>
<td>Valve terminal</td>
<td>66, 67</td>
</tr>
<tr>
<td>delete</td>
<td>66</td>
</tr>
<tr>
<td>distribute</td>
<td>67</td>
</tr>
<tr>
<td>symbol</td>
<td>66</td>
</tr>
</tbody>
</table>
W
Wiring ___________________________________ 290
WMF
    export _____________________________________ 315
    Working line _________________________________ 77
X
XML file ________________________________________ 58